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DEKTAK V 200-Si AND MICROSOFT®WINDOWS 3.1 

DEKT AK V 200-Si operates in a graphics environment called Microsoft Windows 3 .1. 
created by Microsoft Corporation. An extension of the MS-DOS® operating system. 
Microsoft Windows gives a standard look and feel to DEKT AK V 200-Si and all other 
Windows applications. 

The DEKT AK V 200-Si package contains all the software necessary to run DEKT AK V 
200-Si. You can also run DEKT AK V 200-Si under the full version of Microsoft
Windows version 2.1 or higher.

With Microsoft Windows 3.1, you can take advantage of these additional features of the 
Windows environment: 

l .  Running multiple applications: You can run several applications under Windows at
one time and easily switch between them, creating an integrated work environment. 

2. Data exchange between applications: You can transfer data between DEKTAK V
200-Si and other standard DOS applications, files, di.rectories, and disks, and control
all DOS-related tasks such as directory or file management and formatting disks.

3. Windows control of the DOS environment: From the Windows environment you can
easily access all Windows and non-Windows applications, files, directories. and
disks, and control all DOS-related tasks such as directory or file management and
formatting disks.

To run DEKT AK V 200-Si under Microsoft Windows, you need to license and install 
Microsoft Windows Version 2.1 or higher. 

"Microsoft" and ''MS-DOS" are registered trademarks of Microsoft Corporation. 
"DEKTAK" is a registered trademark of Veeco Instruments Inc., Sloan Technology Division. 
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SECTION 1 

UNPACKING AND INSTALLATION 

ENVIRONMENT REQUIREMENTS (U.S.A. ONLY) 

Temperature 
Normal operating temperature should be between 18 to 25 degrees Celsius, 
±I degree (64 to 77 degrees Fahrenheit, ±1.8 degrees). 

Clean Room 
The Dektak Series V system should be operated in a Class 100 or cleaner 
environment. 

Clean Air Flow Rate 
Down-blowing laminar flow not to exceed lOOft/min (30m/min). 

Relative Humidity 
30 to 45% relative humidity (non-condensing). 

Electrical Power 
Power requirements: 

Power demand: 

Power connection: 

Vacuum 

100/120/120 VAC (±5%) at 5 amps, 1 Phase, 50/60Hz 
200/230/240 VAC (±5%) at 3 amps, 1 Phase, 50/60Hz 

350 VA maximum 

A 3 meter, 3 conductor, 16AWG, power cord is 
supplied with the system. The cord is terminated with a 
male NEMA L5-15 connector. This connector is rated 
for 13 amps, 1,625 watts@ 125 VAC. 

24" (600mm) Hg minimum constant vacuum for the system with one fitting 
for 1/4-incb OD tubing. Standard fitting is 1/4-inch slip connect. 

Clean Dry Air 
100 psi (690 kPa) clean air for the system with one fitting for 1/4-incb OD 
tubing. Standard fitting is 1/4-inch slip connect. 

Venting 
The system has one 5-inch OD exhaust port for cooling air fan. The 
standard configuration has the port at the back of the central lower area of 
the cabinet. An optional configuration has the air exhaust port through the 
base of the unit. 

If it is not desired to vent the cooling air into the fab environment, then 
provisions must be made to duct the air into the service chase area or a 



SECTION I - UNPACKING Al\TD lNSTALLATION 

ducted exhaust system. If venting to an exhaust system, the flow of the 
exhaust system should not create back pressure at the exhaust fan. 

Vibration Interference 

Floor 

The system should not be operated near sources of vibration (such as fans, 
motors) or in excessive flow of a clean room air duct. Optimum 
performance will be obtained if placed in an area with little foot traffic and 
low acoustical noise. Vibration is not to exceed: 

70 µg from J to 100 Hz on a floor with a flat noise spectrum 

The floor must be level and rigid and capable of supporting the weight 300 
lbs. (136kg) of the system. 

System Location and Service Access 
The system should be located within the work area to provide normal 
hallway passage in front of the system without interference with the 
operator. The left and rear sides of the system must have a minimum 
clearance of 24 inches (610mm) to provide service access. 

2 



SECTION I· UNPACKING AND INSTALLATION 

UNPACKING 

Please read the entire installation instructions prior to beginning installation. 

The DEKT AK V 200-Si is shipped in two containers: one crate and onecardboard 
carton containing the monitor. The contents of the shipping crate and the 
unpacking instructions is provided in the following pages. Check the instrument 
visually to detect damage in shipment. 

NOTE 

Save all packing materials, shouJd it be necessary to ship or 
return the e ui ment. 

The DEKT AK V 200-Si Profiler is shipped in a large wooden crate and is bolted 
to a pallet. Save all shipping materials should it be necessary to reship the 
equipment. The procedure for uncrating is described below. 

l. Remove the top of the crate by prying off the metal climps which
bold the top of the crate in place. A climp hammer, crow bar, or
slotted screw driver can be used to remove the climps.

2. Once the top of the crate is off, remove the four sides of the crate.

3. Cut or tear away the plastic wrap around the unit. Remove the
sheet metal skins off the sides of the unit. The skins are held in
place with industrial grade VeJcro. To remove, pull skin firmly out
away from the unit and lift up to disengage hooks at the top.

4. Four large bolts secure the unit to the pallet. Remove the nuts from
the four bolts located under the pallet. It may be eaier to lift the
pallet off the floor witha forklift to access the bolts. Remove the
four bolts securing the unit to the pallet.

5. Use a forklift to lift the unit from the pallet. Take care not to snag
any cables with the fork blades that may be hanging down below
the frame. Make sure the forklift makes solid contact with the
front and rear crossbar of the table frame. Attempting to lift the
unit from any other direction may damage the machine. With the
forklift correctly positioned, lift the system off the pallet. Lower
the system to the floor onto a sturdy level surface, casters allows
the system to be maneuvered once on the ground. Raise the four
feet as far into the frame as they will go, to support the instrument
on the four casters.

CAUTION 

The DEKTAK V 200-Si is heavy. Attempting to lift the 
unit without proper equipment may result in personal 
injury and/or damage to the equipment. 

3 



SECTION 1- UNPACKING AND INST
A

LLATION 

INSTALLATION 

Once the DEKTAK V 200-Si is placed on a level surface, the unit is ready to be 
rolled to its permanent location. Wheel the instrument into its operation position, 
ensuring adequate service and maintenance clearance (see Figure 1-1 ). 

Leveling 

When the unit is moved to its permanent location it must be leveled to insure 
proper vibration isolation. Place a level on the robot mounting plate as close to the 
center of the machine as possible. Use a wrench to tum the bolts located on the 
bottom side of each frame leg clockwise until the wheels lift off the floor. Check 
the level to see which leg needs more or less adjustment. 

PROFILER DOOR 

MAINTENANCE 
ACCESS 

FLOPPY DRIVE 

MAIN POWER 

KEY LOCK 

Figure 1-1. Facilities Requirements 

• Electricity: 110/220 VAC, 50/60 Hz, 350VA (connect to back)
• Compressed Air: 100 PSI (connect to back)
• Vacuum: 24 inch Hg. (connect to back)
• CE approved
• S2-93 Certified
• Lockable front door for security
• Upgradable to loader system

4 



SECTION I - UNPACK.ING AND INSTALLATION 

SHIPPING BRACKETS 

To protect the precision sample stage and stylus mechanism during shipment, 
special fixtures are put in place to restrict their movement within the profiler. 
The instructions for removing the shipping brackets. 

CAUTION 
Neglecting to remove any or all of the shipping brackets prior 
to o eratioo ma result in dama e to the e ui ment. 

Isolation Table Shipping Brackets 

These brackets must be removed before inflating the legs of the isolation table. 
The shipping brackets connect the isolation table and the table frame during 
shipping. The brackets must be reinstalled prior to reshipping the unit to prevent 
damage to the profiler. Remove the side covers and the top cover to access these 
brackets. 

Stage Bracket 

Bracket connects the stage to the glass block plate. Remove the four screws 
holding the bracket. 

Surface Block Bracket 

An angle bracket secures the surface block plate to the profiler base. To remove 
the surface block bracket, unscrew the four screws holding down the bracket. 

Tower Bracket 

A steel bracket is used to restrict the movement of the tower which houses the 
stylus mechanism. To remove the tower bracket, unscrew the two screws 
attaching the bracket to the right side of the tower and the tower drive assembly. 

CAUTION 
The shipping brackets must be reinstalled prior to reshipping the 
unit or damage to the equipment may result. Save aU brackets 
and screws should it become necessary to return the unit. 

5 



SECTION I - UNPACKING AND INSTALLATION 

AIR, VACUUM, ELECTRICAL CONNECTIONS 

Air Pressure Connector 

The Dektak V 200-Si is built upon a vibration isolation table and requires no less 
than l0Opsi to operate properly. Locate the air pressure connector inside the front 
right door. Connect the facility air pressure line (1/4" [6.35mm] O.D. tubing) to 
the "one-touch" fitting attached to the air pressure regulator, marked 
"PRESSURE." Factory-adjusted to regulate the facilities air pressure to 40 psi, 
the regulator may need slight adjustments depending upon variations of facility 
air pressure. After adjusting the pressure regulator to output 40 psi, turn on the 
air pressure. Allow at least 5 minutes for the isolation table to fully engage. 
Check each comer of the table by pushing down gently. If the table is not floating 
freely on each comer, more adjustment may be necessary. 

NOTE: The levelling valves are set to approximately 25 psi. The 
input pressure is not to exceed 10-15 psi above the operating 
pressure. 

Air Vacuum Connectors 

The loader robot and vacuum chuck require no less than 24 inches Hg. of 
vacuum. The air vacuum connector is located on the rear panel. Connect the 
facilities vacuum line (1/4" [6.35mm] O.D. tubing) to the "one-touch" fitting 
marked "VACUUM." Connect the air Line in a similar fashion. To connect the 
lines, press themjirmly into the fitting until they fully seat. The air vacuum may 
now be turned on. 

Monitor Cable Connections 

The multisync color video monitor can be placed on top of the V 200-Si or on the 
counter beside the system. The adjustable monitor can be swiveled or tilted for 
operator comfort. The connectors for the monitor cables are located on the top of 
the DEKT AK V 200-Si profiler. 

Thermal Printer Connections 

The DEKTAK V 200-Si comes equipped with an Omni B&W thermal printer. 
The connectors for the printer cables are located on the top of the DEKT AK V 
200-Si profiler.

Exhaust Port 

The system has one 5-inch OD exhaust port for cooling air fan. The standard 
configuration has the port at the back of the central lower area of the cabinet. An 
optional configuration has the air exhaust port through the base of the unit. 

If it is not desired to vent the cooling air into the fab environment, then provisions 
must be made to duct the air into the service chase area or a ducted exhaust 
system. If venting to an exhaust sytem, the flow of the exhaust system should not 
create back pressure at the exhaust fan. 

6 
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SECTION 1 - UNPACKING AND INST
A

LLATION 

POWER SUPPLY SETTING 

The power supply bas been factory set at the appropriate voltage for the original 
user facility. If the unit is transferred to a facility where the voltage is different, it 
will be necessary to change the power supply setting. The procedure to verify or 
change the power supply setting is as follows: 

I. Verify that the main power switch located on the back of the computer
console is turned off "O" and the main power cable is disconnected from
its primary power source and the computer console.

2. Once the main power cable is disconnected from the Computer Console,
slide the clear plastic shield to the left until the fuse is exposed.

3. The voltage select card is located next to the fuse. Verify that the voltage
displayed is the correct voltage setting. If it is not, the voltage setting will
need to be changed.

4. To change the voltage supply setting, remove the fuse holder and the
voltage select card. Fimtly but carefully pull the voltage card straight out
of the cavity.

5. Four different voltage supply settings are available depending upon how
the card is installed (see Figure 1-1). Reinsen the voltage supply card
according to the desired voltage setting facing outward.

6. Once the voltage supply card has been reinstalled with the correct voltage
setting displayed, reinsert the fuse holder with the voltage setting revealed
through the opening of the plastic shield of the fuse holder.

7. Connect the facilities electrical supply to the instrument using an
approved IEC-320 power cord, rated at 16 amps or higher.Connect the
main power of the Dektak V 200-Si into a power outlet providing the
appropriate voltage as shown on the voltage select card.

CAUTION 

Never connect the Dektak V 200-Si to a power source which 
provides a voltage that is different from the power supply 
settin2 of the volta2e select card. 

Verify that the courtesy power switch 0ocated on the front panel) is in the "Off' 

position, so that the "O" is depressed. 

Tum on the integral circuit breaker by pressing the circuit breaker switch (located 
in the facilities interconnect) to the "On" position, so that the "I" is depressed. This 
activates the emergency off (EMO) circuitry. If the large red EMO switch is 
depressed, this circuit breaker will be set to the off (open) position, and all power 
to the instrument disabled. After the power cord has been attached, verify that the 
emergency off switch (EMO) has been reset. It is reset when it is in the extended 

position, and activated when it is in the depressed position. 

8 



SECTION I - UNPACKING AND INSTALLATION 

SYSTEM CHECKOUT 

Once all of the appropriate cable connections have been completed, The DEKT AK 
V 200-Si can be powered up to verify that the system is operating properly. The 
DEKT AK V 200-Si operating software was loaded onto the hard disk at the 
factory prior to shipment. 

1. Turn on the monitor and printer.

2. Power up the DEKTAK V 200-Si by turning on the main power switch
located on the front of the profiler.

3. The software will boot up and the DEKTAK V 200-Si sign on screen will
be displayed on the monitor (see Figure 1-2).

4. The stage will automatically initialize by first translating to the null 
position and then centering itself below the stylus. 

5. Roll the trackball to verify that the arrow displayed on the monitor
responds to the motion of the pointing device.

NOTE 
If the DEKT AK V 200-Si does not properly power up and 
initialize as described above, contact Veeco/Sloan Product 
Support at (805)963-4431. 

Dektak V 200-Si 

ig, 
Sampf• 

Posit!o111ng 

Surface Profile Measuring System 
Sloan Technology 

A Subsidiary of Vecco tnstrumcnls, Inc, 
Version 7 .00 [Pre-Release) {95/09/0112:12:56) 

Copyright (q 1991-1995, Sloan Technology Division 

Figure 1-3. Sign on Message 
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SECTION I - UNPACKING AND INSTALLATION 

LOADING THERMAL PRINTER PAPER 

Before loading paper into the Omni printer provided with the DEKTAK V 200-Si, 
the end of the paper must be cut squarely without any jagged edges. 

l .  In most environments, it is acceptable for the standard thermal printer to
be installed on the top of the DEKTAK V 200-Si Scan Head. Pull the 
"Printer Head" lever forward to lift the head. 

2. Open the paper roll cover. Place the printer paper in the curve of the
paper roll cover, with the paper rolling off the bottom of the roll toward
the printer. Insert the paper under the rubber platen until the edge
appears on the top of the platen.

3. Pull at least two inches of paper through the printer making sure the
paper is centered on the platen. Return the "Printer Head" lever to the
back position.

4. Hold the end of the threaded paper so it rema ins outside when closing the
paper roll cover.

5. Tum on the DEKT AK V 200-Si main power switch. Press and bold the
"Paper Feed" button and tum on the printer. The printer should begin the
"Self Test" mode. The paper should feed out smoothly. Any adjustments
can be made by moving the "Printer Head" lever forward and adjusting
the paper position.

6. Place the printer cover over the printer. Feed the paper through opening.

NOTE 

Change printer paper immediately after the end of roll 
warnin lines are si hted to avoid roll bindu roblems. 

PRINTER SELECTION 

If an external printer is to be used, other than the standard Omni thermal printer, 
the DEKT AK V 200-Si can transfer the print signal to the external printer port on 
the rear panel of the computer console. Refer to the Microsoft Windows manual 
for a listing of compatible printers. The procedure for printer selection is 
described below. 

1. Click-on "Set-Up" from the system menu bar and click-on "Printer Port"
from the Set-Up Menu. A dialog box will display "Internal (OmniPrint
426)" and "External Printer."

2. To send print data to the external printer port click-on "External Printer"
and click-on "OK".

10 



SECTION 2 

GENERAL INFORMATION 

INTRODUCTION 

The DEKT AK V 200-Si is an advanced surface texture measuring system which 
accurately measures surface texture below submicro-incb and film thickness to 262 
rn.icrons. 

Principle of Operation 

Measurements are made electromechanically by moving the sample beneath a 
diamond-tipped stylus. The high precision stage moves a sample beneath the 
stylus according to a user-programmed scan length, speed and stylus force. The 
stylus is mechanically coupled to the core of an L VDT (Linear Variable 
Differential Transformer). As the stage moves the sample, the stylus rides over the 
sample surface. Surface variations cause the stylus to be translated vertically. 
Electrical signals corresponding to the stylus movement are produced as the core 
position of the L VDT changes respectively. An analog signal proportional to the 
position change is produced by the LVDT, which in turn is conditioned and 
converted to a digital format through a high precision, integrating analog to digital 
converter. The digitized signals from a single scan are stored in computer memory 
for display, manipulation, measurement, and print. Stored programs that can be 
readily changed make the DEKT AK V 200-Si ideal for both production and 
laboratory use. 

OSCILLATION 

AMPLIFIER 
PHASE 

DETECTION/ 
DEMODULATION 

B{:;J 

AID 
CONVERTER 

i 
i 
i 
i 

DIGITAL ,,� 
�PR_o_c_Es_s_iN_G�� 

i 
i 

Figure 2-1. Block Diagram of DEKTAK V 200-Si Architecture 
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CONFIGURATION 

Computer Console 

The Computer Console incorporates a Pentium computer. The 1.4 MByte, 3-1/2" 
high density diskette drive permits off line use. Microsoft Windows provides an 
easy to learn, easy to use interface with pull-down menus and pop-up windows. 

Video Monitor 

The DEKT AK V 200-Si video monitor is a 15 inch high resolution (720x480 
pixels), Super VGA color monitor. It displays programs and graphics in full color, 
along with a color video image of the substrate surface. It can also be used to 
view the substrate either alone or with the graphics superimposed. 

Precision Scan Head 

The DEKT AK V 200-Si precision Scan Head unit contains the mechanical and 
optical components for sample placement, sample viewing, scanning/measurement 
and environmental protection. A diamond tipped stylus permits accurate 
measurements in a wide range of applications. User programmable stylus force 
from submilligram to 30mg. allow profiling on soft or hard surfaces. 

Motorized Video Zoom Camera 

A remote controlled 60X to 420X Solid-State Video Zoom optics system and a 
variable intensity illuminator permits viewing of the sample in the measurement 
area. 

Programmable Sample Stage 

A very high precision programmable sample stage performs the scan and permits 
X-Y positioning to any location of measurement interest in a 200mm x 200mm (8
x 8 inch) area. Theta rotation can be entered in 0.001 degree increments up to 360
degrees. Sample positioning can be controlled via DEKT AK V 200-Si keyboard
and trackball.

Thermal Printer 

The standard thermal printer produces full-sized printouts in less than 6 seconds. 
These printouts provide a graphic record of measurement and program data for 
future reference and/or reproduction. Clean room compatible thermal printer 
paper is available. Printouts can also be produced on an Epson compatible 
external printer. 

12 



SECTION 2- GENERAL INFORMATION 

STYLUS SIZE CONSIDERATIONS 

A stylus based surface profiler measures the actual physical surface of sample. In 
certain applications, stylus size and shape should be taken into consideration. 

The radius of the standard diamond stylus is 12.5 microns. The standard stylus 
meets most all requirements for the majority of applications. Some applications, 
however, may require either a larger or smaller tip radius. 

NOTE 

Reducing the stylus tip radius increases the point pressure on 
the sample and may require the stylus force to be reset. Stylus 
force ma be ro ammed from submilli am to 30m . 

Optional styli with radii of sub-micron, 2.5 micron, 5 microns, 12.5 microns, and 
25 microns are available for applications which require very high horizontal 
resolution or measurement of very soft films. 

SCAN SPEED VS. STYLUS FORCE 

When using a low stylus force, the stylus may tend to lift off the surface if a large 
step is encountered at higher scan speeds. In applications where a light stylus 
force is required, it is recommended that low or medium scan speed be used at the 
shortest possible scan length. 

STYLUS TOWER DESCENT RATE 

A programmable stylus tower descent rate gently lowers the stylus onto the sample 
surface. To increase throughput a proximity sensor allows rapid descent of the 
stylus tower prior to contacting the sample surface. As the stylus tower is 
lowered, the proximity sensor automatically slows the stylus descent rate to the 
selected value prior to the stylus contacting the sample surface. 
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SECTION 2 - GENERAL £NFORMATION 

HORIZONTAL RESOLUTION 

The exclusive HyperScan feature provides ultra high horizontal resolution with a 
maximum of up to 65,400 data points available per scan. The horizontal resolution 
of the DEKT AK V 200-Si is determined by the scan length and scan duration. 
The Dektak V 200-Si bas a constant sampling rate of 300 data points per second. 
By slowing down the scan speed, more samples can be taken over a longer period 
of time. Thus, more samples can be taken over a given scan length. The duration 
of the scan time can be set from 3 seconds up to 218 seconds. The examples below 
provide the number of data points per scan at various scan durations for a 2000µm 
scan length. 

Duration Data Points Maximum Resolution 

218 seconds 64,500 0. 031 µm/sample

50 seconds 15,000 0.133µm/sample 

13 seconds 3,900 0.513µm/sample 

3 seconds 900 2.222µm/sample 

The following formula may be used to detennine the number of data points for any 
given scan length and speed. 

Scan Length (in microns} 

# Data Points/Scan = Horizontal Resolution (in microns) 

The horizontal resolution of the DEKTAK V 200-Si is directly related to the scan 
length and the number of data points per scan. The scan length is selectable from 
50 microns to 200 millimeters. Without altering the number of data points per 
scan, the horizonatal resolution or the distance between data points can be 
adjusted by altering the scan length. The scan resolution parameter displays the 
distance between data points (in microns per sample). 

SCAN STORAGE DATA REQUIREMENTS 

Scan data can be stored on either the hard disk or on floppy diskettes. The number 
of data files that can be stored is dependent on the number of data points taken 
during the scan. It takes five bytes of storage space for each data point plotted. 
Therefore, a 13 second scan will require approximately 18,750 bytes of disk space. 
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SECTION 2 - GENERAL INFORMATION 

DEKTAK V 2oo�s1 TECHNICAL SPECIFICATIONS 

Vertical Range: 

Vertical Resolution: 

Scan Length Range: 

Scan Speed Ranges: 

Software Leveling: 

Stage Leveling: 

Stylus (standard): 

Stylus Tracking Force: 

Maximum Sample Thickness: 

Sample Stage Diameter: 

Sample Stage Translation: 

Sample Stage Rotation: 

Maximum Sample Weight: 

Power Requirements: 
Current: 
Phase: 

Warm-up Time: 

Operating Temperature: 

Environmental Humidity: 

Zoom Magnification: 

Color Camera: 

Sample Illumination: 

Dimensions: 

Vacuum Chuck: 

Vibration Isolators: 

25A to 2,620 KA (0.1 microincb to 10 mils) 

1A/65KA, 10A/655KA, 40A/2620KA, 

50 microns to 200mm (2 mils to 8 inches) 

3 seconds to 218 seconds 

Two-point programmable or cursor leveling 

Automatic and power leveling 

Diamond, 12.5 micron radius 

Programmable, submilligrarn-30mg 

45mm (1.75 inches) 

200mm (8 inches) 

X Axis, 200mm (8 inches) 
Y Axis, 200mm (8 inches) 

Theta, 360° 

2.5Kg (5 lbs.) 

100/1 J 5V or 220V, 50/60 Hz 
lOA@ 100/ll5V or 20A@ 220V (±10%) 
Single Phase 

15 min. recommended for maximum stability 

21 ° C ±3°C (70° F ±5°F) 

40%, ±20% 

60X to 420X 

Solid state produces color video image 

Variable intensity white light; IR/UV blocked 

30.5W x 45.4D x 60.5H (78 x 111 x 154 cm) 

Requires external vacuum 24" (600mm) Hg. 

Requires 100 PSI (488 kg/m2
) compressed air.
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SECTION 2 - GENERAL INFORlvlA TION 

OPTIONS/ ACCESSORIES 

See Appendix A in the back of this manual for a complete list of options and 
accessories for the DEKT AK V 200-Si. 

Interactive 3-D 
Software 

SECS/GEM Software 

Stress Measurement 
Software 

Step Detection 
Software 

Extended Optics 

Calibration Standards 

Provides 3-D renderings and surface area analysis. 

Allows two-way communications between the Dektak 
V 200-Si and host computer conforming to the SECS 
II protocol. 

Can calculate tensile or compressive stress on 
processed wafers. Includes special fixturing for 
three-point suspension of wafer. 

Reference and measurement cursors automatically 
position before and after steps for automatic 
computation of analytical functions. 

Provides 115X to 735X zoom magnification of 
sample surface. 

A broad line of calibration standards are available to 
calibrate the system for virrually any application. 
Both step height and VLSI roughness standards are 
offered. 
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OPERATION OVERVIEW 

Automation Program 

SECTION 2 - GENERAL INFORMATION 

Automation Program files permit a number of Scan Routines to be programmed 
and stored on the hard disk. Scan Routines along with their X, Y ,Theta stage 
locations are inserted into the Automation Program. Automation Programs can be 
stored for various applications in DOS file format on the hard disk, giving the 
DEKTAK V 200-Si virtually unlimited program storage capability. 

Scan Routine 

The DEKT AK V 200-Si Scan Routine consists of sixteen individual parameters 
which are selected using the trackball or mouse. Parameters such as scan length 
and speed, leveling, and stylus force can all be user determined. A total of 200 
Scan Routines can be entered into each Automation Program file. 

Sample Positioning 

The sample is placed on the sample stage and positioned for scanning using the 
stage translation, rotation, and leveling controls. Sample positioning can be 
accomplished by using the trackball or mouse. In the fine positioning mode, the 
sample stage tracks the motion of the trackball or mouse. A crosshair reference is 
displayed on the monitor during fine positioning. This software reticle is 
superimposed over the video image of the sample surface. 

In the course positioning mode, a template in the shape of a wafer or disk is 
displayed on the monitor. With the trackball or mouse, simply "point" to the 
desired location on the template, and the stage automatically translates to that 
position. The templates can also be rotated to accomplish theta rotation of the 
sample when the DEKTAK V 200-Si is equipped with the Auto Theta option. 

Scanning 

When a scan is run, the stylus is lowered onto the sample surface, and the stage 
moves the sample as the stylus rides over the surface features.. The Video 
Monitor allows the operator to view both the physical scanning of the sample and 
the plotting of the data simultaneously. At the end of the scan, the stylus 
automatically retracts and the system is immediately ready for the next scan. The 
surface features encountered by the stylus are represented as a two dimensional 
profile which is plotted, scaled, and displayed on the video monitor. 

Profile Manipulation and Measurement 

An initial profile may require software leveling, zero referencing and software 
magnification to zoom-in on an area of interest. Measurement is a continuous 
process and is facilitated by simple movements of the Reference and Measurement 
cursors. 
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SECTION 2 - GENERAL INFORMATION 

Data Plot Display 

The plotting screen displays scan data as well as various parameters from the Scan 
Routine such as the stage X, Y, and theta location, Scan ID#, scan length, scan 
speed, resolution, and stylus force. Also indicated are both the vertical and 
horizontal distances between the cursor/trace intercepts as well as the distances 
from the vertical and horizontal "zero" grid lines. If any analytical functions have 
been requested, the results from the calculation will also be displayed. 

Analytical Functions 

The DEKT AK V 200-Si bas a wide range of analytical functions available for 
analysis of roughness, waviness, step height, and geometrical measurements. Up 
to 30 analytical functions per scan can be performed. 

Boundary Magnification 

Following a scan, the operator can modify boundary locations to magnify portions 
of the trace. These new boundary locations can be stored and recalled at any time. 

Printing 

When the desired profile is displayed and a permanent record is desired, a printout 
can be made with a single keystroke. A summary of the data only without graphics 
may also be printed. 

Deskew 

The DEKT AK V 200-Si system provides a method known as "Deskew" to 
compensate for sample positioning errors. In each Automation Program a pair of 
X-Y coordinates, called "Deskew Points", may be programmed/established. These
points are defined as two visually identifiable landmarks on the sample which can
be located and stored as part of the Automation Program. When like samples are
placed on the stage, it is possible to indicate to the DEKT AK V 200-Si the actual
location of each like sample relative to the original sample by these visible
landmarks using the software reticle. The DEKTAK V 200-Si will compensate for
any positional skewing by computing new coordinates to which the stage must
move in order to locate the same scan position as the original reference sample.
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SECTION 3 

OPTICS ADJUSTMENT AND 

SAMPLE POSITIONING 

SECTION 3 OVERVIEW 

This section provides a step-by-step exercise for adjusting the optics and 
positioning the motorized sample stage the to measure the 1 OKA calibration 
standard, supplied with the Dektak V 200-Si. This exercise will allow the user to 
become familiar with the various features of the equipment relating to sample 
positioning. The skills acquired by perfonning this exercise can be applied to 
sample positioning in any application. Items discussed in this section include: 

■ Stage Control
■ A description of Microsoft® Windows 3 .1
■ Trackball operation
■ Power on
■ Password protection
■ Sample loading
■ Coarse positioning
■ Zoom lens adjustment
■ Camera focus adjustment
■ Sample illumination adjustment
■ Raising the stylus
■ Fine X-Y position adjustments
■ Remove Stage Backlash Feature

The calibration standard exercise is continued in Sections 4 and 5 of this manual. 
Section 4 describes single scan operation and Section 5 describes multiple scan 
operation. By completing the entire exercise, the user will become well acquainted 
with the basic operation of the Dektak V 200-Si. 

ST AGE CONTROL 

The Dektak V 200-Si is equipped with a precision sample stage which allows both 
automatic and semiautomatic sample positioning. Automatic or programmable 
positioning is described in detail in Section 5. Semiautomatic sample positioning is 
accomplished by using the trackball or mouse interactively with the various screens 
of the Microsoft Windows interface. A brief description of Microsoft Windows 
and trackball/mouse operation is provided on the following page. 

"Microsoft" is a registered trademark of Microsoft Corporation 
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SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POSmONING 

MICROSOFT WINDOWS 3.1 USER INTERFACE 

The Dektak V 200-Si employs Microsoft® Windows 3.1 as the operating 
environment. Windows is an extension of the DOS operating system which allows 
different tasks to be integrated to increase efficiency and ease-of-use. 

Windows provides a more practical way of organizing operational tasks of the 
Dektak V 200-Si into pop-up windows, pull-down menus, and scroll boxes. The 
operator simply rolls the pointing device (trackball or mouse) and "clicks" on the 
desired command. Virtually all Window commands are duplicated on the Dektak 
V 200-Si keyboard allowing either full Windows control, keyboard control, or a 
combination of both Windows and keyboard operation. 

Trackball 

A trackball is a pointing device which is used to choose commands. Using a 
trackball is as easy as pointing and clicking. 

The standard Dektak V 200-Si is equipped with a trackball, however it can also be 
operated via a mouse. Although a trackball usually has multiple buttons, the 
Dektak V 200-Si uses the left-most button for selecting commands in most 
applications. 

Moving the mouse across a flat surface or spinning the trackball moves the pointer 
(the arrow on the screen). To select a command move the tip of the pointer until it 
rests on the desired command and click the left-most button. 

The following definitions wilJ be used throughout the rest of this manual: 

''Pointing Device'' 

"Point" 

"Press" 

"Click" 

"Drag" 

"Double Click" 

Trackball. 

Move the tip of the pointer until it rests 
on what you want to point to. 

Hold down the left-most button. 

Quickly press and release the button. 

Hold down the button while moving the 
pointing device. 

Click the button twice in rapid succession. 
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SECTION 3 - omcs ADJUSTMENT AND SAMPLE POSmONING 

POWER ON 

l .  Verify that the DEKTAK V 200-Si power cable is connected to an external
power source. A surge protector is recommended to guard against power 
surges. 

2. Turn the monitor on. The on/off switch for the monitor is located on the lower
right of the monitor.

3. Locate the power switch on the front of the DEKTAK V 200-Si profiler. To
tum the power switch on, flip the switch to the "I" position.

4. The DEKT AK V 200-Si sample stage will initialize and the sign-on message
will be displayed (see Figure 3-1).

-1-C, 

NOTE 

Be sure to close out the Windows application prior to powering 
the s stem down. 

Dektak V 200-Si 

Sal)1Jlle I 
Pos,llonlng 

Surface Profile Measuring System 
Sloan Tec�nology 

A Subsidiary of Veeco Instruments. Inc. 
Version 7.00 [Pre--Relea�) (95/09/01 12:12!56) 

Copyright (cl 1991-1995. Sloan Technology Division 

Figure 3-1. Sign-on Message 

NOTE 
H the DEKTAK V 200-Si does not power up after following the 
above procedure, contact Veeco/Sloan customer service at 
(805)963-4431.
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SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POSmONING 

PASSWORD PROTECTION 

The DEKT AK V 200-Si is equipped with a password protection feature. The 
password system is initially disabled at the factory. The procedure for enabling 
the password is described below. 

1. Click-on "SET-UP" and click-on "PASSWORD" from the set-up menu. The
password submenu will be displayed.

2. Click-on "ENABLE PASSWORD PROTECTION" from the submenu. A
dialog box will be displayed listing the three user levels available: operator
level, technical level, and engineer level.

3. For the purpose of this exercise the engineer level will be used which permits
access to all DEKTAK V 200-Si operations. Click-on "ENGINEER
LEVEL".

4. Click-on the box label "PASSWORD" to display the flashing cursor
permitting the password to be keyed in. The word "ENGINEER" is the initial
password set at the factory. If the initial password is still active, select
"ENGINEER" as the password. However, if the password has been changed
by the user, key in the new password.

5. Click-on "OK" to activate the password. Once password protection is
activated, a dialog will be displayed prompting the user to enter the password
whenever the DEKTAK V 200-Si is powered up.

Enter Password 

Password: 

-user Level

0 Operator Level 

0 Technician Level 

@ Engineer Level 

OK 1 Cancel I 

Figure 3-2. Enabling Password Protection 
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SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POSmONING 

SAMPLE LOADING 

The DEKT AK V 200-Si has been preprogrammed to automatically position the 
sample stage for loading and unloading of samples onto the stage. Directions for 
loading a sample are described below. 

1. Using the trackball, move the pointing device to the system menu bar located
at the top of the screen and click-on "PROFILER". The Profiler Menu will be
displayed (Figure 3-3).

2. Click-on "Unload" in the Profiler menu. The DEKTAK V 200-Si sample
stage will automatically move out to the opening at the front of the scan head
to the unload location.

� 
FIia 

Open 

NOTE 

The keyboard can be used to position the stage to the load and 
unload locations. Striking the "W" key when the stage is 
positioned beneath the stylus moves the stage all the way 
forward to the scan head door into the unload position. 
Striking the "LOAD" key when in the unload position, centers 
the sta2e below the stvlus into the load position. 

etup lag :!lllndow !;allbrate l:!elp 

Stylus Down 

Move To Sain Loe. 
Botate ..• 
Load 
Unload 
fl�c�entl Unload 
Knisc Lift•�rs 
l.tlWl't lift.-r,; 

Auto Level Scan Direction 
Auto L.ew:I Ti11 tlirec�o�n 
ijOJlo Level Plane 
fower Leveling ... 
Sic� c_;:;tagP 
Make J:!orlzontal .•. 
Remove !!acldash 

Qptics ... 

','idea Only 
✓ l,raphics Only 

Vjdeo and Graphics 

+Cl,

Sample 
Pos,flonlng 

Surface Profile Measuring System 
Sloan Technol<1gy' 

A Subsldlary otVeeco Instruments, Inc. 
Version 7.00 (Pre-Release) (95/09/01 l :?:;12:56) 

Copyright (cl 199H 995, Sl1111n Technology Division 

Figure 3-3. Profiler Menu 

23 



SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POSITTONING 

CALIBRATION ST AN DARO POSITIONING 

1. Open the door to the environmental chamber of the DEKT AK V 200-Si and
position the sample in the center of the stage. The calibration standard should
be square with the sides of the machine and oriented on the stage as shown in
Figure 3-4.

2. Return to the Profiler Menu by clicking-on "PROFILER". When the Profiler
Menu appears, click-on "Load". The stage will automatically center the
sample stage directly below the stylus.

3. Click-on "PROFILER". When the Profiler Menu appears, click-on "Tower
Down". The optics tower will be lowered toward the calibration standard.

CAUTION 
As the stylus tower is being lowered, verify that the calibration 
standard is positioned below the stylus. To stop the tower down 
motion, press the ABORT key on the DEKTAK V 200-Si keyboard. 

o[C 

� 

C] 
r-1 

,,......., 
C 
ro 

FRONT OF ST AGE 

z: 

' 
lfl 

Figure 3-4. Calibration Standard Positioning 
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SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POSIDONTNG 

SET-UP 

Prior to attempting coarse pos1t:1.oning, the appropriate template should be 
selected. The set-up menu contains a variety of templates for different 
applications. For this exercise, the template for a 200 mm wafer will be -used. 
The 200 mm wafer template can be used as a template to determine the outer 
diameter of the sample stage table. 

Template Selection 

The coarse sample positioning template permits access to any location on the 
sample stage. The procedure for selecting the desired template is described 
below. 

l .  Click-on "SETUP" from the system menu bar. The Setup Menu will be 
displayed. 

2. Click-on "Wafer Template" from the Setup Menu. A dialog box will be
displayed allowing selection and editing of various wafer templates (see
Figure 3-5).

3. Click-on "200 mm wafer" and click-on "OK". When the sample positioning
window is accessed, the selected template will be displayed.

Elle Bun erofller S,etup Qlag Window J;.allbrate J:lelp 

EDIT & SELECT TEMPI.ATE 

I 200 MIIA WAFER 

. Diameter I 200.oo 

·El. 0 
Chord 10.00 

I 
,---..cc..- B : 

- -·--J

I CANCEL l 

65 IIAIIA DISK 
95 MIIA DISK 
130 MIIA OISK 
80 IIAMWAFER 
100 MM WAFER 
125 MM WAFER 
150 MM WAFER 
00 MM WAFER 

Figure 3-5. Edit & Select Wafer Template Dialog Box 
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SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POS111ON1NG 

SAMPLE POSITIONING WINDOW 

The sample positioning window permits coarse and fine adjustments relative to 
the X, Y, and Theta positions of the sample stage as well as optics adjustments. 
To access the sample positioning window, click-on "Sample Positioning" from 
the Window Menu or click on the "Sample Positioning" icon button. The Sample 
Positioning screen will be displayed (see Figure 3-6). 

Coarse Positioning Template 

The sample positioning window displays the predetermined coarse pos1t1oning 
template selected from the set-up menu. The coarse positioning template may be 
resized by clicking-on and dragging the window border. The window may also 
be iconned by clicking-on the minimize button. To operate the coarse positioning 
template, position the crosshair at the desired location on the sample template, 
double-click the left button on the trackball. The stage will automatically 
translate to the corresponding location on the sample. The current location of the 
stylus in relation to the sample stage is indicated by a green dot on the template. 

Arrow keys position lhe slage. 
l.---

0
---,I Left button actlva1es/deactivates sta 

Double-clicking the right button upd 

:�:�c alignment reticule. 

� 
� 

±.rL 
scan Hera 

�.FL.,,_ 
� � --t 

Run 
Prcoram 

• 

_(;alibrate tlelp 
Automation Programs 
_s_can Routines 
J.,oarler Proqr�m 
Lo.idcr i;_a:.·Slol Deti.,ihon 
Lo��er f�ogrom Queue 

Au!o Prog Summary 
J.n�df:r Pwc St�IU5 
Signon Screen 

Figure 3-6. Sample Positioning Window 
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SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POSITIONING 

SAMPLE POSITIONING WINDOW TOOLBAR DESCRIPTION 

The sample positioning window, located at the top, provides a toolbar containing 
a series of icons that allow a variety of different functions to be performed with 
the simple click of a button. These icons and their functions are described below. 
Additional icons are described in Section 9. 

� 
� 

� 

rn 

Zoom In/Zoom Out 
Click the left button to increase the magnification of the video 
microscope. Click the right button to decrease magnification. 

Illumination Adjustment 
Click the left button to increase sample illumination. Click the right 
button to decrease illumination. 

Focus Adjustment (Optional) 
When the motorized focus option is installed, the left button raises 
the focal plan and the right button lower the focal plane. 

I I ra-Qlaifijl 
Video/Graphics Overlay Adjustment

e U � Click the left button to display the video image only, the
"--•laiiiiiiiilL..::=i center button for graphics only and the right button for both. 

[!ill 

� 

[ID] 

f±1I] 

1qcd 

Tower Up/Tower Down 
Click the left button to raise the entire optics and stylus assembly all 
the way up. Click the right button to lower and null the optics tower. 

Stylus Up/Stylus Down 
Click the left button to raise the stylus arm off the sample surface. 
Click the right button to lower the stylus onto the sample surface. 

Load/Unload 
Click the left button to center the stage below the stylus. Click the 
right button to translate the stage to the scan head door for loading. 

Level Up/Level Down Adjustment 
Click the left button to adjust the sample stage leveling upward. 
Click the right button to adjust the stage leveling downward. 

Stage Rotation Adjustment 
Click and hold the left button to rotate the stage counter-clockwise. 
Click and hold the right button to rotate the stage clockwise. 
Use the right trackball button to rotate the stage at high speed and the 
left trackball button to rotate the stage at low speed. 

I I I I f 
X-Y Stage Position Adjustment

+ ... "'t ... Oick the corresponding button to jog the stage right,
left, forward, and backwards. 

Remove Stage Backlash 
Clicking on this button backs the stage up and re-approaches the scan 
location at an angle to remove backlash in the scan drive mechanism for 
applications where stylus positioning is critical. 
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SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POSffiONING 

STAGE ROTATION 

The sample positioning window permits the user to rotate the stage and make 
adjustments to the theta sample position. Stage rotation can either be 
accomplished by clicking on the rotation icon or by using the rotation dialog box. 
Click-on "Profile" from the system menu bar and click-on "Rotate" to display the 
Fine Rotation dialog box (see Figure 3-7). 

Fine Control 
The "Fine Control'' section of the rotation window permit-; the stage to be rotated 
by clicking-on the clockwise or counterclockwise buttons. The stage will 
continue to rotate until the button is clicked a second time. 

Rotation Speed 
A scroll bar is provided to allow adjustments to the fine theta rotation speed. To 
adjust the speed click-on the high or low arrows or drag the cursor on the scroll 
bar to the desired speed. 

Align Bun frofller Setup Qiag Window .(;.allbrate tlelp 

1 ____ 1 
Arrow keys posilion the stage. 
left bunon actlvates/deaClivates stage tracking. 
Double-clicking lhf! right bunon updates the feature 
allgnmcm reticule. 

I_ �.!l;?L;� 
l
.countcrCloi;kwise j 

,Rotation Speed- 1 

Lil I J 1.-:J 
'Low High 

. Processing ... 

Figure 3-7. Theta Rotation Window 

28 



SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POSffiONlNG 

OPTICS ADJUSTMENT DIALOG BOX 

The video image displayed on the DEKTAK V 200-Si monitor can be adjusted by 
using the Optics Dialog Box as well as the toolbar icons. The Profiler menu 
contains pop-up Optics Dialog Box that allows fine adjustments of focus, 
illumination, and zoom of the video optics microscope. To adjust the optics, 
click-on "PROffiER" from the system menu bar and click-on "Optics" to display 
the Optics Dialog Box (See Figure 3-8). 

Zoom Adjustment 
Click on the corresponding button to increase or decrease the zoom 
magnification. Click the button a second time when properly adjusted. 

Illumination Adjustment 
A scroll bar is used in the Optics dialog box to adjust the sample illumination. 
The illumination can be adjusted up or down by clicking the corresponding arrow 
or by dragging the cursor in the scroll bar to the desired illumination. 

NOTE 

The focus adjustment can only be accomplished with the 
remote control focus option installed. The focus is 
automatically adjusted whenever the optics is nulled by 
lowering the stylus onto the sample surface. The optional 
remote control focus feature permits fine adjustments of the 
focal plane. 

file f.dU Align Bun .erofller Setup 

Zoom· -

I . Increase . I '
I Oecre11se II 
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Figure 3-8. Optics Adjustment 
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SECTION 3 • OPTICS ADJUSTMENT AND SAMPLE POSmONING 

LOWERING/RAISING THE STYLUS 

The stylus is automatically raised whenever coarse sample stage positioning is 
initiated. This allows the user to view the sample and position the stage with the 
stylus lifted off the surface. Lowering the stylus onto the sample surface acts to 
null the stylus location and adjust the camera focus. With the stylus lowered, the 
stylus can be properly aligned with the movable reticule. 

1. 

2. 

1-iiriiii 
ll:l::J 

The stylus can be lowered by using either the toolbar icon 
buttons or the Profiler Menu. To access the Profiler Menu, click­
on "Profiler" from the System Menu Bar and the Profiler Menu 
will be displayed (see Figure 3-9). The "Tower Up" and "Tower 
Down" options raise and lower the entire tower assembly which includes the 
video camera, illurninator and stylus mechanism. The "Stylus Up" and 
"Stylus Down" options raises and lowers the stylus slightly. 

To lower the stylus, click-on "Stylus Down" from the Profiler Menu or use 
the stylus down icon. The Profiler Menu will disappear and the stylus will be 
lowered onto the sample surface. 

Move To 
Stan Lot 

NOTE 

The stylus reticule should be aligned with the stylus tip with the 

camera magnification set at maximum zoom. 

• , �etup 

Tower l.!I> 
Tower Qown 
�tylus Up 

Move To Scan Loe. 

Botate ... 
Load 
Urrload 
Buckend Unlr,u,l 
A�, .• � 1.itt�r, 
Lower litters. 

Y:,/.indow !;_allbrate lfelp 

Auto Level Scan Direction 
.. uto u,vcl Till Oirr.,.tion 
A11V1 L�vd Plnflt• 

_eower Leveling ... 
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Remove f!acklash 
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SECTION 3 - OPTICS ADJUSTMENT AND SAMPLE POSmONING 

STYLUS RETICULE ALIGNMENT 

The stylus reticule can be aligned to a newly installed stylus, or to allow for 
tolerances in the stylus head. If the stylus tip is not properly aligned with the 
reticule on the Sample Positioning window, the position of the reticule can be 
adjusted. The reticule provides a reference point when positioning the sample 
stage. Because the stylus is raised off the surface during stage positioning, the 
reticule indicates where the stylus will touch down on the surface. 

l . To align the reticule with the stylus tip click-on "Setup" from the system
menu bar. The set up menu will be displayed.

2. Click-on "Stylus Reticule" and three options will appear: Align, Reset, and
Style. (The "Reset" selection repositions the reticule to the original default
location in the center of the screen. The "Style" selection allows the reticule
style to be altered by entering a larger number to make the reticule lines
bolder or a smaller number for a fine line reticule.) Click-on "ALIGN" to
manually reposition the reticule.

3. When "ALIGN" is clicked-on a dialog box is displayed with instructions to
ensure a substrate is located under the stylus. Click-on "OK" to proceed.

4. A crosshair contained within a box will be displayed. Align the crosshair
with the stylus tip and double-click.

5. A dialog box will be displayed, click-on "YES" to update the stylus reticule
location.
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Figure 3-10. Stylus Reticule Alignment 

31 



SECTION 3 • OPTICS ADJUSTMENT AND SAMPLE POSffiONTNG 

FEATURE RETICULE ALIGNMENT 

The Feature Reticule is the smaller green reticule displayed on the fine 
positioning screen. The feature reticule can be aligned with surface features away 
from the stylus to more accurately position the stylus for a scan. The procedure 
for realigning the Feature Reticule is described below. 

1. The Feature Reticule can be realigned when the Sample Positioning Window
is displayed. To reposition the Feature Reticule, roll the pointing device to
the desired location on the Sample Positioning Window. It is best to align
the Feature Reticule with an easily recognizable surface feature.

2. Once the cursor is properly aligned with the desired feature, double-click the
right button on the trackball.

3. A dialog box will be displayed, click-on "YES" to update the Feature
Reticule alignment. The Feature Reticule will automatically be repositioned
to the new location.

NOTE 
The stylus location in relation to the reticule may change slightly 
when zooming the video camera in or out. In order to maintain 
proper stylus/reticule alignment, it is recommended that the desired
zoom ma ification be ad ·usted rior to ali 
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SECTION 3 - OPTICS ADJUSTMENT AND SA.\1.PLE POSITTONlNG 

X-Y ANO FINE STAGE POSITION ADJUSTMENTS

Once the optics are properly adjusted, X-Y and fine stage positioning can be 
accomplished. The sample positioning can be accomplished by using the toolbar 
arrow keys at the top of the Sample Positioning Window as described earlier in 
this section. Fine adjustments can also be accomplished by maneuvering the stage 
with the trackball as described below. 

l. The Sample Positioning Window permits fine adjustments to the X-Y
position of the sample stage. Simply use the trackball to point to any portion
of the video image displayed on the screen and click to activate the stage.

2. Once the stage is activated, the stage will track the motion of the mouse or
trackball along the X-Y axis.

3. When the stage is properly positioned, click-on any portion of the video
display a second time and the stage will be deactivated. The current X-Y­
Theta stage location will be displayed in the lower right comer of the screen.

NOTE 

Rolling the trackball too fast during fine positioning can cause 
oscillation in the lead screws. To stop the oscillation, push the small 
"TURBO" button on the trackball. 
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Figure 3-12. X-Y Stage Positioning Window 
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SEcnON 3 - OPTICS ADJUSTMENT AND SAMPLE POSmONING 

REMOVE STAGE BACKLASH 

For applications where X-Y stage repeatability must be maintained at the highest 
level possible, a remove back.lash feature is available. This feature removes any 
backlash in the sample positioning and scan drive mechanism to assure excellent 
sample positioning repeatability. 

When this feature is activated, the sample stage backs up and re-approaches the 
selected site at a diagonal to remove any back.lash that may be present in the 
motors. For applications where positional repeatability is an issue, the remove 
backlash function should be used when prior to entering a scan location or a 
deskew point location. 

� To activate the remove back.lash feature, click-on the remove back.lash 

lLJ 
icon button from the toolbar. 

It may also be activated from the "Profiler" menu by clicking on the "Remove 
Back.lash" selection (see Figure 3-13). 
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SECTION 4- SINGLE SCAN OPERATION 

SECTION 4 

SINGLE SCAN OPERATION 

SECTION 4 OVERVIEW 

This section will provide a step-by-step exercise for performing routine step height 
measurements on the lOKA calibration standard supplied with the DEKT AK V 
200-Si. It is a continuation of tbe exercise begun in Section 3 of this manual. The
exercise is designed to teach the user the basic operational skills required to
program and run simple scan routines. The items discussed in this section include:

■ Creating an automation program 

■ Scan routine programming

■ Running a scan routine

■ Reference/measurement cursor positioning

■ Stage leveling

■ Making a step height measurement

■ Plot magnification

■ Print out

In the exercise described in this section, the DEKT AK V 200-Si is operated via a 
trackball, as well as the keyboard. The user interface screens work in conjunction 
with the trackball and the keyboard. The user may want to become familiar with 
the DEKT AK V 200-Si user interface by reading section three prior to attempting 
this exercise. 
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SECTION 4. SINGLE SCAN OPERATION 

CREATING AN AUTOMATION PROGRAM 

Prior to running a scan routine, an automation program must first be created. 
Automation programs are files which contain all the necessary information for 
performing single or multiple scan routine sequences. The procedure for creating 
a new automation program is described below. 

1. Click-on "Window" from the system menu bar and click-on "Automation
Programs" from the Window Menu. The Automation Programs screen will be
displayed (see Figure 4-1).

2. Click-on "File" from the screen specific menu bar and click-on "New" from
the file menu. A dialog box will be displayed asking if current Automation
Program is to be saved. Clicking-on "Yes" allows the current Automation
Program to be saved. Clicking-on "No" deletes any changes to the current
Automation Program and enters the default Automation Program.

3. A second dialog box will be displayed for the 3-D mapping option. For this
application select "Standard" and click-on "OK".

4. The automation program control header dialog box will be displayed allowing
automation programs to be saved under user defined index headings. This
feature is described in more detail in Section 5. For this application, click-on
"OK". A new automation program will be created containing the default scan
routine parameters.
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SECTION 4 - SINGLE SCAN OPERATION 

ENTERING THE SCAN LENGTH 

This page describes entering the appropriate scan length for measuring the 
calibration standard supplied with the Dektak V 200-Si. The scan length and scan 
location can be entered from the sample positioning screen as described below. 

1. Click-on "Window" and click-on "Sample Positioning" from the stage menu.
The sample positioning screen will be displayed.

2. With the stylus tower down, activate fine sample positioning by clicking-on
the video image of the sample positioning screen. The stage should now track
the motion of the trackball. Position the stylus reticule to the left of the "dog­
bone" step of the calibration standards shown below (the image in Figure 4-2
is shown at rninimwn magnification). With the stylus reticule properly
positioned, click the track ball a second time to deactivate the stage.

3. Click-on "Edit" and click-on "Enter Scan Length ... ". The stage will now track
the left and right motion of the track ball to allow the scan length to be
entered. Roll the track ball until the stylus reticule is positioned to the right of
the "dog-bone" step, and click-on the track ball button.

4. The "Enter Scan Length" window will be displayed (Figure 4-2) allowing the
scan length to be altered. For this exercise, click-on the "Scan Length" box
and enter a scan length of 1000 microns. The "Enter Scan Location" box
should be activated, indicated by an "X" in the box. Click-on "OK" to enter
the scan length and scan location into the Scan Routine Program.

t�--�I Roll track ball In X direction along scan line. 

e 
Then click lhe left mouse but1on to define scan length. 
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Figure 4-2. Entering 1000 Micron Scan Length into a Scan Routine 
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SECTION 4 • SINGLE SCAN OPERATION 

RUNNING A SCAN ROUTINE 

When running a scan routine, it is often beneficial to view the video image of the 
stylus and sample with the graphic representation of the surface profile 
superimposed. To accomplish this, pull-down the "DISPLAY" menu and click-on 
"Video and Graphics". 

To run a scan routine, click on the "Scan" icon button or pull-down the "RUN" 
menu, and click-on "Run Scan Routine." To run the scan routine at the stage's 
current X-Y location rather than at the default location listed in the scan routine 
parameters, the following sequence of events will occur when a scan is initiated: 

1. The data plot screen will be displayed with the graphic display of the scaled
grid superimposed over the video image of the stylus and calibration standard.

2. The stylus will be lowered onto the surface. After a brief pause, the scan will
commence. As the stylus scans across the calibration standard, the initial
profile trace is plotted on the scaled grid.

3. Once the scan is complete, the stylus will lift off the surface and the stage will
return to the X-Y location where the scan originated. The profile is then
automatically replotted and rescaled. The image displayed on the monitor
should resemble Figure 4-3.
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SECTION 4- SINGLE SCA!� OPERATION 

REFERENCE/MEASUREMENT CURSOR POSITIONING 

The reference (R) cursor and measurement (M) cursor are used to define the 
portion of the profile trace for leveling or performing analytical functions. Cursor 
positioning is critical for obtaining accurate results. Cursors can be positioned by 
using either the trackball method or the numeric entry method. 

It is recommended that the default cursor band widths be used for leveling and 
measuring. To activate the default cursor bands click-on "Plot" and click-on 
"Default Bands" (See Figure 4-4). 

Trackball Cursor Positioning 

Special arrow buttons are provided at the bottom right of the Data Plot screen for 
positioning the cursors (see Figure 4-4). Cursors can be repositioned by clicking 
and holding the left and right arrow buttons. Click-on the "R" button to reposition 
the reference cursor and click-on the "M" button to reposition the measurement 
cursor. Clicking-on the "F" button moves the cursors at high speed. You can also 
reposition the cursors by dragging the "R" and "M" flags at the top of the cursors. 

The boxes to the far left of the cursor positioning arrows indicate the location of 
the cursors. The top box refers to the R cursor location and the bottom box refers 
to the M cursor. The number contained in the box indicates the point at which the 
cursor intercepts the profile trace in relation to the vertical scale. 
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SECTION 4 - SINGLE SCAN OPERATION 

Cursor Positioning - Numeric Entry 

The grey boxes to the left of the cursor positioning arrows display the cursor 
position in relation to the horizontal scale. Cursor locations can also be altered by 
using the DEKT AK V 200-Si keyboard to numerically enter new cursor positions. 
For this exercise the R cursor should be set at 100 microns with the M cursor at 
900 microns. Keyboard cursor positioning is described below. 

1. Click-on the upper grey box indicating the R cursor horizontal position. A
flashing prompt will appear in the box.

2. Key-in 100 on the DEKT AK V 200-Si keyboard and press enter. The R
cursor will be repositioned at 100 microns.

3. Click-on the lower grey box indicating the M cursor horizontal position. A
flashing red prompt will appear in the box.

4. Key-in 900 and press enter. The M cursor will be repositioned at 900
microns.

The box labeled "Vert Delta:" displays the vertical difference between the points at 
which the R and M cursors intercept the profile trace. The box below it labeled 
"Horiz Delta:" provides the horizontal distance between the cursors. 
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SECTION 4 - SINGLE SCAN OPERATION 

AUTOMATIC STAGE LEVELING IN THE SCAN DIRECTION 

It is not necessary to autolevel the stage, unless it is severely out of level. The 
auto leveling feature can only be accessed when the data plot screen is displayed. 
It is used interactively with the reference and measurement cursors. When Auto 
Leveling is activated, the stage is automatically leveled in relation to the points at 
which the profile trace intercepts the cursors. The R and M cursors must be 
positioned on the same horizontal plane along the profile trace. For the best result, 
the Rand M cursors should be positioned as far apart as possible. 

1. To use auto leveling, click-on "Profiler" from the system menu bar, click-on
"Auto Level Scan Direction" (see Figure 4-6).

2. If the stylus is resting on the sample surface when auto leveling is clicked-on,
the stylus will first be raised. The stage will then be automatically leveled
according to the vertical difference between the cursors.

3. When a second scan is performed, the profile trace should be adequately
leveled to make a measurement. Additional leveling of the trace can be 
accomplished in software. 
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SECTION 4 - SCNGLE SCAN OPERATION 

POWER STAGE LEVELING 

The power leveling method allows the stage to be mechanically leveled. It is 
usually used in applications where the stage or sample is extremely out of level, to 
the point where the scan line runs off the scale. 

1. To use the power leveling, click-on "Profiler" from the system menu bar and
click-on "Power Leveling". The stage leveling window will be displayed (see
Figure 4-7). This window allows the stage to be raised or lowered at one end
to adjust the level.

2. If the scan trace has a positive slope or runs off the top of the screen, click-on
"Lower". The stage will continue to level until "Lower" is clicked-on a
second time.

3. If the scan trace has a negative slope or it runs off the bottom of the screen
click-on "Raise". The stage will continue to level until "Raise" is clicked-on a
second time.

4. When the desired stage leveling adjustments have been accomplished, click-on
"OK". The stage leveling window will disappear.

5. Run another scan to verify if the stage level has been adjusted satisfactorily.
The power leveling method uses a trial and error technique that may have to
be re eated several times to level the staae.
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SECTION 4 - SlNGLE SCAN OPERATION 

SOFTWARE LEVELING 

Even after the stage has been power leveled or auto leveled, ensuing scans may 
show the profile trace slightly out of level. Software leveling allows the system to 
quickly level the profile trace, without actually having to completely level the 
stage. The stage must be software leveled in order to obtain accurate step height 
measurements or accurate readings from analytical functions. Software leveling 
sets the reference and measurement cursors at zero to establish reference for 
measurements. 

1. To software level a trace, position the R and M cursors along the baseline of
the step (see Figure 4-8).

2. Click-on "PLOT" from the system menu bar. The Plot Menu will be displayed.

3. Click-on "Level". The profile trace will be replotted and leveled with the R
and M cursor intercepts at zero.

Software leveling can also be programmed into the scan routine to automatically 
level the trace at the conclusion of the scan. For more information see Section 8 
on software leveling. 
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SECTION 4 - SINGLE SCA.i'I OPERATION 

SETTING THE ZERO POINT 

Any point on the profile trace may be selected as the zero point. The zero point is 

the point of reference from which all measurements are taken. Software leveling 

sets both the R and M cursor intercepts at Zero. When the "Zero" function is 

activated, it sets the zero point only at the R cursor intercept. It is important when 

measuring step heights that the M cursor is positioned at the top of the step. For 

optimum results, the zero point should be set as close to the base of the step, prior 

to step height measurements. 

1. Position the reference or "R" cursor at the desired zero location, just to the

left of the base of the step as shown in the figure below.

2. Click-on "Plot". The plot menu will be displayed.

3. Click-on "Zero" from the Plot Menu. The profile trace will automatically be

replotted and the zero point will be established at the R cursor intercept (see
Figure 4-9).
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SECTION 4 - SINGLE SCAN OPERATION 

DELTA AVERAGE STEP HEIGHT MEASUREMENT 

Once the scan routine has been run and the profile is properly leveled and zeroed, 
an accurate step height measurement of the calibration standard can be obtained 
using the Delta Average step height analytical function. 

1. Analytical functions are calculated using the R and M cursors. The cursor
positions shown in Figure 4-8 are correct for the Delta average step height
calculation, with the R cursor at the base of the step and the M cursor at the
top of the step.

2. To calculate the average step height function, click-on "Analysis" and click-on
"Analytical Functions". The analytical functions menu will be displayed. To
activate the Delta average step height function, click-on the box labeled
"ASH" from the "Height" selections.

3. Click-on the "Measure" selection located at the bottom of the analytical
functions window. (fhe "Measure and Program" selection enters the ASH
function into the current scan routine to be automatically performed when the
current scan routine is run again.) Click-on the "COMPUTE" button and the
average step height will be calculated with the result displayed in the area to
the left of the data plot screen.
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SECT[ON 4 - SINGLE SCAN OPERATION 

PLOT MAGNIFICATION 

Once a scan has been run and the profile trace is plotted, a portion of the data plot 
display can be isolated and magnified for more detailed analysis of the profile trace. 

l .  To magnify an area of interest, roll the pointing device to the data plot grid.
The location of the pointing device on the grid will be displayed as a crosshair. 
Roll the crosshair to the corner of the area of the data plot screen that is to be 
magnified and click-on that location. 

2. The blue crosshair will now be displayed as a small red box. Drag the
pointing device away from the first corner at a diagonal to expand the box.
Once the box has turned green, it contains enough data to allow the trace to
be replotted. When the desired boundaries are set, click-on the trackball
button a second time. For this exercise the boundaries should look similar to
those shown in Figure 4-11.

3. Click-on "PLOT" from the menu bar. When the plot menu is displayed, click­
on "REPLOT". The system will automatically replot the profile trace with the
new boundaries similar to Figure 4-12.

4. To redisplay the original profile trace, pull-down the "PLOT" menu once
again and click-on "REPLOT" a second time. The original trace will be
replotted.
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SECTION 4 - SINGLE SCAN OPERATION 

SAVING BOUNDARIES 

l. To save the new set of boundaries, click-on "Plot" and click-on "Save
Boundaries". A dialog box will pop-up requesting an identification number
under which to save the boundaries (see Figure 4-12). Any number between 1
and 9 may be used.

2. Use the numeric keypad to key-in I.D. number for the plot boundaries. For
this exercise select Number 1. Once the number bas been entered click-on
"OK". The dialog box will disappear and the current boundaries will be saved
in memory under I.D. number 1. If previous boundaries had already been
saved under I.D. number 1, the new boundaries will replace the old.

SHOWING SAVED BOUNDARIES 

l. To show the saved boundaries, click-on "Plot" and click-on "Show
Boundaries".

2 All boundaries currently saved in memory will be displayed on the Data Plot 
Screen along with the I.D. number. 

"" Pro ram: <Untitled> ; O�ta: <Untitled> San 1 of 1 

8 
Sam Parameters 

ro: o 

M0'>1l To 
I
X: 96522 µa 

Scan Loe Y: 165733 II"' 
THE.TA: II.HD 

tscLEN: 1DGII 11• 
JRES: 0.256 µ111/sa•ple 
�FORCE:: 30 •9 

1,------.1" R 
PRO Save boundaries under number: 

� 1ro 
Scan Hare. 

; 
I. OK JI ____ _ 

;:!.;'-�;:!.;' 
Run 

Prognim 

fFlrocessing_, -

µm 

Figure 4-12. Saving Boundaries 

47 

Horiz_D_] 
150.00 Um 

X:96560. Y:i
°

65606, T:O 



SECTION 4 - SINGLE SCAN OPERATION 

RESTORING SAVED BOUNDARIES 

The restore function allows the profile trace displayed on the data plot screen to be 
replotted using a set of boundaries saved in memory. 

1. Click-on "Plot" from the menu bar.

2. Click-on "Restore" from the Plot Menu. A dialog box will be displayed
requesting the I.D. number under which the desired boundaries to be restored
were saved (see Figure 4-13).

3. Key-in the 1.D. number "I" and click-on "OK". The current scan trace will
then be replotted using the saved boundaries.

4. The original profile trace may also be restored by following the above
procedure for restoring a saved boundary and entering restore boundaries
under number "O". The original trace will be restored.
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SECTION 4 - SINGLE SCAN OPERATION 

PRINTOUT 

A printout may be requested on the DEKT AK V 200-Si thermal printer or on a 
Windows compatible printer. A printout can be obtained of all the scan data with 
the plotted profile, a summary of the scan data, the scan routine form, the 
automation program form and the automation program summary. A printout of 
the entire active screen can be printed when using a Window compatible printer. 

l. To request a printout, click-on "FILE" from the menu bar.

2. From the File Menu, click-on "Print". A submenu will be displayed, listing the
various print options (see Figure 4-14).

3. Click-on "Scan Data" from the print submenu. A printout will be produced on
the current active printer.

NOTE 
The printer port is selected from the SET-UP menu. When 
using an external printer, the drivers for the Windows 
comoatible printer must be installed prior to use. 
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SECTION 4 - SINGLE SCAN OPERATION 

SAVING AN AUTOMATION PROGRAM 

An automation program can be stored on the DEKT AK V 200-Sj bard disk or on 
a diskette. The automation can then be opened at a later time to be rerun or 
altered. For the purpose of this exercise, follow the procedure described below to 
save the automation program created in this section onto the C drive. 

1. Click-on "WINDOW" from the system menu bar and click-on "Automation
Programs" from the programs menu. The Automation Programs screen will
be displayed (Figure 4-15).

2. Click-on "File" from the Automation Program's screen specific menu bar. The
file menu will be displayed.

3. Click-on "Save As ... " from the Ftle Menu. A pop-up window is displayed
requesting file name under which the Automation Program is to be saved (see
Figure 4-15).

4. A filename up to eight characters long may be entered. For this exercise key­
in the file name "exercise" and click-on "OK." The window will disappear and
the Automation Program is now saved on the hard disk under file name
"exercise".
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SECTION 5 ·MULTIPLE SCAN OPERATION 

SECTION 5 

MULTIPLE SCAN OPERATION 

AUTOMATION PROGRAMS EXERCISE 

This section is a continuation of the exercise begun in Sections 3 and 4 using the 
lOKA calibration standard. By building on the experience gained in creating and 
performing a single scan operation, the DEKT AK V 200-Si can be used to 
produce complex multi-scan sequences. Items discussed in this chapter include: 

■ Automation Program Description
■ Copying Scan Routines
■ Triplet Entry
■ Running an Automation Program
■ Selecting Deskew Points
■ Data Destination Options
■ Requesting a Printout
■ Data File
■ Pause After Scan
■ Saving an Automation Program
■ Reopening a Saved Automation Program

AUTOMATION PROGRAM DESCRIPTION 

The Automation Program is the basis for all operations performed on the 
DEKT AK V 200-Si. Automation programs are stored in DOS file format on the 
hard disk, giving the DEKT AK V 200-Si virtually unlimited program storage 
capability. A basic knowledge of MS-DOS commands will be very helpful in 
understanding and creating automation programs. For more information, see the 
Microsoft MS-DOS operating system user's guide and user's reference. 

The Automation Programs Screen displays the current scan routine along with 
their X,Y,Theta locations, deskew points, and data destination options. This 
screen allows the DEKT AK V 200-Si to be programmed for performing multi.­
scan operations at various locations on a sample. 

The Screen Specific menu bar located just above the automation program screen 
contains a F

i

le menu, Edit menu and Deskew menu. These three menus are 
described in the following pages. 
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SECTION 5 • MULTIPLE SCA.i.'I OPERATION 

OPENING A NEW AUTOMATION PROGRAM 

For the purpose of this exercise, a new Automation Program will be opened to 
create a multi-scan automation program. 

1. Click-on "Window" from the System Menu bar and click-on "Automation
Programs" from the Window Menu. The Automation Programs screen will be
displayed.

2. Click-on ''File'' from the menu bar and click-on "New" from the File menu. A
dialogue will be displayed requesting if you want to save changes to the
current Automation Program.

3. A second dialogue box will ask whether you want to create a standard
automation program or one using mapping, for this exercise select "Standard".

4. A third dialogue box will then be displayed permitting an automation program
control header to be created which allows additional information pertinent to
the samples under test to be entered into the automation program control
header. Click-on "OK" when finished and the default scan routine will be
entered into the current automation program.

l 
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SECTION 5 - MULTIPLE SCAN OPERATION 

EDITING AN AUTOMATING PROGRAM 

The procedure below describes how to copy the current Scan Routine to create an 
Automation Program containing multiple Scan Routines. An Automation Program 
can contain up to 200 Scan Routines, however, for the purpose of this exercise, an 
Automation Program will be created containing three Scan Routines. 

1. Click-on "Edit" from the Automation Program window menu bar and click-on
"Copy to Range ... " from the Edit Menu. A pop-up window will be displayed
requesting the copy to range (see Figure 5-2).

2. A flashing cursor will appear in the box labeled "Copy current scan routine to
scan routine#", key in number "2" in the box.

3. Click-on the box below it labeled "Through Scan Routine #." The flashing
cursor will appear in the second box. Key-in number "3".

4. Click-on "OK". The window will disappear and the current Scan Routine 1
will be copied to scan routines 2 and 3 where the Scan Routines are listed on
the right half of the Automation Programs screen. Scan Routine 2 is now the
current Scan Routine.
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SECTION 5 - MULTIPLE SCAN OPERATION 

GLOBAL EDITING OF SCAN ROUTINE PARAMETERS 

The individual scan parameters within each scan routine of an Automation 
Program can be changed at any time. For the purpose of this exercise, the Global 
Edit Mode will be used to allow the parameters of all the scan routines within the 
Automation Program to be edited. 

1. Click-on "Window" and click-on "Scan Routines" from the Window Menu.
The Scan Routines screen will be displayed. Click-on "Edit" and click-on
"Global Edit Mode" (Figure 5-3).

2. Click-on the ''Display Parameters" window. The Display parameters options
will be displayed. Click on the "Automatic Leveling" checkbox. Enter 150 into
each band width box (Figure 5-3). Click on "OK" to close.

3. To enter the ASH analytical function, click-on "Edit" from the menu bar and
click-on "Append Analytical Functions". The Analytical Functions will be
displayed.

4. Click-on the M cursor box and enter "1000". Click-on "ASH" from the
Height Parameters and click-on "ADD". The ASH Band Widths dialog box
will be displayed. Enter the default ASH band widths for the R and M cursor
by clicking-on "OK". Click-on "Done" when finished.
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SECTION S - MlJL TIPLE SCAN OPERATION 

PROGRAM ENTRY 

The location of a scan routine is identified by a set of three numbers which 
represent the X,Y, and theta positions of the stage where the scan routine is to be 
performed. Because all three scan routines in the current automation program 
have the same values, it will be necessary to enter new values for each scan 
routine. 

1. Click-on "Window" from the menu bar and click-on "Sample Positioning".
The sample positioning screen will be displayed.

2. Click-on "Edit" from the screen specific menu bar. The Edit Menu will be
displayed listing several options (see Figure 5-4). Selecting "Enter Scan
Location" from the Edit Menu enters the current stage location into the
current scan routine. Selecting "Enter Scan Length" allows the scan length to
be adjusted. And selecting "Go to Scan Routine" goes to the selected scan
routine, making it the current scan routine. The number of the current scan
routine is displayed at the very top of the screen.

3. Click-on "Go To Scan Routine" and enter scan routine number "1" into the
dialog box and click-on "OK".
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Figure 5-4. Program Entry Menu 
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SECITON 5 - MULTIPLE SCAN OPERATION 

Scan Location Entry - Scan Routine #1 

Prior to entering the location for Scan Routine #1, verify that Scan Routine #1 is 
displayed at the top of the screen as the current Scan Routine. 

1. Click-on the video image of the sample positioning screen. The stage will
now track the motion of the mouse or trackball. When the calibration
standard is properly positioned, as shown in Figure 5-5, click-on the mouse or
trackball a second time to deactivate the stage.

2. Click-on "Edit". The Edit Menu will be displayed.

3. Click-on "Enter Scan Location" from the Edit Menu.

4. A dialog box will be displayed verifying the Scan Location for Scan Routine
#1. Click-on "OK" to enter the location. Scan Routine #2 is now the current
Scan Routine.
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SECTION 5 - MULTIPLE SCAN OPERATION 

Scan Location Entry - Scan Routine #2 

Prior to entering the location for Scan Routine #2, verify that Scan Routine #2 is 
displayed at the top of the screen as the current scan routine. 

1. Click-on the video image of the Sample Positioning screen. The stage will
now track the motion of the mouse or trackball.

2. Roll the pointing device to position the calibration standard as shown in
Figure 5-6. Once the calibration standard is properly aligned with the
software reticule, click the mouse or trackball a second time to deactivate the
stage.

3. Click-on "Edit". The Edit Menu will be displayed.

4. Click-on "Enter Scan Location" and click-on "OK". The current X,Y stage
position will be entered into Scan Routine #2 and Scan Routine #3 will
become the current Scan Routine.
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SECTION 5 - MULTIPLE SCAN OPERATION 

Scan Location Entry - Scan Routine #3 

Prior to entering the location for Scan Routine #3, verify that Scan Routine #3 is 
displayed at the top of the screen as the current Scan Routine. 

1. Click-on the Video image of the Sample Positioning screen. The stage will
now track the motion of the mouse or trackball.

2. Roll the pointing device to position the calibration standard as shown m
Figure 5-6. Click a second time to deactivate the stage.

3. Click-on "Edit". The Edit Menu will be displayed.

4. Click-on "Enter Scan Location" from the Edit Menu and click-on "OK". The
current X,Y stage position wil l be entered into Scan Routine #3.

5. Once all of the triplets are entered an Automation Program can be run. Click­
on "RUN" and click-on "Run Auto Program". The Automation program will
be run, performing a scan at each programmed location.
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SECTION 5-MULTIPLE SCAN OPERATION 

DATA DESTINATION OPTIONS 

Data destination options can be entered into the Automation Program to 
automatically perform a selected function at the conclusion of each scan routine. 
Several data destination options are available on the DEKT AK V 200-Si for 
selecting the printer, data file, APS, and pause after scan. The procedure to 
program these options for the purpose of this exercise is described on the 
following pages. 

Printer 

l .  Click-on the printer data destination option and three printer options will be
displayed: no, print plot, and print plot summary (see Figure 5-8). If "No" is 
selected, a printout will not be produced. If "Print Plot" is selected, the 
plotted profile trace along with the profile data will be printed out on the 
DEKTAK V 200-Si thermal printer. If "Print Plot Summary" is selected, a 
printout will be produced of a summary of the scan data only. 

2. For this exercise, click-on "Print Plot". With "Print Plot" selected, a printout
of the plotted profile will be produced after each scan routine is completed,
whenever the Automation Program used in this exercise is run.

NOTE 

In addition to the Plot or Scan Data Summary printout, the 
Automation Program Summary (APS) can be printed at the 
conclusion of the Automation Proerarn. 
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SECTION 5 - MULTIPLE SCAN OPERATION 

Data File/Data Export 

The data file and data export options permit the data plot screen from the just 
concluded scan routine to be filed either as binary data or ASCII data on the 
DEKT AK V 200-Si hard disk or for back-up on a diskette. The plotted profile can 
then be redisplayed at a later date for further analysis. Two data file options are 
available "No" and "Yes". For this exercise the data will be filed to the C drive. 

1. Click-on the "Data File" option in the Automation Programs screen. A
dialogue box will be displayed permitting the data to be saved either at binary
data or ASCII data (see Figure 5-9). Click-on "SeJect File" under binary data.
A dialogue box will be displayed containing a directory listing of the Data Plot
screen previously saved in the "V 200-Si" file.

2. UnJess otherwise specified, data will automatically be loaded to the default
DEKT AK V 200-Si file on the "C" drive. Click-on the box labeled "File
Name:" just to the right of "*.*" and a flashing cursor will be displayed in the
box.

3. A file name up to eight characters may be entered under which to file data.
Push the back-space key to delete the "*. *" and key in the filename
"EXERCISE" and click-on "OK".

4. The filename "EXERCISE'' will be entered into the data file option. When the
current automation program is run, the data plot screens produced from the
performed scan routines will be filed under
"EXERCISE".
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SECTION 5 - MULTIPLE SCAN OPERATION 

Opening Saved Scan Data Plot 

For the purpose of this exercise, the current Automation Program will be run to 
demonstrate how the data destination option files data plot screens under the 
selected filename. 

1. Click-on "RUN" and click-on "Run Auto Program". The Automation
Program will be run and the data plot screens will be filed.

2. At the conclusion of the Automation Program, the Data Plot screens can be
retrieved by clicking-on "File'' located above the Data Plot Screen.

3. Click-on "Open" from the File Menu and click-on "Single Scan" from the sub­
menu. A directory listing will be displayed of the saved data plot screens.
The data plot screen from scan routines l, 2, and 3 are filed under
"EXERCISE.001", "EXERCISE.002" and "EXERCISE.003" respectively
(see Figure 5-10).

4. To redisplay the Data Plot Screen from Scan Routine #1, click-on
"EXEROSE.l" and cLick-on "OK". The Data Plot Screen from Scan Routine
#1 will be replotted and redisplayed.
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Enabling Automation Program Summary (APS) 

The Automation Program Summary data destination option provides a summary 
and listing of the analytical function results for an Automation Program. All scan 
routines within the automation program must have identical scan routine 
parameters (excluding X,Y,Theta location) for the Automation Program Summary 
to be computed. 

1. Click-on "Window" and click-on "Automation Programs" to return to the
Automation Program Screen.

2. Click-on the line labeled "APS" from the Data Destination Options to display
the Automation Program Summary dialog box (see Figure 5-11).

3. Click-on the box labeled "Print APS" to produce a printout of the Automation
Program Summary.

4. Click-on the "Select File" button under "Binary APS" to save the Automation
Program Summary as a binary file.

5. Click-on the box labeled "Summary File Name" and key-in the filename
"EXERCISE.APS" (by convention, these filenames should be given an .APS
Dos file extension) and click-on "OK".

6. Click-on "RUN" and click-on "Run Auto Program" from the Run menu. The
current Automation Program will be run, and the Automation Program
summary will be computed, displayed, printed, and saved.
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Figure 5-11. Automation Program Summary Dialog Box 
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SECTION 5 - MULTIPLE SCAN OPERATION 

Automation Program Summary Screen 

The Automation Program Summary Screen (see Figure 5-12) provides data on the 
just concluded Automation Program. The items highlighted in yellow include: 
The Automation Program filename, number of Scan Routines, Sample ID, 
Automation Program start time and date. The items highlighted in green display 
the locations of the reference and measurement cursors for each analytical 
function. The items highlighted in blue provide the mean, standard deviation, 
minimum, maximum, and range of the analytical function from all the scan 
routines. The items highlighted in red provide the individual analytical function 
results for each scan routine. 

I. To redisplay the Automation Program Summary after exiting the APS screen,
click-on "Window" and click-on "Auto Prog Summary".

2. To print an Automation Program Summary, click-on "File" and click-on
"Print" and click-on "Auto Prog Summary (APS)" from the File Menu.

3. To redisplay an Automation Program Summary saved to file, click-on "File"
from the APS screen menu bar and click-on "Open" from the Ftle Menu. A
listing of the files saved under the ".APS" DOS file extension will be
displayed. Click-on the desired filename and click-on "OK".

4. To save an Automation Program Summary to file from the APS screen, click­
on "File" and click-on "Save" from the APS File Menu. Enter the desired
filename with the ".APS" DOS file extension and click-on "OK".
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Pause Before Scan 

The Before After Scan data destination option allows a pause or a time delay to be 
entered between each scan routine to pennit the operator time to visually inspect 
or record scan data. Three pause before scan options are available: "No Pause", 
"Adjust", and "Time Delay". When "No Pause" is selected, all scan routines within 
the Automation Program will be run one right after another. When "Adjust" is 
selected, the system will stop after each scan routine to allow any necessary 
adjustments to be made to the sample position. It will wait until the operator 
clicks-on "Continue" from the Run menu before continuing to the next scan 
routine in sequence, contained in the Automation Program. Finally, the "Time 
Delay" selection permits a time delay to be entered between scans. The procedure 
for entering a time delay into the Automation Program is described below. 

l . Click-on "Pause Before Scan" and a dialogue box will be displayed permitting
a time delay to be entered in seconds (see Figure 5-13).

2. For the purpose of this exercise, click-on "Time Delay" and key in "10"
seconds and press "Enter". A ten second delay will be entered between each
scan routine when the current Automation Program is run.
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Figure 5-13. Delay Before Scan 
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UNLOAD AFTER AUTOMATION PROGRAM 

When an Automation Program is complete the "Unload When Done" feature may 
be selected to automatically translate the sample stage to the scan head door at the 
conclusion of an automation program to allow easy loading and unloading of 
samples. 

1. Click-on "Unload When Done" from the automation program data
destination options. The Unload After Program dialogue box will be
displayed (see Figure 5-14).

2. Click-on "Go to Unload Position" and click-on "OK".
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SELECTING DESKEW POINTS 

Each Automation Program contains two Deskew Points. The Deskew feature 
allows the system to compensate for slight sample to sample positioning errors. 

When an Automation Program is being developed on a production reference 
sample, all programmed X-Y coordinates relate to the position of that particular 
sample as it rests on the sample stage. It is highly unlikely that like samples can be 
loaded at the exact physical location of the reference sample used to define the 
Automation Program. Tooling or fixturing pins are extremely helpful and highly 
recommended if fast, accurate sample positioning is to be achieved, however slight 
sample and/or physical positioning variances will throw off or "skew" the 
programmed X-Y coordinates. 

To compensate for this "skewing", Deskew Points can be established on the 
reference sample when the Automation Program is defined. Any easily identifiable 
landmarks on the reference samp1e may be selected as Deskew Points, such as test 
pads on a silicon wafer or the corner of the substrate. 

To assure deskew accuracy, the following steps must be taken when establishing 
or verifying Deskew Points: 

1. Always verify Deskew Points at the same video magnification as the
points were established.

2. Prior to establishing reference or actual Deskew Points, always lower the
stylus by activating the "Tower Down" function from the "STYLUS"
menu, to ensure the tower is nulled over the feature. Always raise the
stylus prior to repositioning the sample.

3. For critical measurements it is recommended that Deskew Points be set
prior to entering the triplets for the scan routines within an Automation
Program.

4. For the greatest deskew accuracy, establish the two Deskew Points at the
greatest diagonal position possible (see Figure 5-15).
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Figure 5-15. Establishing Deskew Points at a Diagonal 

66 

\ 
□
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ESTABLISHING REFERENCE DESKEW POINTS 

In the upper left field of the Automation Programs screen the coordinates for the 
Deskew Points are displayed. If no deskew points have been entered, then "none" 
will appear below "Deskew Points". Two deskew points are required. The 
procedure for setting reference deskew points for this exercise is described below. 

To Set 1st Reference Deskew Point 

1. Click-on "Align" from the menu bar displayed in either the automation
programs window or the fine positioning window and click-on "Set AutoProg
Deskew Points". The fine positioning screen will be displayed along with the
dialog box for setting the first Deskew point.

2. Click-on the software reticule to activate the stage. Roll the pointing device
until the software reticule is lined up with the upper right corner of the
cali bra ti on standard pattern as shown in Figure 5- 16.

3. When the reticule and standard are properly aligned, click the pointing device
a second time to deactivate the stage.

4. Click-on "Profiler" and click-on "Tower Down" to lower the stylus and null
the tower. Then click-on "Profiler" and click-on "Stylus Up" to raise the
stylus. Readjust the reticule/standard positioning if necessary.

5. Click-on "OK" in the dialog box. The current X,Y,Tbeta location will be
entered as the first reference deskew oint.
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Figure 5-16. Setting the First Reference Deskew Point 
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To Set 2nd Reference Deskew Point 

Once the first reference Deskew Point has been set, a second dialog box will be 
displayed providing instructions for setting the second reference Deskew Point 
(see Figure 5-17). The second deskew point must be selected at a point which is 
located at a diagonal from the first reference deskew point. 

1. Roll the pointing device to the software reticule and click. The arrow will
disappear and the stage will track the motion of the pointing device.

2. Position the sample stage so that the lower left corner of the calibration
standard pattern is lined up with the software reticule as shown below. Once
the standard and reticule are properly aligned, click the pointing device a
second time to deactivate the stage.

3. Click-on "OK" in the dialog box. The current X,Y,theta location will be
entered as the second reference deskew points.

4. Click-on "Profiler" and click-on "Tower Down" to lower the stylus and null
the tower. Then click-on "Profiler" and click-on "Stylus Up" to raise the
stylus. Readjust the reticule/standard positioning if necessary.

5_ To verify that the deskew points have been entered, return to the Automation 
Programs screen. The X,Y,theta triplet values of the deskew point locations 
will be displayed. 

TO SET 2ND OESl<J:W POINT; 

Po•itlo.n a feature unde.r the :rtytu.-, 

Ensur-e tower is nulled over feature� 

cm,1c OK to accept lhe <lcakcw polnl 

Scan Here 

.n. .n. ,J"'\. � -+ -� 

Run 
PrOQrlW'I 

• 

Ready 

200MM 

WAFER 

Program: KEVTEST.mp ScRtlt: 3 of 3 

_Gem/Secs- ttelp 

tracklag 
es the feature 
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RUNNING AN AUTOMATION PROGRAM ON A SKEWED SAMPLE 

The exercise below describes the procedure for setting the actual deskew points on 
the skewed calibration standard. Prior to running the Automation Program, 
reposition the calibration standard on the stage, approximately l mm to 2 mm from 
its original position. 

1. Click-on "RUN" and click-on "Run Auto Program" from the Run menu. The
stage will translate to the X,Y,theta location of the reference deskew points.
A dialog box will be displayed providing instructions for checking the first
actual deskew point (see Figure 5-18).

2. Click-on "Profiler" and click-on "Tower Down" to lower the stylus and null
the tower. Click-on "Profiler" and click-on "Stylus Up" to raise the stylus.

3. Click-on the software reticule to activate the stage. Roll the pointing device
to relocate the visually identifiable landmark selected as the 1st reference
deskew point. Line up the software reticule with the upper right comer of the
calibration standard pattern as shown in Figure 5-18.

4. Once the reticule is properly aligned with the calibration standard, click the
pointing device a second time to deactivate the stage.

5. Oick-on "OK" in the dialog box. The dialog box will disappear and the
current X,Y,theta stage location will be entered as the first actual deskew
point. The stage will then translate to the X, Y ,theta location entered as the
second reference deskew oint.
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6. Click-on "Profiler" and click-on "Tower Down" to lower the stylus and null
the tower. Click-on "Profiler" and click-on "Stylus Up" to raise the stylus.

7. Click-on the software reticule to activate the stage. Roll the pointing device
to relocate the visually identifiable landmark selected as the second reference
deskew point. Line up the software reticule with the lower left comer of the
calibration standard as shown in Figure 5-19.

8. Once the reticule is properly aligned with the calibration standard, click the
pointing device a second time to deactivate the stage.

9. Click-on "OK" in the dialog box. The dialog box will disappear and the
DEKT AK V 200-Si is now ready to run the Automation Program. The stage
will translate to the first scan routine location and begin the Automation
Program.

NOTE 

If the DEKTAK V 200-Sl is equipped with the AutoTheta 
Option, a third dialog box will be displayed requesting that the 
2nd Deskew Point be relocated to adjust for any rotational 
offset. Repeat the above procedure (steps 6-9) to relocate the 
2nd actual Deskew Point. 
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REPLACING AN EXISTING AUTOMATION PROGRAM 

By participating in the exercise described in this section, many changes and 
alterations have been made to the Automation Program. The procedure for saving 
an existing Automation Program with changes is described below. 

l. Click-on "Window" and click-on "Automation Programs" to return to the
Automation Programs screen.

2. Click-on "File" and the file menu will be displayed.

3. Click-on "Save As" from the File Menu.

4. Click-on "OK". A second pop-up window will be displayed with a warning
asking if it is OK to replace the existing "EXERCISE.MP".

5. Click-on "Yes". Both windows will disappear and the new automation
program "EXERCISE" will replace the existing program.

NOTE 

To save the Automation Program to the A Drive, click-on 
"Save" from the File menu and save the filename as: 
"A:\EXERCISE.MP". Be sure to return the system to the C 
Drive prior to removing the diskette from the A Drive. 
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SECTION 6 

ANALYTICAL FUNCTIONS 

SECTION OVERVIEW 

This section provides a description of the analytical functions included as part of 
the standard DEKT AK V 200-Si software. These special functions allow the user 
to perform complex analytical computations on the profile data quickly and 
easily. Multiple analytical functions can be entered into a scan routine to 
automatically calculate surface texture parameters on like samples. The operator 
can also perform analytical functions at the conclusion of a scan by selecting the 
desired parameters one-by-one. 

By using these functions to analyze the profile data, valuable information can be 
obtained for controlling and monitoring the production process. To assist the 
operator, analytical functions are grouped by applications: roughness, waviness, 
step height, and geometry parameters. The items included in this section are 
listed below. 

■ Analytical Functions Description
■ Roughness Parameters
■ Waviness Parameters
■ Step Height Parameters
■ Geometry Parameters
■ Analytical Function Exercise
■ Entering Analytical Functions into the Scan Routine
■ Cutoff Wavelength Filters
■ Smoothing

ANALYTICAL FUNCTIONS DESCRIPTION 

The DEKTAK V 200-Si is equipped with 25 different analytical functions for 
measuring surface texture. The following pages provide the abbreviation for each 
function as it appears on the screen, along with a brief description of the 
parameter. 

If extensive surface texture analysis is planned, it is recommended that the ANSI 
B46.l specification on surface texture be studied. A copy of this specification 
can be obtained from the American Society of Mechanical Engineers, 345 East 
47th Street, New York, NY 10017. 
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ROUGHNESS PARAMETERS 

Max Dev Maximum Deviation: Calculates the furthest data point above or 
below the mean line. 

Max Ra Maximum Ra: Identifies that portion of the assessment length 
which has the highest Ra. The assessment length, defined by the 
cursors, is divided into nineteen overlapping segments. Each 
segment is equal to one-tenth of the assessment length distance. 
The Ra is calculated for each segment. The R cursor will be 
positioned in the center of the segment with the highest Ra. Only 
one MRa is allowed to be programmed into a scan program. 

Ra 

Rp 

Rq 

Rt 

Rv 

Rzdin 

Skew 

Arithmetic Average Roughness: Formerly known as AA and 
CLA. Ra is the universally recognized, and most used, 
international parameter of roughness. It is the arithmetic average 
deviation from the mean line. 

Maximum Peale: The maximum height or the highest peale of the 
profile roughness above the mean line, within the assessment 
length. 

Root-mean-square (RMS): Determines the root-mean-square 
value of roughness corresponding to Ra. 

Maximum Peale to Valley: The sum total of the Maximum Peale 
and Maximum Valley measurements of roughness within the 
assessment length (Rt= Rp + Rv). 

Maximum Valley: The lowest point, or the maximum depth of the 
profile roughness below the mean line, within the assessment 
length. 

Ten Point Height Average: The average height difference between 
the five highest peaks and the five lowest valleys in accordance 
with DIN 4768/1 specification published by the Deutsche Institut 
fuer Norrnung c.v. 

Skewness: The symmetry of the profile about the mean line. It 
will distinguish between asymmetrical profiles of the same Ra or 
Rq. 

NOTE 

For the best results, the scan trace should be software leveled 
rior to calculatin an anal · cal functions. 
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WAVINESS PARAMETERS 

Wa Arithmetic Average of Waviness: The average deviation of 
waviness from the mean line (corresponds to Ra). 

Wmaxdev Maximum Deviation of Waviness: Measures the distance of the 
furthest data point above or below the mean line from the waviness 
profile (corresponds to Maximum Deviation of roughness). 

Wp 

Wq 

Wt 

Wv 

Maximum Peak of Waviness: Measures the maximum height of 
the highest peak of the waviness profile, above the mean line 
(corresponds to Rp). 

Root-Mean-Square of Waviness: Determines the root-mean-
square (RMS) value of waviness (corresponds to Wa). 

Maximum Peak to Valley of Waviness: The sum total of the 
maximum peak and maximum valley measurements of waviness 
(Wt=Wp+Wv). 

Maximum Valley of Waviness: The lowest point, or the maximum 
depth of the waviness profile below the mean line (corresponds to 
Rv). 

NOTE 

The waviness analytical functions can only be accessed if the 
DEKTAK V 200-Si is equipped with Software Version 1.12 or 
higher. Waviness calculations will be performed on raw 
profile data unless the low pass waviness filter has been 
activated. 
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STEP HEIGHT PARAMETERS 

ASH 

AVG HT 

HSC 

PC 

PEAK 

PV 

TIR 

VALLEY 

Delta Average Step Height: Used to obtain a step height 
measurement in applications where roughness or noise is present 
on the profile trace. It computes the difference between two 
average height measurements. 

Average Height: Calculates the average height of a step, with 
respect to the zero line, using the R and M cursors to define the 
area of measurement. 

High Spot Count: The number of peaks that project above a line 
that is parallel to the mean line. 

Peak Count: The number of peaks that project through a selectable 
band centered about the mean line of the assessment length 

Maximum Peak: Calculates the maximum height above the 
baseline, as determined by the cursor/trace intercepts. 

Maximum Peak to Valley: Calculates the vertical distance 
between the maximum peak and maximum valley. 

Total Indicated Reading: Calculates the vertical distance between 
the highest and lowest data points between the cursors. 

Maximum Valley: Calculates the maximum depth below the 
baseline, determined by the cursor/trace intercepts. 
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GEOMETRY PARAMETERS 

Area 

Perim 

Radius 

Slope 

TP 

Volume 

Area-Under-The-Curve: Computes the area of a profile between 
the R and M cursors with respect to the horizontal zero grid line. 
The profile must be leveled for accurate results. If the profile is 
above the zero line, area is expressed as a positive value in square 
microns. If the profile is below the zero line, the result will be a 
negative value. 

Perimeter: Calculates the outside perimeter of a profile between 
the R and M cursors. A horizontal reference line is created using 
the R and M cursor intercepts. The profile must be leveled for 
accurate results. 

Radius: A least-squares-arc is fitted to the data points and the 
radius is calculated from the equation of a circle. The algorithm 
does not distinguish between concave and convex shapes. To 
maximize the accuracy of the results, the following factors must be 
considered: (1) the sample shape must approximate a sector of a 
circle: (2) the stylus tip must traverse the apex of the sample if it is 
a sphere. Using the largest radius stylus possible will help 
minimize the error; (3) Repeatability errors may dominate the 
measurement if the chord rise is less than 100.A for scans longer 
than 1 mm. 

Slope: Calculates the arc tangent of the ratio of the vertical 
distance to the horizontal distance between the R and M 
cursor/trace intercepts. The result is expressed in degrees. Slope 
is useful only for relatively shallow slopes. If the stylus radius is 
too large or the step too steep, the stylus will contact the upper 
edge of the step before the lower edge and the slope measurement 
will be inaccurate. 

Bearing Ratio: The percentage of points along the assessment 
length that project above a line that is parallel to the mean line. 

Volume: The integration-by-shells technique is used to find the 
volume of a solid. This is accomplished by rotating the lamina 
delineated by the scan trace and a line segment connecting the 
cursor intercepts through 180 degrees about a vertical axis which is 
located half way between the cursors. 
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SECTION 6 - ANALYTICAL FUNCilONS 

ANALYTICAL FUNCTION EXERCISE 

This exercise will demonstrate how to perform an average roughness 
measurement at the conclusion of a scan. For the purpose of this exercise, the 
optically flat glass of the calibration standard provided with the system can be 
used. The calibration standard should be positioned so that a 2 mm scan will 
traverse across the glass portion of the standard without encountering a step (see 
Figure 6-2). 

1. Click-on "Windows" and click-on "Automation Programs". The Automation
Programs screen will be displayed.

2. Click-on "File" from the menu bar, and click-on "new" from the menu. The
default scan routine will be entered into the current Automation Program.

3. With the stage positioned as shown in Figure 6-2, click-on "RUN". From the
main menu bar and click-on "Run ScRt Here" from the menu. The current
Scan Routine will be run.

4. Once the scan routine has been run with the profile plotted, the trace must be
leveled. Click-on "Plot" and click-on "Level" from the menu. The trace will
be replotted and leveled.

NOTE 

Prior to initiating any analytical function, the trace must first 
be software leveled to obtain accurate results. 
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Figure 6-1. Calibration Standard Positioning for a Roughness Measurement 
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SECTION 6 - ANALYTICAL FUNCTIONS 

AVERAGE ROUGHNESS MEASUREMENT 

Once the scan is run and the profile trace is leveled, an analytical function may be 
performed from the Data Plot screen. The procedure for executing the Average 
Roughness (Ra) analytical function on the raw profile data is described below. 
The analytical function will only be calculated on the data between the R and M 
cursors. The cursors can be relocated if desired, but for this exercise, the default 
cursor setting of 100 and 1900 microns should be appropriate for a 2 mm scan. 

l. Click-on "Analysis" from the menu bar and click-on ''Analytical Functions"
to display the dialogue box below (see Figure 6-3).

2. The Analytical Functions Menu contains selections for setting roughness,
waviness, heights, and geometry parameters. The roughness functions menu
lists nine different parameters, click-on "RA". The RA parameter will be
highlighted.

3. Click-on the "measure" button provided in the roughness functions window
(selecting "measure and program" automatically enters the analytical function
into the Scan Routine program).

4. Click-on "Compute" and the window will disappear and the average
roughness will be calculated. The result from the RA function will be
displayed in the area of the left of the Data Plot screen along with the cursor
locations. Note that an asterisk appears next to the Ra, this indicates that the
analytical function was calculated on the raw, unfiltered data.
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SECTION 6 - ANALYTICAL RJNCTIONS 

DETERMINING THE CUTOFF WAVELENGTH 

The DEKT AK V 200-Si is equipped with short pass, and long pass digital filters 
for filtering out high and low frequency signals. In effect, the cutoff frequencies 
defines the intended difference between roughness and waviness. The filters are 
designed in accordance with the ANSI B46.1 specification on surface texture. 
The wavelengths are user selectable from 1 to 200,000 microns. 

The appropriate cutoff wavelength will vary from application to application. 
However, it is recommended that the scan length be at least 5-10 times longer 
than the cut-off wavelength. The cutoff value will not be accepted if fewer than 8 
data points are available per cutoff wavelength. The "scan Resolution" parameter 
displayed on the Scan Routine Screen provides the number of microns per sample 
for a given scan length and speed. The minimum acceptable cut-off wavelength 
must be at least eight times longer than the value listed as the scan resolution. 
This can be otherwise defined as: microns per sample x 8 = minimum acceptable 
cut-off wavelength. 

For example, the default scan routine used for the purpose of this exercise has a 
scan length of 2000 microns, a scan speed of medium, and a scan resolution of 
0.513 microns per sample. Multiplying 0.513 by 8 equals 4.10, so the minimum 
acceptable cut-off wavelength is 5 microns. The scan length must be at least 5 
times greater than the cut-off wavelength. Dividing the 2000 micron scan length 
by 5 equals 400. Therefore, a cut-off value must be selected between 5 and 400 
microns. 

Three separate cut-off filters are provided for selecting the wavelength by pass 
frequency. The three filters are described below. 

Short (High) Pass Filter 

This filter is used for calculating roughness data. It filters out low frequency 
waviness signals and allows high frequency roughness data to pass through. 

Long (Low) Pass Filters 

This filter is used for calculating waviness data. It filters out high frequency 
roughness signals and allows low frequency waviness data to pass through. 

Band Pass Filter 

When the band pass filter is selected, both the short pass and long pass filters will 
be enabled to calculate the roughness data. It creates a band which filters out 
high frequency signals above the band and low frequency signals below the band. 
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SECTION 6 - ANALYTICAL FUNCTIONS 

ACTIVATING THE CUTOFF FILTERS 

To obtain accurate roughness measurements, it is recommended that the short 
pass filter be activated. The procedure for activating the short pass and long pass 
filters is described below. 

1. Click-on "Analysis" from the Data Plot Screen menu bar, and click-on
"Cutoff Filters" from the Analysis Menu. A dialog box will be displayed for
setting the roughness and waviness filters (see Figure 6-4).

2. Click-on the box labeled "Short Pass Filter Cutoff' and enter a value of 20.

3. Click-on the box labeled "Long Pass Filter Cutoff' and enter a value of 200.

4. Click-on "OK" and the profile trace will be replotted with three separate scan
traces: The white trace represents the raw profile data, the yellow trace
represents the roughness profile as determined with the short pass filter, and
the red trace represents the waviness profile as determined by the long pass
filter.
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SECTION 6 - ANALYTICAL FUNCTIONS 

DAT A TYPE SELECTION 

The operator may select the type of data to be displayed on the data plot screen. 
The raw, roughness, and waviness profile data can be displayed either 
individually or simultaneously. The procedure for selecting the data type is 
described below. 

1. Click-on "Plot" from the Data Plot Screen menu bar. The Plot Menu will be
displayed.

2. Click-on "DataType" from the Plot menu. A window will be displayed
permitting the selection of raw, roughness, or waviness data type display.
All three selections should be activated as indicated by an "X" in their
respective boxes (see Figure 6-5).

3. Click-on the box labeled "waviness" to delete the "X" from the box. (The
box acts as a toggle to switch the data type on and off.)

4. Click-on "OK". The Data Plot screen will be replotted with the roughness
and raw data profiles displayed and the waviness profile deleted.
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SECTION 6- ANALYTICAL FUNCTIONS 

MEASURING AND ENTERING ANALYTICAL FUNCTIONS 

Once the short pass roughness filter is activated, perform the average roughness 
analytical function a second time. Analytical functions can be entered into the 
current scan routine from the Data Plot Screen to be automatically calculated 
whenever the current scan routine is performed. The procedure for measuring the 
Ra function and entering it into the scan routine is described below. 

1. Click-on "Analysis" from the Data Plot Screen menu bar and click-on
"Analytical Functions". The Analytical Functions menu will be displayed.

2. Click-on "RA" from the roughness functions menu. The RA parameter will
be highlighted.

3. Click-on the "Measure and Program" button provided in the Roughness
Functions window (see Figure 6-6).

4. Click-on "Compute". The Roughness Functions menu will disappear and the
average roughness will be measured and entered into the current scan routine.
The result from the Ra function will be displayed in the area to the left of the
data plot screen. Note the different results from the first Ra calculated on the
unfiltered raw profile data and the second Ra calculated on the filtered
roughness data.
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SECTION 6 - ANALYTICAL FUNCTIONS 

ENTERING ANALYTICAL FUNCTIONS INTO A SCAN ROUTINE 

Multiple analytical functions can be entered into the Scan Routine screen, to be 
automatically calculated at the conclusion of the scan. The procedure for entering 
analytical functions into the scan routine is described below. 

l . Click-on "Window" from the system menu bar, and click-on "Scan Routines"
from the Programs menu. The Scan Routine screen will be displayed.

2. Click-on "Edit" from the Scan Routine screen menu bar, and click-on
"Append Analytical Functions". The Analytical Functions menu window
will be displayed.

3. Click-on "WA" from the Waviness Functions Window. "WA" will be
highlighted.

4. The cursors can be set at different locations for each individual analytical
function. To adjust the cursor positioning, click-on the box labeled "R.
Cursor", delete the current value, and key-in 0. Then click-on the box
labeled "M. Cursor", delete the current value, and key-in 2000.

5. Click-on "ADD". The WA function will be entered into the area on the right
of the Scan Routines screen labeled "Analytic Functions" (see Figure 6-7).
Click-on "DONE" when complete.
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SECTION 6 - ANALYTICAL FUNCTIONS 

ENTERING FIL TEA CUTOFFS INTO A SCAN ROUTINE 

The short pass and long pass filters can be entered into the scan routine to 
automatically be activated for calculating roughness and waviness analytical 
functions. The procedure for entering filter cutoffs into a scan routine is 
described below. 

1. Click-on the data processing parameter labeled "Filter Cutoffs" from the
Scan Routine Screen. The filter cutoffs parameter will be highlighted.

2. Click-on the box labeled "Short Pass Filter Cutoff' and key-in a cutoff value
of 20 microns for calculating roughness.

3. Click-on the box labeled "Long Pass Filter Cutoff' and key-in a cutoff value
of 200 microns for calculating waviness.

4. Click-on "OK" and the dialog box will disappear and the cutoff values will
be entered into the scan routine.
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SECTION 6- ANALYTICAL FUNCTIONS 

ENTERING DAT A TYPE INTO A SCAN ROUTINE 

The type of profile data to be displayed at the conclusion of a scan can also be 
predetermined by entering the selected data types into the scan routine. The 
procedure for entering the data type into a scan routine is described below. 

1. Click-on the "Disp. Data Type" parameter from the Scan Routine Screen.
The Disp. Data Type parameter provides three options: raw, roughness, and
waviness.

2. When the default Scan Routine is used, the raw profile data is entered as the
Display Data Type parameter. For the purpose of th.is exercise all three data
types will be displayed. The boxes containing the data type selections act as
a toggle for entering and deleting the selections. Click-on the boxes labeled
"Roughness" and "Waviness" to enter all three data types into the scan
routine (see Figure 6-9).

NOTE 

The roughness data type cannot be selected unless the short 
pass filter is first activated. Likewise, the waviness data type 
cannot be selected unless the lone: oass filter is activated. 

Once the Analytical Functions, cutoff filters, and display data types have been 
entered into the current scan routine, they will automatically be executed 
whenever the current scan routine is run. 
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SECTION 6 - ANALYTICAL FUNCTIONS 

DELETING ANALYTICAL FUNCTIONS FROM A SCAN ROUTINE 

When the Scan Routine Screen is displayed and an analytical function is entered, 
the delete function can be accessed from the Analytical Functions Menu. The 
procedure for deleting an analytical function from the scan routine is described 
below. 

1. Roll the pointing device to the right hand portion of the Scan Routines screen
where the entered Analytical Functions are stored. Click-on the desired
analytical function to be deleted. For the purpose of this exercise, click-on
"WA". The function to be deleted will be highlighted.

2. Click-on ''Edit" from the Scan Routine Screen menu bar and click-on "Delete
Analytical Functions". The Delete Analytical Functions window will be
displayed.

3. Click-on "OK" from the Delete Analytical Functions Window. The 
highlighted analytical function will be deleted from the Scan Routine.
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SECTION 6 ·ANALYTICAL FUNCTIONS 

DESCRIPTION OF SMOOTHING FUNCTION 

Whenever the smoothing function is activated, the roughness, waviness, or raw 
profiles will be calculated using the smoothed data. The smoothing function is 
used to reduce high frequency, low amplitude noise on a trace. Some 
applications involve films deposited over rough substrates. This substrate 
roughness "transfers" to the film surface, which can make measurements difficult 
or questionable. 

The DEKT AK V 200-SI offers three degrees of smoothing. The higher the 
degree, the more smoothing will be realized. 

Degree l : 5-point smoothing. 

Degree 2: 11-point smoothing. 

Degree 3: 23-point smoothing. 

After the degree of smoothing is selected, a prompt asks for the value of the 
vertical distance between the maximum peak to valley roughness. 

Determine the maximum peak to valley distance of the high frequency low 
amplitude noise, and then enter this or a greater value (the TIR analytical function 
can easily be used to determine the noise band to be entered). 

The smoothing function smoothes all data within the specified noise band by 
examining eacb data point in turn and comparing it with the previous and 
following points. 

If Degree I is selected, five consecutive data points are used in the smoothing 
calculation and if they lie within the specified noise band, a running calculation is 
started. A first-order curve is fitted to all consecutive points lying within the 
noise band. As new points are examined, the routine calculates the new value of 
each point by looking at the four closest points that lie within the band. 

When the algorithm encounters a point that lies outside the band, the calculation 
is interrupted. The new point is left "as is" and becomes a center point of a new 
noise band. If the next five points are within the new band, the calculation is 
restarted. If subsequent points lie outside the band, they will be plotted "as is," 
and each becomes a new reference point. This technique is desirable to straight 
filtering as the slope of the profile is maintained. 

The smoothing function may be used in one of two ways. In applications where 
rough samples will be run on a regular basis, smoothing may be entered into the 
Scan Routine. In this way, the smoothing function will be performed on each 
scan profile automatically. The smoothing function may also be selected after a 
scan has been completed. Both methods for smoothing will be discussed on the 
following pages. 
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SECTION 6 - ANAL YTJCAL FUNCTIONS 

ACTIVATING THE SMOOTHING FUNCTION 

Smoothing may be performed on profile data at the conclusion of a scan. The 
procedure for activating the smoothing function from the Data Plot Screen is 
described below. 

1. Click-on "Window'' from the system menu bar, and click-on "Data Plot"
from the Window Menu. The Data Plot Screen will be displayed with the
profile data replotted.

2. Click-on "Analysis" from the Data Plot Screen menu bar, and click-on
"Analytical Functions" to display the Analytical Functions menu.

3. Click-on "TIR" from the Height functions and click-on "Compute". The total
indicated reading peak to valley distance will be calculated.

4. Click-on "Analysis" from the Data Plot Screen menu bar, and click-on
"Smoothing" from the Analysis Menu. A dialog box will be displayed for
entering smoothing parameters (see Figure 6-11).

5. Three degrees of smoothing are available. For the purpose of this exercise,
enter "2" into the box labeled "smoothing degree".

6. Click-on the box labeled "Smoothing Band" and enter a value equal to or
greater than the value displayed as the TIR result. Click-on ''OK" and the
raw profile data will be smoothed and replotted.
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SECTION 6 - ANALYTICAL FUNCTIONS 

ENTERING SMOOTHING INTO A SCAN ROUTINE 

Smoothing may be entered into the current scan routine to automatically be 
executed at the conclusion of the scan. Toe procedure for entering smoothing 
into the scan routine is described below. 

1. Click-on "Window" from the system menu bar, and click-on "Scan Routines"
from the Window Menu. The Scan Routines screen will be displayed.

2. Click-on the "Smoothing" parameter from the Scan Routines screen.

3. The Smoothing Parameter window will be displayed pennitting smoothing
parameter to be entered. Three degrees of smoothing are available. Enter
the desired degree either 1, 2, or 3.

4. The smoothing band value can be determined by perfonning the Total
Indicated Reading (TIR) analytical function on the scan to be smoothed.
Enter a value equal to or greater than the TIR value. The smoothing function
will now automatically smooth the profile data whenever the current scan
routine is executed. To clear smoothing, click-on the smoothing parameter
and click-on "NO".
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SECTION 7 - SYSTEM MENU DESCRIPTIONS 

SECTION 7 

SYSTEM MENU DESCRIPTIONS 

SECTION 7 OVERVIEW 

This section provides a brief description of the various menus and menu 
selections available in the DEKTAK V 200-Si software. This section is included 
to provide additional information on the various menu items which may or may 
not have been discussed in the previous sections of this manual. Items discussed 
in this section include: 

■ System Menu
■ File Menu
■ Run Menu
■ ProftlerMenu
■ Setup Menu
■ Diagnostics Menu
■ Window Menu
■ Calibration Menu
■ Automation Programs Menu Selections
■ Scan Routine Menu Selections

The DEKT AK V 200-Si uses Microsoft Windows as the user interface. 
Microsoft Windows is an extension of the DOS operating systems. Whenever the 
DEKT AK V 200-Si file is accessed, the DEKT AK V 200-Si screen is displayed 
(see Figure 7-1). Continually displayed at the top of the DEKTAK V 200-Si 
screen is the system menu bar. The various menus included in the system menu 
bar are described in the following pages. Individual screens such as the 
Automation Programs screen and the Scan Routines screen, have a second, screen 
specific, menu bar in addition to the system menu bar. These additional menus 
will also be described later in this section. 
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SECTION 7 • SYSTEM MENU DESCRJPTIONS 

SYSTEM MENU 

The DEKT AK V 200-Si user interface consists of a variety of screens. The 
system menu box, status line and system menu bar are continually displayed at 
the top of each screen (see Figure 7-1). 

System Menu Box 
The small box in the upper left corner of the screen displays a pop-up window 
when clicked on (See Figure 7-1). The window permits the user to exit the 
DEKT AK V 200-Si software and enter MS-DOS commands. 

Status Line 
A status line is visible at all times, located at the bottom of the screen. It 
constantly displays screen specific status information and the current X, Y, theta 
stage position. 

System Menu Bar 
The system menu bar provides access to the different types of operations 
available. The various menus contained within the system menu bar come under 
the headings: File, Run, Profiler, Setup, Diagnostics, Window, and Calibration. 
A description of the contents of each menu and instructions for accessing them 
are provided in the following pages of this section. 
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Figure 7-1. System Menu Box 
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SECTION 7 - SYSTEM MENU DESCRIPTIONS 

FILE MENU 

The File Menu allows Automation Programs and other files to opened, saved or 
printed. To access the File Menu, click-on "File" (see Figure 7-2). 

New 
The "New" selection replaces the existing automation program with a new single 
scan automation program containing the default scan parameters. 

Open 
The "Open" selection allows an automation program or other previously saved 
files to be opened. Clicking-on "Open" displays a list of available files. 

Save 
The "Save" selection saves any recent changes to the current automation program. 

Save As 
The "Save As" selection allows an automation program to be saved under a 
different file name. Clicking-on "Save As" displays a list of current file names. 

Export 
The "Export" selection allows an automation program to be exported as a TXT 
file. Clicking-on "Export" displays a list of current TXT files. 
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Figure 7-2. File Menu 
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SECTION 7 • SYSTEM MEi\lU DESCRIPTIONS 

FILE MENU (CONTINUED) 

Print 
Clicking-on "Print" displays a sub-menu providing access to a variety of print 
functions described below. 

Automation Program Index 
Clicking-on "Auto Prog Index" produces a printout of an index of the current 
Automation Programs saved on the hard disk. 

Automation Program Form 
Clicking-on "Auto Prog Form" produces a printout of the file name, deskew 
points, data destination options, and scan routines entered into the current 
Automation Program. 

Automation Program Summary (APS) 
This print function provides a summary of the analytical results from a multiscan 
Automation Program. The "Auto Prog Summary (APS)" selection can only be 
accessed when the APS function is activated in the Automation Program. 

Expanded APS 
This print function provides a more detailed printout of the results from a 
multiscan Automation Program Summary. The "Expanded APS" selection can 
only be accessed when the APS function is activated in the Automation Program. 

Scan Routine Form 
Clicking-on "Scan Routine Form" produces a printout of the scan parameters and 
analytical functions entered into the current Scan Routine. 

Scan Data 
Clicking-on "Scan Data" produces a printout of the plotted profile trace along 
with the scan data summary. 

Scan Data Summary 
Clicking-oa "Scan Data Summary" produces a printout of the parameters and the 
analytical function results from the just completed Scan Routine. It provides a 
summary of the scan data only. 

Loader Process Status 
This selection can only be accessed if the DEKT AK V 200-Si is equipped with 
the cassette loader. Clicking-on "Loader Process Status" produces a printout of 
the parameters from the loader process status screen. 

Print Active Screen 
This print function acts as a Print Screen command. It prints the entire current 
active screen to an external printer. This operation will work with any raster­
type, Windows compatible printer, including all dot matrix, LaserJet, Postscript 
and even color printers. 

Calibration Factors 
Clicking-on "Calibration Factors" produces a printout of the current calibration 
factors for the DEKTAK V 200-Si. 
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SECTTON 7 • SYSTEM MENU DESCRIPTIONS 

RUN MENU 

This pull-down menu is used to run a Scan Routine or an Automation Program. 
To access the Run Menu, click-on "Run" (see Figure 7-3). 

Scan 
When "Scan" is clicked-on, the stage moves the X,Y,Theta location of the current 
Scan Routine, and runs a scan. 

Scan Here 
When "Scan Here" is clicked-on, the current Scan Routine is run at the current 
X,Y,Theta stage position. 

Auto Program 
When "Auto Program" is clicked-on, all of the Scan Routines m the current 
Automation Program are run, beginning with Scan Routine #1. 

Auto Program From 
When "Auto Program From" is clicked-on, the current Automation Program is 
run beginning at the selected scan routine. 

Auto Program By Index 
This selection provides a printout of the Automation Program Header. 

Continue 
This command is used to continue the current Automation Program when the wait 
between scan routine function has been activated. 

Dektak V 200-Si 

Surlace Profile Measuring System 
Slolln Technology 

A Subsidhuy of Veec:11 Instruments, Inc. 
Ven1lo11 7 .00 

Copyright [cj I !r91-1995, Sloan Technology Division 

Figure 7-3. Run Menu 
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SECTION 7 - SYSTEM MENU DESCRIPTIONS 

PROFILER MENU 

This pull-down menu is used for controlling profiler functions. To access the 
Profiler Menu, click-on "Profile" (see Figure 7-4). 

Tower Up 
When "Tower Up" is clicked-on, the system tower will be raised all the way up. 

Tower Down 
When "Tower Down" is clicked-on, the stylus will be lowered all the way down 
until it makes contact with the sample surface and then the stylus will be Lifted off 
the surface. The tower speed may be set in the Scan Routines screen at high, 
medium, or low speed. 

Stylus Up 
When "Stylus Up" is clicked-on, the system raises the stylus off the surface of 
substrate without raising the stylus tower. This allows the user to view the video 
image of the stage surface while positioning the stage, without contact between 
the stylus and sample. 

Stylus Down 
When "Stylus Down" is clicked-on, the stylus will be lowered onto the sample 
surface. The stylus is automatically raised off the sample surface whenever the 
sample stage is repositioned. 

Sample Positioning 
Displays the sample positioning screen providing a video image of the sample 
surface with a repositionable stylus reticule and feature alignment reticule 
superimposed. It permits fine sample positioning, theta rotation, and a sample 
template for coarse positioning. 

Move to Scan Location 
Moves the stage to the X,Y,Theta location of the current Scan Routine. 

Rotate 
Displays a dialogue box which allows adjustments in the theta rotation of the 
sample stage. 

Load 
Translates the stage to the load position, centered directly below the stylus. 

Unload 
Translates the stage to the front of the scan head, permitting convenient loading 
and unloading of samples. 

Auto Leveling 
The auto leveling feature can only be accessed when the data plot screen is 
displayed. It is used interactively at the conclusion of a scan to automatically 
level the sample stage_ 

Power Leveling 
Displays a dialogue box which permits motorized adjustments the level or tilt of 
the sample stage up or down. 
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SECTION 7 - SYSTEM MENU DESCRIPTIONS 

Make Horizontal 
This feature is useful to correct rotational offsets in the positioning of skewed 
samples on the sample stage. 

Remove Backlash 
Tus feature removes any backlash in the scan stage to assure sample positioning 
repeatability. 

Optics 
Clicking-on "Optics" displays a window which allows adjustments to the zoom 
optics, sample illumination and camera focus (The optional remote control focus 
must be installed to adjust the focus using the optics window). 

Video Only 
When this selection is clicked-on, the video image of the sample surface from the 
DEKTAK V 200-Si's 35-200X video zoom microscope is projected on the 
monitor. 

Graphics Only 
When "Graphics Only" is clicked-on the graphic screen is displayed on the 
monitor, without the video image. 

Video and Graphics 
When "Video and Graphics" is clicked-on the graphic screen is superimposed 
over the video image of the sample surface. 
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SECTION 7 - SYSTEM MENU DESCRIPTIONS 

SETUP MENU 

This pull-down menu is used for setting up the DEKT AK V 200-Si (see Figure 7-
5). 

Printer Port 
Allows the print signal to be transferred to the standard thermal printer port or to 
the external printer port. 

Wafer Template 
Displays a listing of the various size wafer and disk template selections available 
for the coarse positioning screen. 

Working Directories 
Allows the working directories to be altered. 

Stylus Reticule 
Displays a dialog box for adjusting the stylus reticule position on the screen. 

Default Theta Alignment 
This selection can only be accessed with optional programmable theta installed. It 
displays a dialogue box which permits the default theta alignment to be changed. 

Theta Resolution 
This selection can only be accessed with optional programmable theta installed. I 
displays a dialogue box which permits the theta resolution to be adjusted . 
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SECTION 7 - SYSTEM MENU DESCRIPTIONS 

SETUP MENU (Continued) 

Configuration Parameters 
Displays the factory set up parameters for software and hardware options. 

Set X Backlash Parameter 
For optimal repeatability in stage positioning, stage locations should always be 
selected for the left, i.e., move the stage to the left of the position desired and the 
approach the position from that side before selecting it. When the stage is 
automatically positioned for scanning, if the anti-backlash algorithm is enabled, 
the location will also be approached from the left. This eliminates repeatability 
errors due to backlash in the gears. To enable the backlash algorithm, enter a 
backlash distance in the "Distance" field. A value of 1000 is suggested. Enter Oto 
disable the algorithm. The speed and acceleration values should not require 
adjustments. 

Set Deskew Offsets 
This selection allows the user to correct for offsets in the deskew positioning or 
reset the deskew points. 

Password 
This selection allows password protection to be enabled at various levels on the 
DEKTAK V 200-Si. The password security level is displayed in the "About" 
dialogue box, accessible from the system menu. 

Automation Program Options 
This selection allows the Automation Program options of including a header or 
executing options after an A.PS edit. 

SECS Parameters 
Semiconductor Equipment Communications Standard (SECS) cannot be accessed 
without optional software installed. This selection displays a dialog box which 
permits the setting of band rates, time outs, device I.D., retry limit, and maximum 
SECS blocks. It allows the DEKT AK V 200-Si to be placed on-line. 

99 



SECTION 7 • SYSTEM MENU DESCRIP11ONS 

DIAGNOSTICS MENU 

This pull-down menu is used for diagnostic testing and analysis of the DEKTAK 
V 200-Si. To access the Diagnostics Menu, click-on "Diag" (see Figure 7-6). 

Toggle ON/OFF Debug Boxes 
This selection acts as a toggle to turn the automatic display of debug boxes on and 
off. 

View Diagnostics Messages 
This selection displays the diagnostics messages on the screen. 

Select Hardware Diagnostics 
This selection allows the selected hardware diagnostics to be saved to file. 

Initialize and Home Stage 
This selection initializes and homes the sample stage. 

Reinitialize Stage 
This selection reinitializes the sample stage. 

Initialize SP<->RTC Communications 
This selection initializes the SP to RTC communications. 
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WINDOW MENU 

This pull-down menu provides access to the various DEKT AK V 200-Si screens 
(see Figure 7-7). 

Automation Programs 
When "Automation Programs" is clicked-on, the Automation Program screen is 
displayed which permits alterations to the Automation Programs. 

Scan Routines 
When "Scan Routines" is clicked-on, the Scan Routine program screen is 
displayed. The Scan Routines screen is used to enter all scan parameters. 

Sample Positioning 
This selection provides access to the sample positioning screen where adjustments 
to the X-Y -Theta stage position and the optics can be made. 

Data Plot 
The Data Plot selection can only be accessed once a Scan Routine has been run 
and plotted. The data plot screen displays the scale profile trace. 

Automation Program Summary 
The "Auto Prog Summary" can be selected when APS has been enabled, in the 
Automation Program Screen, and the Automation Program has been run. 

Signon Screen 
This selection displays the Signon Screen shown below. 
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CALIBRATION MENU 

Calibrate Theta 
Displays a dialog box for setting theta calibration. The programmable theta option 
must be installed to access this selection. 

Calibrate X, Y Axes 
Displays a dialog box for setting the X,Y calibration of the DEKTAK V 200-Si. 

Find Center of Rotation of Stage 
Displays a dialog box for finding the center of a skewed sample on the stage. 

Vertical Calibration 
Displays a dialog box for setting and clearing the vertical calibration of the 
DEKTAK V 200-Si (see Section 10 of this manual). 
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SECTION 7 - SYSTEi"1 MENU DESCRIPTIONS 

AUTOMATION PROGRAMS MENU SELECTIONS 

When the Automation Programs screen is displayed, additional menu selections 
are provided (see Figure 7-9). These menus are briefly described below. A more 
detailed description of the use and functions of the menu items is provided in 
Section 5 of this manual. 

Edit Menu 
Selecting "Insert Default Scan Rt" establishes the current Scan Routine as the 
default Scan Routine. Selecting "Delete Scan Rt" deletes the current Scan 
Routine from the Automation Program. "Delete ScRt Range" allows a range of 
scan routines to be deleted. Selecting "Copy To" allows the current Scan Routine 
to be copied to a requested scan routine number. Selecting "Copy To Range" 
allows the current Scan Routine to be copied to a range of Scan Routine numbers. 
Selecting "Auto Prog Header" displays a dialogue box for creating an automation 
program header. Selecting "Build AutoProg Index" displays a dialogue box for 
building an automation program index. 

Align Menu 
Selecting "Clear Auto Prog Deskew Points" clears the current deskew points 
from the Automation Program. Selecting "Set Auto Prog Deskew Points" 
provides instructions for entering new reference deskew points into the 
Automation Program. The "Auto Alignment" selection can only be accessed if the 
unit is equipped with automatic alignment . 
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SCAN ROUTINE MENU SELECTIONS 

When the Scan Routines screen is displayed, additional menu selections are 
provided (see Figure 7-10). These menus are briefly described below. 

Edit Menu 

The Edit Menu permits editing of individual scan routines or global editing of all 
the scan routines within a multiscan Automation Program. Selecting "Next" 
displays the next scan routine in sequence of the current Automation Program. 
Selecting "Previous" displays the previous scan routine of the current Automation 
Program. The "Go To" function allows a selected scan routine to be displayed. 

The "Append Analytical Functions" selection permits analytical functions to be 
entered into the scan routine. The "Delete Analytical Functions" selection permits 
highlighted analytical functions to be deleted from the scan routine. 

The Global Edit selection acts as a toggle to activate and deactivate the Global 
Edit Mode. When the Global Edit Mode is activated any changes to the 
parameters of the displayed scan routine will effect all. the scan routines within 
the Automation Program. 

Pro ram: <Untitled> ScR\6: 1 of 1 

fdlt Align Bun frofiler 
!!!!XI 
frevious 
foTo ... 

!ID lq, L 1111, 0 

/1ppend Analytical Functions ... 
6-6930ua, o. aoo 

Global fdll Mode 

Scan Duration: 13 sec 
Scan Resollrtion: D.�13 uivsaa,ple 
ti. Range: 6"SSi<A 
Profile: -'1..r 
Stylus force: 3� 
Tower Speed: High 

jDISPLAY PARAMETERS! 
s. leveling: Ho 
R. Cursor: 1UU.OOU• 
It. Cursor: 1911tl. GOun 
Disp. Range: Auto 
Disp. Data Type: Ra� 

jDATA PROCESSING! 
Filter Cutoffs: Ho 
Snoothing: Ho 
Step Detection: Disab1ed 

!ALIGNMENT I
Hon11 

-Oisplay the next scan routine- form in program llsl 

i

i 

Figure 7-10. Scan Routine Menus 

104 

Analytic Functions 

iX:102250, Y:166930, T:O 



SECTION 8. SCAN ROlITINE PARAMETER DESCRIPTIONS 

SECTION 8 

SCAN ROUTINE PARAMETER DESCRIPTIONS 

SECTION 8 OVERVIEW 

This section describes the various scan parameters and display parameters of the 
Scan Routine Screen (see Figure 7-10). Up to 200 different Scan Routines can be 
entered into a single Automation Program File. Each Scan Routine within an 
Automation Program contains all the necessary parameters for performing a 
specified scan. These individual parameters are user selectable, providing 
extraordinary flexibility to adopt the DEKT AK V 200-Si for a wide range of 
applications. The Scan Routine parameters discussed in this section include: 

■ Location
■ Scan ID
■ Scan Length
■ Scan Speed
■ Scan Resolution
■ Measurement Range
■ Profile
■ Stylus Force
■ Tower Speed
■ Software Leveling
■ Reference Cursor
■ Measurement Cursor
■ Display Range
■ Display Data Type
■ Filter Cutoffs
■ Smoothing

SCAN ROUTINE PARAMETERS WINDOW 

All of the above parameters are user selectable and can be accessed from the Scan 
Routine window. To display the Scan Routine window, click-on the "Window" 
selection from the menu bar and click-on "Scan Routine" from the Window 
Menu. The Scan Routine window will be displayed (see Figure 8-1). 
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SCAN PARAMETERS 

The procedure for setting the various scan parameters is described below. 

Location 

This parameter displays the X,Y,Theta stage location at which the current scan 
routine will be performed. The first number in the triplet represents the X 
location, the second number is the Y location, and the third is the Theta location 
expressed in degrees. 

The stage location can be altered by clicking-on the "Location" parameter. When 
the "Location" parameter is highlighted, a box for entering each triplet is 
displayed (see Figure 8-1 ). Simply click-on one of the boxes labeled X, Y, or T 
and enter the desired coordinates using the DEKT AK V 200-Si numeric keypad. 
Press the enter key to set the new location. 

Because the numeric value of the X,Y,Theta location is often not known, in most 
cases the stage location will be entered by using the Sample Positioning Screen. 

Scan ID 

This parameter permits a four digit scan identification filename or number to be 
assigned. To enter the Scan I.D. click-on the "Scan ID" parameter. When the 
"Scan ID" parameter is highlighted, a box for entering the number is displayed. 
Key-in the desired filename or number using the keyboard and press enter. 
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SECTION 8 - SCAN ROUTINE PARAi\1ETER DESCRIPTIONS 

Scan Length 

The exclusive ScanStitching feature enables Scan Lengths from 50 microns to 
300,000 microns (300mm). To enter a scan length over 100mm the ScanStitching 
feature must first be activated by select ing "ON" in the box labeled "Stitching". 
To set the scan length, click-on the "Scan Length" parameter. When the "Scan 
Length" parameter is highlighted, a box for entering the length is displayed. 
Enter the desired scan length using the DEKT AK V 200-Si numeric keypad, and 
press the enter key. The scan length is expressed in microns. 

Scan Speed 

The scan duration setting displays the amount of time it takes to complete a given 
scan. The horizontal resolution of a scan is determined by the scan duration in 
conjunction with the scan length. The scan speed is directly related to the data 
sampling rate. For example, a 50 second scan provides 15,000 data points. The 
scan duration can be set from 3 seconds to 218 seconds for a maximum of 65,400 
data points per scan. A longer scan duration should be selected for long scan 
applications and measurements of very fine surface roughness which require the 
highest horizontal resolution obtainable. When high throughput is the primary 
consideration, the a shorter scan duration can be used. For most applications, a 
10-20 second scan provides adequate resolution and throughput.

To set the scan duration, click-on the "Scan Duration" parameter. Key in the 
desired duration in seconds. The resolution and sample points will automatically 
be adjusted in accordance with the new duration value. 
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SECTION 8 • SCAN ROITTINE PARAMETER DESCRIPTIONS 

Scan Resolution 

The Scan Resolution parameter displays the horizontal resolution for the scan 
length and scan speed entered into the Scan Routine. The scan resolution is 
expressed in microns per sample. In other words, it provides the horizontal 
distance between data points. Data points are the points along the scan path at 
which data samples are taken. The more data points taken during a given scan 
length, the shorter the distance between samples. Therefore, a scan routine with 
the lowest number of microns per sample will provide the best possible horizontal 
resolution. 

Measurement Range 

The available vertical resolution depends upon the measurement range selected. 
When measuring extremely fine geometries, the 65K.A range provides a vertical 
bit resolution of lA. For general applications, the 1 OA vertical resolution of the 
655KA range is usually adequate. Wbeo measuring thick films or very rough or 
curved samples, the 2620K.A range with 20A resolution should be selected. 

To set the measurement range, click-on the "M. Range" parameter. When the "M. 
Range" parameter is highlighted, three boxes will be displayed offering the three 
measurement range selections: 65KA, 655K.A and 2620KA. Click-on the desired 
measurement range to enter the selection. 
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SECTION 8 - SCAN ROUTINE PARAMETER DESCRIPTIONS 

Profile 

The profile setting scales the measurement range according to the profile selected. 
Three different profiles are available for a variety of sample surface 
characteristics. 

(Valleys) Provides 90% of the measurement range below 
the zero horizontal grid line. Used primarily for 
measuring etched depths. 

(Hills and Valleys) Provides 50% of the measurement 
range above the zero horizontal grid line and 50% below. 
Used in most applications, especially if the surface 
characteristics of the sample are not well known, or if the 
sample is out of level. 

_n_ (Hills) Provides 90% of the measurement range above 
the horizontal grid line. Used primarily for measuring 
step heights. 

To set the profile, click-on the "Profile" parameter. When the "Profile" parameter 
is highlighted, three boxes will be displayed containing the various profile 
options. Move the pointing device to the desired profile and click-on the mouse 
or trackball button. The selected profile will be entered into the Scan Routine 
Program. 
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SECTION 8 - SCAN ROUTINE PARA.METER DESCRIPTIONS 

Stylus Force 

The stylus force can be set from 30mg. down to 0.5mg. force. The Scan 

Parameters Dialogue Box enables the stylus force to be adjusted. To adjust the 

force click-on either the up arrow or down arrow within the "Stylus Force" 

selection of the dialogue box. When the desired stylus force is displayed click-on 

the "OK" button to enter the stylus force into the scan routine. 

Minimum Inertia Force Adjustment 

The inertia force can also be set below 0.5mg by selecting the Minimum Inertia 

Force selection. To set the inertia force at minimum, click-on the box labeled 

"Minimum Inertia Force". An "X" will appear in the box when Minimum Inertia 

Force is selected. Click-on the "OK" button to enter the minimum inertia force 

into the scan routine parameters. 

Tower Speed 

The tower speed determines at what velocity the stylus tower is lowered onto the 
sample surface. When measuring soft surfaces, the lower tower speed should be 
selected to eliminate stylus impact damage to the sample. To increase throughput 
a high tower speed can be selected when measuring hard surfaces. 

To set the tower speed, click-on the "Tower Speed" parameter. When the "Tower 
Speed" parameter is highlighted, three boxes will be displayed with the selections 
of Low, Medium, and High tower speed. Click-on the desired tower speed to 
enter the selection. 
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SECTION 8 - SCAN ROUTINE PARAMETER DESCRJPTIONS 

DISPLAY PARAMETERS 

The Scan Routines screen contains additional parameters under the heading 
"Display Parameters" which allow automatic manipulation of the graphic display 
of the profile trace. The Display Parameters are described below. 

Software Leveling 

The DEKT AK V 200-Si can be programmed to automatically software level the 
profile trace at the conclusion of a scan in relation to the cursor/trace intercepts. 
In order to obtain accurate step height readings and analytical calculations, the 
trace must be software leveled. Software leveling can be programmed into the 
scan routine. Cursor band widths can also be entered to perform 4-cursor delta 
leveling. 

To enter software leveling, click-on the "S. Leveling" parameter. If software 
leveling is desired, click-on the Automatic Leveling checkbox. 

When Automatic Leveling is selected, two additional boxes will be displayed 
(Figure 8-6). These boxes permit the cursor band widths to be adjusted and 
entered into the software leveling parameter. If no bands are required, enter 0, 
and the default fine line cursors will be used to level the trace. If the desired 
cursor widths are known, they can be entered into the scan routine. The first box 
represents the width of the reference cursor and the second box is for setting the 
measurement cursor width. 
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SECITON 8 - SCAN ROUTINE PARAMETER DESCRIPTIONS 

Band Width Setting 

Cursor band widths can also be entered from the Data Plot screen. Delta 
averaging technique is used to provide a roughness average reading of the section 
of the profile trace within the bands. The profile trace will then be automatically 
leveled according to the two average readings. 

When setting the cursor band widths and cursor locations, it is often helpful to 
first run a sample scan of the scan routine to be leveled. Once the scan has been 
completed and the unleveled trace is displayed, position the cursors at two points 
on the trace that run along the same horizontal plane. 

To set the cursor width click-on the "Plot" menu from the Data Plot screen menu 
bar. Click-on "Band Width" and a window will be displayed permitting the 
cursor band widths to be adjusted (see Figure 8-7). Once the desired band widths 
are set, click-on "OK_" 

To enter the new band widths into the software leveling parameter of the Scan 
Routine screen, pull down the Bands menu again and click-on "Enter Software 
Leveling." The selected band width value will automatically be entered into the 
software leveling parameter. 
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SECTION 8 - SCAN ROUTINE PARAMETER DESCRIPTIONS 

Reference/Measurement Cursors 

The R. Cursor and M. Cursor parameters permit the reference and measurement 
cursor locations in relation to the horizontal scale of the Data Plot screen to be 
entered into a scan routine. Once entered, whenever the scan routine is executed, 
the cursors will automatically be positioned to the programmed locations. The 
cursor settings are used to automatically software level the profile trace. 

If the desired cursor settings are known, they can be numerically entered directly 
into the Scan Routine, when the Scan Routine screen is displayed. This can be 
accomplished by simply clicking-on the "R. Cursor" or "M. Cursor" parameter, 
and entering the desired cursor location. 

Cursor locations can also be entered into the current scan routine from the Data 
Plot screen. To set the cursor locations for leveling, it is recommended that a 
sample scan be run of the feature to be measured. Once the scan is complete, 
position the reference cursor at a location along the reference plane (i.e., the base 
of a step or the lip of an etched depth). To accurately level the trace, the 
measurement cursor should be positioned away from the reference cursor, yet 
along the same horizontal plane. 

Once the cursors have been properly positioned, click-on "Edit" from the Data 
Plot screen menu bar. Click-on "Enter Software Leveling" from the Bands menu 
and the new cursor locations will be entered into the scan routine. The software 
leveling function will now be performed at the specified cursor locations 
whenever the current scan routine is executed . 
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SECTION 8 - SCAN ROUTINE PARAMETER DESCRIPTIONS 

Display Range 

The Auto Ranging feature automatically scales and ranges the profile trace to fill 
80% of the data plot display. However, in some applications where repetitive or 
like scans are being compared, it may be advantageous to preset the graphic scale 
by numeric entry. 

To set the display range, click-on the "Disp. Range" parameter. When the "Disp. 
Range" parameter is highlighted, two options are displayed: Auto and Select. To 
select automatic ranging, click-on "Auto." To set the display range at a specified 
value, click-on "Select." The "Select" option provides two additional boxes for 
entering the upper and lower boundaries of the graphic scale (see Figure 8-9). 
Enter the desired setting for the upper boundary in the first box and press enter. 
Repeat the procedure to enter the lower boundary in the second box. 
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Figure 8-9. Display Range Parameter 

Display Data Type 

This parameter permits raw profile data as well as the roughness and waviness 
profile to be displayed. The raw profile and roughness or waviness profiles can 
be displayed individually or simultaneously, to easily correlate the profiles. A 
detailed description of the function and use of the Display Data Type parameter is 
provided in Section 6 of this manual. 
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SECTION 8- SCAN ROUTINE PARAMETER DESCRIPTIONS 

DATA PROCESSING 

The DEKT AK V 200-Si provides parameters for processing profile data for 
specific applications. Within the field of the Scan Routines screen are two 
parameters listed under the heading "Data Processing." These parameters permit 
filter cutoffs and smoothing filters to be activated. Their use and function is 
described in detail in Section 6 of this manual. 

Filter Cutoffs 

Roughness and waviness filter cutoffs can be entered from the Scan Routine 
screen or the Data Plot screen. This parameter permits user selected cutoff values 
to be entered into the current Scan Routine. A short pass filter is available for 
calculating roughness analytical functions. A long pass filter is available for 
calculating roughness analytical functions. 

Smoothing 

The smoothing parameter permits a smoothing filter to be activated. When the 
smoothing function is used, raw, roughness and waviness profiles are calculated 
using the smoothed data. Three degrees of smoothing are available. The higher 
the degree, the more smoothing will be realized. 
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SECTION 8 • SCAN ROlJITNE PARAMETER DESCRIPTIONS 

STEP DETECTION/ AUTOMATIC ALIGNMENT OPTIONS 

The DEKT AK V 200-Si provides optional features for Step Detection and 
Automatic Alignment. The instructions for opening these features is provided in 
the appendix in the back of this manual. 
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SECTION 9 

KEYBOARD AND ICON FUNCTIONS 

KEYBOARD FUNCTIONS 

The DEKTAK V 200-Si keyboard can be used for performing nearly all 
Windows fuctions typically performed using the trackball. The corresponcling key 
functions are described in this section. 

An external computer keyboard can also be connected to the DEKT AK V 200-Si 
for entering alpha-numeric commands. See Section 1 of this manual for external 
keyboard installation instructions. 

NUMERIC ENTRY KEYBOARD FUNCTIONS 

10 

0-9

CLR 

ABORT 

ENTER 

REPLOT 

ZERO 

LEVEL 

Function 

(NUMERIC KEYPAD) Used in specifying numeric values for 
programming parameters, cursors, boundaries and smoothing 
functions. 

(MINUS SIGN KEY) Used for specifying negative values. 

(BACKSPACE KEY) Erases any alpha-numeric data keyed in 
but not yet entered. The Clear Key also acts as a backspace key 
when making alpha-numeric keyboard entries. 

("A" KEY) Interrupts a scan or automation program and 
progress. Also used to stop tower motion or stage translation. 

(ENTER) Enters specified numeric data or filename.s. 

("C" KEY) Will replot the desired boundaries (1 through 9) 
according to the boundaries saved. RPL T,0 will display the 
original boundaries. 

("D" KEY) Places the R cursor/trace intercept on the zero 
horizontal grid line. 

("E" KEY) Levels a trace according to the R and M 
cursor/trace intercepts. The R cursor/trace intercept will 
automatically be zeroed. 
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SECTION 9 - KEYBOARD DESCRIPTION 

ST AGE POSITIONING KEYBOARD FUNCTIONS 

DATAPLOT 

BOUNDARIES 

LEFT 

BOUNDARY 

TOP 

BOUNDARY 

RIGHT 

BOUNDARY 

BOTTOM 

BOUNDARY 

Function 

("F', "G", "H'', "N' KEYS) When one of these keys is 
pressed, it activates the corresponding boundary on the data plot 
display, allowing the boundary to be repositioned by pressing 
the arrow keys or entering numeric value. 

(''F" KEY) Activates the LEFf boundary on the data 
plot display, allowing the boundary to be repositioned by 
pressing the arrow keys or entering numeric value. 

("G" KEY) Activates the TOP boundary on the data 
plot display, allowing the boundary to be repositioned by 
pressing the arrow keys or entering numeric value. 

("H" KEY) Activates the RIGHT boundary on the data 
plot display, allowing the boundary to be repositioned by 
pressing the arrow keys or entering numeric value. 

("N" KEY) Activates the BOTTOM boundary on the data 
plot display, allowing the boundary to be repositioned by 
pressing the arrow keys or entering numeric value. 

ARROW KEYS For cursor, boundary, and stage positioning. Select the desired 
cursor keys, boundary keys or stage key to reposition using the 
keys described below. 

UP 

LEFT 

RIGHT 

DOWN 

("I" KEY) For repositioning the top and bottom boundaries 
("G" and "N" keys) upward and positioning the stage ("Q" key) 
so that tbe video image of the sample on the screen moves 
upward. 

("J" KEY) For repositioning th� left and right bouudaries (''F' 
and "H'' keys) to the left and positioning the stage ("Q" key) so 
that the video image of the sample on the screen moves to the 
left. Can also be used for moving the Refemce Cursor ("M" 
key) and Measurement Cursor ("0" key) to the left. 

("K" KEY) For repositioning the left and right boundaries ("F' 
and "H" keys) to the right and positioning the stage ("Q" key) 
so that the video image of the sample on the screen moves to 
the right. Can also be used for moving the Refernce Cursor 
("M" key) and Measurement Cursor ("0" key) to the right. 

("L" KEY) For repositioning the top and bottom boundaries 
("G" and "N" keys) downward and positioning the stage ("Q" 
key) so that the video image of the sample on the screen moves 
downward. 
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FAST KEY ("SHIFf" KEY) Speeds up stage, stylus tower, boundary or 
cursor movement. The Fast key also acts as the shift key when 
making alpha-numeric keyboard entries. 

NOTE 

To move sample stage, cursors, boundaries, or stylus tower in 
the fast mode, press and hold the appropriate arrow key and 
then the FAST key ("SHIFT" KEY). 

R CURSOR ("M" KEY) Press to adjust the reference cursor location or 
width. Use in conjunction with the right and left arrow keys to 
position the cursor. Use in conjunction with the up and down 
arrow keys to adjust the cursor width. 

M CURSOR ("O" KEY) Press to adjust the measurement cursor location or 
width. Use in conjunction with the right and left arrow keys to 
position the cursor. Use in conjunction with the up and down 
arrow keys to adjust the cursor width. 

TILT STAGE ("P" KEY) When this key is pressed, the stage can be 
mechanically leveled by pressing the up and down arrow keys 
("I" and "L" keys). 

ST AGE (STAGE POSITIONING) When this key is pressed, the 
sample can be positioned along the X-Y axis by pressing the 
arrow keys ("I", "J", "K", and "L" keys). 

THETA (THETA ROTATION) Permits the sample stage to be rotated 
by using the left and right arrow keys ("J" and "K" keys). 
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SECTION 9 - KEYBOARD DESCRIPTION 

DISPLA V KEYBOARD FUNCTIONS 

Kgy_ Function 

VIDEO ('' S" KEY) Controls three video display modes: Video onJy, 
graphics only, or video/graphics overlay. 

STYLUS ("T" KEY) Raises and lowers the stylus tower. Pressing the 
"T" key and the Fast key simuJtaneously raises and lowers the 
stylus tower at high speed. 

PRINT ("U" KEY) Initiates a printout on the printer of the scan data 
and plotted profile trace. 

AUTO PROG ("V" KEY) Initiates the current automation program. 

LOAD ("W" KEY) This key acts as a toggle for loading and 
unloading samples. Striking the "W" key with the stage 
positioned below the stylus raises the stylus tower and moves 
the stage all the way forward to the unload position at the Scan 
Head door opening. Striking this key when the stage is in the 
unload position centers the stage under the stylus in the load 
position. 

SCAN ("X" KEY) Runs the current Scan Routine at the current 
X,Y,Theta location. 

FOCUS ("Y" and ":" KEYS) Adjusts the video camera lens focus. The 
optional remote control focus feature must be installed to 
activate these keys. 

LIGHTING ("Z" and"," KEYS) Adjusts the sample illumination. The "Z" 
key increases the illumination and the "," key decreases the 
illumination. 

ZOOM ("\" and"." KEYS) Adjusts the video camera zoom lens from 
85-550:X. The ''\" key increases magnification and the "." key
decreases the magnification.
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ICON FUNCTIONS 

The Dektak V 200-Si Microsoft Windows user interface provides a series of easy 
to use on screen icon buttons for perfonning repetitive functions quickly with 
simple point and click ease. The description for these icons is provided below. 

□ 

[ii 

� 

� 

[g 

� 

□ 

Function 

Displays the Automation Program Window. 

Displays the Sample Positioning Window. 

Displays the Data Plot Window. 

Displays the Automation Program Sumary Window 

Displays the Scan Routine Window 

Runs the current scan routine. 

Runs the current scan routine at the current stage location. 

Runs the current automation program. 

Opens a new Automation Program. 

Opens a saved file such as Automation Program or scan data. 

Saves the current Automation Program or scan data. 

Prints the current scan data and profile trace. 

Displays the Help menus. 
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SECTION 9 - KEYBOARD DESCRfPTION 

� 
LEJ 

(Only available on Scan Routine Window) Displays the next 

and previous scan routines of a multi.scan Automation Progam. 

Displays the analytical funtions dialog box. 

Enables and disables scan routine Global Edit Mode. 

(Available in Automation Program Window only) Displays 
dialog box for exporting scan data. 

(A va.ilable in Automation Program Window only) Displays 
dialog box for copying a single scan routine or a range of scan 
routines into the current Automation Program. 

(Available in Automation Program Window only) Displays 
dialog box for deleting a single scan routine or a range of scan 
routines from the current Automation Program. 

(Available in the Data Plot Window only) Performs the 
software leveling function on the scan trace. 

(Available in the Data Plot Window only) Performs the 
replot function on the scan trace used to enlarge a portion of the 
tra:c. 

Displays the Loader Program Window. 

(Available in the Sample Positioning Window only) Removes 
stage backlash prior to entering scan sites and deskew sites into 
an automation program. 
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SECTION 10- CALIBRATION, MAINTENANCE AND WARRANTY 

SECTION 10 

CALIBRATION, MAINTENANCE AND WARRANTY 

SECTION 10 OVERVIEW 

Items discussed in this section include: 

■ Care and Handling
■ Vertical Calibration
■ Theta Calibration
■ X,Y Calibration
■ Find Center of Rotation of Stage
■ Changing the Time and Date
■ Formatting a Data Disk
■ Stylus Replacement
■ Illum.inator Lamp Replacement
■ Warranty

CARE AND HANDLING 

Like any precision instrument, the DEKT AK V 200-Si requires care in handling 
and operation. The following recommendations should be followed. 

1. Allow the DEKTAK V 200-Si to warm up for approximately 15 minutes
prior to use, to stabilize the electronics.

2. Do not use any Jeadscrew lubricants other than Veeco authorized leadscrew
lubricant PIN 085280.

3. Always position the sample so that the stylus is the only part of the stylus
arm that touches the sample.

4. Always keep the Scan Head door closed when the DEKTAK V 200-Si is not
in use.

5. Never connect or disconnect any cables when power is on.

6. Do not lower the stylus tower without the stage assembly in place.

7. Do not move a sample during a scan.

8. A void vibration and shock during measurements. (A common source of this
is an operator or observer touching or bumping a surface close to the
instrument or the instrument itself during a scan.)

9. Always raise stylus tower and optics assembly to the full up position when
the system is not in use, even when power is left on.
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SECTION 10. CALIBRATION, MAINTENANCE AND WARRANTY 

VERTICAL CALIBRATION 

The DEKTAK V 200-Si should be software calibrated regularly (at least once a 
month) to ensure vertical measurement accuracy. The 10-KA calibration standard 
supplied with the DEKT AK V 200-Si can be used for this purpose. Additional 
calibration standards are also available to calibrate the instrument for a wide 
variety of applications. Step height calibration standards range in thickness from 
200 angstroms to 100,000 angstroms. All calibration standards are traceable to 
the National Institute of Standards and Technology and include a certificate of 
calibration. 

Vertical Calibration Help Window 

The DEKT AK V 200-Si provides user instructions for setting the vertical 
calibration. This window can be displayed from any screen but the Data Plot 
screen. The procedure to display the Vertical Calibration Help window is 
described below. 

1. Click-on "Calibrate" from the system menu bar. The set-up menu will be
displayed.

2. Click-on ''Vertical Calibration" and click-on "Set". The vertical calibration
help window will be displayed (see Figure 10-1).
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Figure 10-1. Vertical Calibration Help Window 
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SECTION 10- CALIBRATION, MAINTENAl'ICE AND WARRANTY 

SCANNING A CALIBRATION STANDARD 

To set the vertical calibration, a scan must first be run using a calibration standard 
and the average step height function must be calculated on the scan data. The 
detailed instructions for sample positioning, and running a scan are provided in 
Section 3 and 4 of this manual. For the purpose of discussion, the calibration 
procedure described below will use the !OKA calibration standard supplied with 
the DEKT AK V 200-Si. 

l .  Open a new Automation Program and enter a scan length of 500 microns into
the default scan routine. 

2. Position the calibration standard to run a 500 micron scan over the center of
the "dog bone" shaped step of the lOKA calibration standard.

3. Click-on "Scan Here" from the Run menu. The 500 micron scan will be run
and the profile will be plotted.

4. Auto level the stage, as described in Section 4 of this manual.

5. Click-on ''Scan Here" a second time, and software level the trace as described
in Section 4. The resulting profile should resemble Figure 10-2 below.
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Figure 10-2. Calibration Standard Step Height 
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SECTION 10 - CALIBRATION, MAINTENANCE AND WARRANTY 

CALCULATING AVERAGE STEP HEIGHT 

It is recommended that the cursor band widths be set at approximately I 00 
microns for calculating the average step height analytical function. The cursor 
bands can also be used for software leveling the trace. A detailed description of 
the procedure for setting the width of the bands is provided in Section 8 of this 
manual. 

1. To set the cursor bands, click-on "Set Bands" from the bands menu and enter
band widths of 100 microns for each cursor.

2. With the reference cursor positioned along the base of the step, reposition the
measurement cursor to the center of the step (see Figure 10-3).

3. Click-on "Analysis" and click-on "Append Analytical Functions". The
Analytical Functions window will be displayed.

4. Click-on "ASH" to activate the average step height parameter and click-on
"Compute". The average step height will be calculated and the result will be
displayed to the left of the Data Plot screen. Click-on ''Done".
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Figure 10-3. Calculating Average Step Height 
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SECTION ID-CALIBRATION, MAINTENANCE AND WARRANTY 

SETTING THE VERTICAL CALIBRATION 

Once the average step height has been calculated, the vertical calibration can be 
set. 

1. Click-on "Calibrate" from the system menu bar located above the Data Plot
screen. The calibration menu will be displayed.

2. Click-on "Set Vert. Calibration" from the menu. A dialog box will be
displayed permitting the vertical calibration to be set (see Figure 10-4).

3. The dialog box displays the measurement range of the current Scan Routine.
The "Set Options" selections permit the vertical calibration to either be set
for the current measurement range, or for all three ranges: 65KA, 655KA
and 2620 KA. This feature allows the various ranges to be set using different
size step height calibration standards. For the purpose of this exercise, click­
on "Set for All Ranges."

4. The "Measured Step Height" value is actually the average step height value
calculated on the just concluded scan. In the box labeled "Actual Step
Height," enter the certified step height value printed on the certificate of
calibration and on the back of the case provided with the IOKA calibration
standard.

5. Click-on "OK" to set the vertical calibration. When the scan routine is rerun
and the average step height function is once again calculated, the ASH result
should equal that of certified value.
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Figure 10-4. Set Vertical Calibration Dialog Box 
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SECTION 10 • CALIBRATION, MAINTENANCE AND WARRANTY 

CLEARING VERTICAL CALIBRATION 

Whenever the vertical calibration is set, the old values are automatically cleared 
and replaced by the new parameters. However, in some cases, it may be desirable 
to clear individual ranges or all ranges. This procedure is described below. 

l .  Click-on "Calibrate" and click-on "Clear Vert. Calibration" from the menu,
the clear vertical calibration dialog box will be displayed (see Figure 10-5). 

2. The dialog box permits the vertical calibration to be cleared from the various
display ranges either individually or from all the ranges. Click-on the range
or ranges to be cleared and click-on "CLEAR" and click-on "OK". The
vertical calibration will be cleared from the selected range or ranges.
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Figure 10-5. Clear Vertical Calibration Dialog Box 

128 



SECTION 10 - CALIBRATION, MAINTEN Ai'I/CE AND WARRANTY 

THETA CALIBRATION 

The calibration procedures described in the next few pages calibrate the 
DEKTAK V 200-Si for Deskew and machine-to-machine compatibility. The theta 
and X, Y calibration selections are as well as the find center of the stage rotation 
procedure can all be accessed from the Calibration Menu. 

Select "Calibrate Theta" to set Encoder Counts per degree of theta stage. The 
default value is 1000 and can be reset by selecting the "Reset" button. The 
procedure is described below. 

1. Select "JOG TO X0,Y0" then jog to a point The tower will null when you
click to stop jogging. Repeat this process until the point is accurately selected.

2. Select "Rotate 360". The stage will rotate approximately 360 degrees. If it
rotated exactly 360 degrees we would be back to the start point. Most likely

we will be off.

3. Select "Rotate -" or "Rotate+", dependent on having gone to far or not far
enough, respectively, until the reticule is again aligned with the start point.
The degrees off and encoder counts/degree will be displayed.

4. Select "OK" to accept the new value or cancel to keep the old. In either case
the stage will rotate back to 0.

5. The accuracy of the calibration can be checked by again selecting the
"Calibrate Theta" menu, and the selecting "Rotate 360", this time the stage
should wind up exactly back at the start point after the rotation.
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Figure 10-6. Theta Calibration Dialogue Box 
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SET AXIS CORRECTION FACTOR 

Select this menu to calibrate the angle between the X and Y axes. The default is 90 
degrees and can be set by selecting "Reset to Default". The calibration procedure 
is described below for both motorized and programmable theta. 

1. If using the programmable AutoTheta, select "Jog to XO.YO" to position to

the intersection of a pair of straight lines known to be at 90 degrees to each

other (orthogonal). The tower will null when you click to stop jogging.

Repeat until the point is accurately selected.

2. Select "Jog to X 1, Y 1" to position to the end point of the horizontal line.

3. Select "Rotate". This will rotate the stage so that the selected line is

horizontal. The stage will move back close to XO, YO.

If using motorized theta, the line can be made horizontal by using the "Slew Stage" 
operation under the "Profiler Menu". 

Now that a horizontal line has been established. 

l. Select "Jog to XO,YO" to move back to the intersection. Again the tower will

null when you click to stop jogging. Repeat until the point is again accurately

selected.

2. Select "Jog to X2,Y2" to position to the end of the vertical line. The tower

will null when you stop jogging. Repeat until the point is accurately selected.

The angle between the axes will be displayed.

3. Select "OK" to accept the value, "CANCEL" to quit without changing the

correction factor.
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Figure 10-7. Calibrate X,Y Axis Dialogue Box 
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FIND CENTER OF ROTATION OF STAGE 

l .  Select "Jog to X0,Y0" to  select a point which you will be  able to easily re­

identify once the stage is rotated 180 degrees. The tower will null when you 

stop jogging. Repeat until the point is accurately selected. 

2. Select "Rotate 180".

3. Select "Jog to Xl,Yl" and find the same point as in step l. Again, repeat until

the point is accurately selected. The center of rotation of the stage will be the
mid point of the line segment connecting X0,Y0 with Xl,Yl .

4. Select "New center" to use this value as the center.

5. Select "Go to Center" to move to the center.

6. Adjust the sample under the stylus so that an easily identifiable point comes
into the field of view.

7. Repeat steps 1 through 5. This time the selected point should stay within the
field of view because it is close to the center. If it is not, pick a point closer to

the center or adjust the sample so that the point is closer to the center.

8. Visually identify a point close to the center. Select "Rotate 180" and watch the
point as it moves around the supposed center. It should maintain a constant
distance from the center as it rotates. If it does not, repeat from step 7, except
selecting "Average Center" instead of "New Center", until you are satisfied
that the point you pick is maintaining a constant distance from the center as it
rotates.
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Figure 10-8. Find Center of Rotation of Stage Dialogue Box 
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ANTI-BACKLASH ALGORITHM 

For optimal repeatability in stage positioning, stage locations should always be 
selected from the left. Le, move the stage to the left of the position desired and 
then approach the position from that side before selecting it. When the stage is 
automatically positioned for scanning, if the anti-backlash algorithm is enabled, 
the location will be approached from the left also. This eliminates repeatability 
errors due to backlash in the gears. 

1. To enable the anti-backlash algorithm, select "Setup" from the menu bar. The
DEKT AK V 200-Si Setup Menu will be displayed.

2. Select "Set X Backlash Parameter" from the Setup Menu. The X Stage
Backlash Parameter dialogue box will be displayed (see Figure 10-9).

3. Enter a backlash distance in the "Distance" field. A value of 1000 is
suggested. (Enter Oto disable the algorithm.)

4. The speed and acceleration values should be left alone. Select "OK" to enter
the backlash parameters.
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Figure 10-9. Stage Backiasi1 Parameters Dia1cgue Box 
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CHANGING THE TIME AND DATE 

The DEKTAK V 200-Si has an internal clock which keeps the time and date. 
Whenever a printout is produced of the scan data or the scan data summary, the 
time and date are recorded on the printout. Resetting the clock is accomplisbed in 
the MS-DOS executive window. The procedure for setting the time and date is 
described below. 

1. Exit the DEKT AK V 200-Si application by clicking-on the System Menu
Box located in the uppermost left corner of the screen. Click-on "Switch To"
from the system menu and double click-on "Program Manager". The
program manager will be displayed.

2. If the main menu is not displayed, double click-on the "Main" menu icon.

3. Double click-on the "Control Panel" icon from the Main Menu and the
control panel will be displayed (see Figure 10-10).

4. Double click-on on the "Time/Date" icon. To change the time or date, click­
on the item to be changed (for example, minutes). The item will be
highlighted and arrows will be displayed to increase or decrease the number.

5. Once the desired time and date is set, click-on "OK" and click-on the control
panel menu box and click-on "Close."

6. To return to the DEKTAK V 200-Si application, click-on the System Menu
Box and click-on "Switch To" and double click-on the DEKTAK V 200-Si
application.
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Figure 10-10. Time and Date Control Panel 
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FORMATTING A DAT A DISK 

DEKTAK V 200-Si Automation Programs and Scan Data Files can be stored on 
external micro disks rather than on the bard disk drive. The DEKT AK V 200-Si 
"A" drive is a 3½ inch diskette drive. An optional 5¼ inch floppy disk drive is 
available, which can be used as the external or "E" drive. Before a diskette can 
be used, it must be formatted. The procedure for formatting a 3½ inch diskette in 
the DEKTAK V 200-Si "A" drive is described below. 

l .  Exit the DEKT AK V 200-Si application by clicking-on the System Menu
Box, and clicking on "Switch To" and double click-on "Program Manager". 

2. If the main menu is not displayed, double click-on the "Maio" menu icon.

3. Double click-on the "File Manager" icon from the Main Menu. The File
Manager will be displayed.

4. Click-on "Disk" from the File Manager menu bar and click-on "Format Disk"
from the disk menu. A dialog box will be displayed for selecting the disk
drive. Insert a new 3½ inch diskette into drive "A" located in the upper left
comer of the DEKT AK V 200-Si computer console.

5. Select disk drive "A" and click-on "OK." The diskette inserted into drive
"A" will be formatted.

CAUTION 
Formatting a disk erases any data that currently exists on the 
disk. 

DELETING FILES 

Automation Program Files and Scan Data Files can be deleted from the hard disk 
from the File Manager. 

l .  Switch to the File Manager from the Dektak V 200-Si application by
foJlowing the procedure described above in steps 1-3. File Manager will be 
displo.jed with a listing of L'le saved files. Click-on the desired file to open it. 

2. Click-on the file to be deleted, the selected file will be highlighted.

3. Click-on "File" from the menu bar, and click-on "Delete" from the File
Menu. A dialog box will display the file to be deleted. Click-on "OK" to
delete the file.

4. Once the desired files have been deleted, return to the Dektak V 200-Si
application clicking-on the System Menu Box and clicking-on "Switch To"
and double clicking-on the DEKT AK V 200-Si application.
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STYLUS REPLACEMENT 

All DEKTAK V 200-Si styli have the same shank size. They differ only in the 
radius of the diamond tip. The procedure to remove and/or replace a stylus is 
described below. 

CAUTION 

The stylus suspension system is delicate. 

1. Click-on "Stylus" and click-on "Tower Up" to raise the stylus and optics
tower to the full up position.

2. The "Quick Release" stylus mechanism enables fast and easy stylus
replacement. To remove the stylus, simply pull down on the stylus shaft (see
Figure 10-11). The stylus is held in place magnetically.

3. To install a new stylus, position the stylus within the groove at the bottom of
the sensor until the magnet locks it into position. Slide stylus all the back.

4. Use the stylus position adjustment knobs to align the video image of the
stylus tip with the on screen reticule.

STYLUS POSITION 

ADJUSTMENT KNOBS 

TO REMOVE STYLUS, GRAB SHAFT OF STYLUS 

WITH TWEEZERS AND PULL DOWN GENTLY 

REMOVE STYLUS SHIPPING PAPER 

PRIOR TO USE 

Figure 10-11. Low Inertia Sensor Head 
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ILLUMINATOR LAMP REPLACEMENT 

CAUTION 

Do not touch lamp while power is on. The bulb is extremely 
bot. 

1. Click-on "Profiler" and click-on "Tower Up" to optics tower to the full up
position.

2. Tum off the DEKT AK V 200-Si.

3. Remove the screw attaching the cover plate to side of the illuminator and
remove the cover plate.

4. Pull the lamp straight out.

5. Place a new bulb in the socket and check the reference dimension. For
optimum illumination, set the bulb filament parallel to the filter (see Figure
10-12). If the new lamp does not light, check the lamp wire connection at
the rear of the optics bridge.

6. Replace the illuminator cover plate.

LAMP BULB 

TOP VIEW 
COVERPLArE 

FILAMENT 
FRONT VIEW 

t __ _ 
� LIGHT SOURCE HOUSING f-- �,.�

FILTER SURFACE 

Figure 10-12. llluminator Lamp Replacement 
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LEADSCREW LUBRICATION 

Scandrives that are in clean rooms and being used many hours per day require 
fresh lubrication often. The maintenance personnel must determine the frequency 
of lubrication depending upon the amount of use. A little too much oil will not 
hurt as it can be cleaned up after it falls off the scandri ve. This will not 
contaminate samples since this area is under the chuck. 

On the other hand, if a leadscrew runs dry, the machine will hang up during 
homing or sample positioning; also, the leadscrew can be ruined and must then be 
replaced. 

Grease on the scandrive rods is all right but, DO NOT get it on the leadscrew. 
Universal Leadscrew Oil (Sloan Part Number is 085280) is the only approved oil 
that can be used on the scandrive leadscrew. This oil can also be used on the Y 
and X drive leadscrews. Leadscrews that have been coated with teflon, will 
require periodic cleaning of the anti-backlash nut to remove the teflon residue 
(once a year).The scandrive rods require a light grease. DO NOT apply this 
grease to any leadscrew. 

Suggested frequency for fresh lubrication based upon heavy use of a 
machine: 

l .  Scandrive leadscrew ............... monthly 
2. Scandrive rods ......................... bi-monthly 
3. X or Y leadscrews ................... every 3 months 
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SERVICE CONTRACTS 

To maximize equipment uptime and avoid major repairs, Veeco offers 
customized service contracts to meet customer needs. These contracts can be 
used to extend the one-year factory warranty. Service contracts include routine 
maintenance to keep the equipment up to factory spec. 

For more information on service contracts, call the Veeco Service Center near 
you: 

Santa Barbara, CA: 
Plainview, NY: 
Milpitas, CA: 
Santa Ana. CA: 

MAJOR REPAIRS 

(805)963-4431
(516)349-8300
( 408)263-0700
(714 )631-6484

WARNING 
The computer console and/or Video Monitor should NEVER 
be opened when connected to the primary power source. 
Major service should only be performed by qualified, factory 
trained, Veeco Service Emrineers. 

The DEKT AK V 200-Si cannot be readily repaired after major component 
failures without the assistance of specialized test equipment and software 
routines. In the event of equipment failure, please call the Veeco Service Center 
near you for assistance. 

Before calling the Veeco Service Center, check the following: 

1. Reboot the DEKT AK V 200-Si by first closing the Windows application and
turning the system off, and then turning the power back on.

2. Are all cables properly connected and free of obvious damage?

3. Is the power cord connected properly?

4. Is the sample illumination properly adjusted?

5. Does the stylus tower move up and down when "Tower Up" or "Tower
Down" is clicked-on?
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WARRANTY 

All new catalog-listed standard equipment sold and/or manufactured under 
Veeco's labels, is warranted by Veeco to be free of defects in material and 
workmanship if properly operated and maintained. This warranty covers the cost 
of necessary parts and labor (including, where applicable, field service labor and 
field service engineer transportation) during the warranty period. 

The warranty period is one (1) year. 

Warranty period takes effect upon date of shipment. Except as excluded below, 
these warranties extend to parts which are manufactured by persons other than 
Veeco which are components of standard catalog items. Purchased equipment 
incorporated into any item supplied by Veeco will be covered by manufacturer's 
warranty. 

Expendable items, including but not limited to styli, lamps, and fuses, are 
specifically excluded from the foregoing warranties and are not warranted. All 
used Equipment is sold on an "as is, where is" basis without warranty, express or 
implied. 

Equipment made or modified to Purchaser's specifications on special order shall 
carry the above warranties with respect to material and workmanship, but shall be 
specifically excluded from any other warranties, express or implied, including 
those related to performance specifications, and any special components shall 
only carry the original manufacturer's warranties. 

Warranty Claims 

Veeco's obligation under these warranties is limited to repairing or replacing at 
Veeco's option defective non-expendable parts. Veeco's obligation shall not 
extend to defects that do not impair service. No claim will be allowed for any 
defect unless Veeco has received notice of the defect within thirty days following 
its discovery by Purchaser. 

Claims for Shipment Damag6 

No claim will be allowed for Equipment damaged in shipment sold under 
standard tenns of F.O.B. Factory. Within thirty days of Purchaser's receipt of 
Equipment, Veeco must receive notice of any defect which Purchaser could have 
discovered by prompt inspection of Equipment. In any event, Veeco shall have 
the option of inspection at Purchaser's premises or at Veeco's plant, before 
allowing or rejecting the claim. 
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Warranty Eligibility 

To be eligible for the above warranties, Purchaser must perform preventative 
maintenance in accordance with the schedule set forth in the Operation and 
Maintenance Manual provided. Veeco assumes no liability under the above 
warranties for Equipment or system failures resulting from improper operation, 
improper preventative maintenance, abuse or modifications of the equipment or 
system from the original configuration. 

NOTE 

This warranty is in lieu of all other warranties, expressed or 
implied and constitutes fulfillment of all of Veeco's liabilities to 
the purchaser. Veeco does not warrant that the system can be 
used for any particular purpose other than that covered by the 
applicable specifications. Veeco assumes no liability in any 
event, for consequential damages, for anticipated or lost 
profits, incidental damages or loss of time or other losses 
incurred by the purchaser or any third party in connection 
with svstems covered by this warranty or otherwise. 

Service 

Field Service is available nationwide. Service and installations are performed by 
factory trained Veeco service engineers. 

Contact the Veeco Surface Metrology sales/service office, for prompt service. 

WESTERN REGION 

Veeco Surface Metrology 
602 East Montecito St. 
Santa Barbara CA 93103 
Attn.: Service Center 
Phone: (805)963-4431 
Fax: (805)965-0522 
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APPENDIX A 

DEKT AK V 200-Si OPTIONS, ACCESSORIES AND 

REPLACEMENT PARTS 

OPTIONS 

Item Description Part No. 

Stress Measurement Can calculate tensile or 508908 
Software compressive stress on processed 

wafers. includes special 
fixturing for three-point 
suspension of wafer. 

Extended Optics 85X to 550X. 044230 

Remote Keyboard Standard POAT 101 keyboard 010074 
used in place of integral keyboard. 

SECS/GEM Allows two-way communication 
between the DEKT AK V 200-SI and 

508869 

a host computer. 

Motorized Focus Motorized variable focus for high 516906 
magnification applications. 

DekMap 2 3-D image rendering software. 508941 

DekMap 2 Workstation Includes Pentium computer with 
DekMap 2 software and 17" monitor. 

508948 

Pattern Recognition Cognex automatic alignment system. 563150 
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ACCESSORIES 

Styli 

Calibration Standards 
Set 

Individual Calibration 
Standards 

Description 

Color Code 
Black 
Red 
Orange 
Gray 
Green 

Size 
25 micron radius 
12.5 micron radius 
5 micron radius 
2.5 micron radius 
Sub-micron radius 

Five Calibration Standards. 
Sloan certified nominal 200A and 
500A, and NBS traceable nominal 
I KA, SKA, and 50KA measurements. 
May be used with all Stylus Profilers. 
Includes a Certificate of Calibration 
and Hardwood Case. 

Nominal 200A measurement 
Nominal 500A measurement 
Nominal lKA measurement 
Nominal SKA measurement 
Nominal lOKA measurement 
Nominal SOK.A measurement 
Nominal 1 OOKA measurement 

Factory Recertification of Sloan Calibration Standard( s) available. 

VLSI Calibration Nominal 180A measurement 
Standards Nominal 440A measurement 

Nominal 880A measurement 
Nominal 4500A measurement 
Nominal 9400A measurement 

VLSI Roughness 90A (0.354urn) 
Standards 220A (0.866um) 

440A (1.732urn) 
2250A (8.858um) 
4700A (18.504um) 
Complete set (90A, 220A, 440A, 

2250A, 4 700A) 

Printer Paper OmniPrint 426 Model 
All other Omni Models 

Clean Room Paper All Omni Models 

Sample illuminator Lamp Replacement Bulb 

Leadscrew Lubricant 1/3 Fluid Oz. 
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Part No. 

665105 
665104 
665103 
665102 
665101 

138375 

138365 
138366 
138367 
138368 
138369 
138370 
138371 

085350 
085351 
085352 
085353 
085354 

085370 
085371 
085372 
085373 
085374 

085360 

085542 
085549 
085556 

140229 

085280 



APPENDIX B 

STRESS MEASUREMENT 

DESCRIPTION OF STRESS 

The stress algorithm creates a stress curve, made up of stress values for every data 
point on the scan trace. If a pre-stress scan data file was saved, then the calculation 
proceeds (on all the scan data points) as follows: 

1. The pre-stress scan data is loaded and smoothed using a running average with
a window size of 1/10 the scan length.

2. The smoothed data is further smoothed using a piece wise third order
polynomial interpolation technique.

3. The curvature trace is derived from the first and second derivatives of the
smoothed data trace.

4. Steps 1-3 are then applied to the post stress scan data, producing a curvature
trace for the post stress scan data.

5. The stress curve is then computed from the curvature traces.

6. The maximum and average compressive and tensile stresses are calculated
from the stress curve, and displayed in the Stress Results dialog box. Only
those values of the stress curve between the cursors are considered.

Three-Point Substrate Suspension 

To compensate for substrate deflection created by gravity or by a vacuum hold 
stage, the stress option kit provides three-point substrate suspension. Three .25 
ii1ch d.ia.rneter steel ball bearings are used to suspend the substrate above the stage 
surface. These ball bearings are inserted into the tap holes on top of the stage. A 
magnet is also provided for removing the ball bearings from the stage. 

Stress Reference 

Prior to calculating stress, a reference must be established. Stress can either be 
calculated using a straight line as the reference, or by producing a preliminary 
reference scan on the sample prior to processing. In order to accurately measure 
stress, the reference scan and the scan produced after thin film deposition, must 
have identical scan parameters, including cursor locations (stress is computed on 
the data between the reference and measurement cursors). For this reason, it is 
recommended that the scan parameters used to produce the original reference 
scan be saved in an Automation Program file to be used after deposition. 

Once the reference scan is produced, it must be saved in a data file. The data ft.le 
is then used as the reference for comparison and stress calculation. 
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APPENDIX B · STRESS MEASUREMENT OPTION 

IDENTIFYING SUBSTRATE CHARACTERISTICS 

To program stress, first, position the R and M cursors to enclose that part of the 
scan trace over which to collect stress statistics. If a reference scan is being used 
to compute stress, then the same scan parameters used to produce the reference 
scan must be used to produce the scan on the substrate after deposition. Whether 
the default straight line reference or a reference scan is being used to calculate 
stress, the substrate must also be scanned after thin film deposition. Once the 
scan has been produced on the substrate after deposition, the characteristics of the 
substrate being measured for stress must be entered into the stress calculation. 

1. Run the scan on substrate after deposition. The scan will be plotted.

2. Click-on "Analysis" from the Data Plot screen menu bar.

3. Click-on "Compute Stress" from the Analysis Menu. The stress dialog box
will be displayed (see Figure B-2).

4. The "Thin Film Substrate" portion of the stress dialog box displays the
material, orientation, and elasticity of the thin film substrate. Several options
are stored io memory to compute stress in a variety of applications. To view
the preprogrammed thin film substrate selections click-on "Options." The
Options menu will be displayed (see Figure B-1).

5. C1ick-on the thin film substrate to be measured for stress and click-on "OK."

Program: <Untitled> ; Data: <Untitled> Seen 1 011 
Elle .!;.dlt Bun P!ol ;;nalysis _erofller .§.etup Qiag �lndow &_olibrate _Gem/Secs J:!elp 

™�� 
STRESS PARAMETERS 

�-

Thin FIim Subt-lta\e ---�- --�-

[_; M.aterlo.l: SI 
[ii"··�-·-"-~--'--',.,__ __ _ ELASTICITY CONSTANTS 

lu 
L:::J 

f 
Pr< 

Elestrclty. j Z.290 X 1 �In Alm Sub,trotet 
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Alm thfeknesa: 

-=· ----- l 
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I
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Figure B-1. Stress Options Menu 
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APPENDIX B · STRESS MEASUREMENT OPTION 

ENTERING STRESS PARAMETERS 

Once the substrate material and orientation bas been identified, the other stress 
parameters can be entered. 

1. If the elasticity of the substrate is known to be different than the value
displayed in the box labeled "Elasticity," click on the box and enter the
correct value.

2. Click-on the box labeled "Substrate Thickness" and enter that value m
microns.

3. Click-on the box labeled "Film Thickness" and enter that value in microns.

4. If the stress is to be measured against the default straight line reference click­
on "OK" and the stress result will be displayed.

5. If the stress is to be measured against a reference scan produced earlier and
saved in a data file, click-on the box labeled "Stress Data File." Enter the file
name under which the reference scan profile data was saved and click-on
"OK." Stress will be computed and the stress result window will be
displayed (see Figure B-3).

-=- Program: <UnUUed>; Data: <Untitled) Scan 1 or 1 

STRESS PARAMETERS 

FIim thiclcncu, 

PreOepo1>IUon sc,,n dote Ille,: 

01ten1e11on: 111 

� 

I·--.,...,..-----------,

l 
Proconln9 ... 

um I [Ho,12_;0
1800.00 um 

Figure 8-2. Stress Measurement Dialog Box 
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STRESS RESULTS 

The statistical results are displayed in the Stress Results dialog box. These 
results can be viewed at any rime after stress has been computed by selecting the 
Analysis menu from the DataPlot window and selecting "Stress Results" item. 

A print out of stress results can be obtained by either selecting the PRINT button 
from the Stress Results dialog box or as part of the Scan Data Summary print out. 

Upon the completion of the stress computation, the stress and smoothed scan data 
traces are shown. Whenever a stress curve is displayed, the vertical. scale changes 
from Angstroms to Dynes/cm2. The following types of stress plots can be selected 
from the Stress Curves dialog box obtained from the Plot Menu in the Data Plot 
screen by selecting the "Stress Curves" menu item: 

1. Pre stress scan data, curve fit, and stress.
Scan data curve plotted in white, curve fit in cyan, stress curve in green. 

2. Post stress scan data, curve fit and stress.
Scan data curve plotted in white, curve fit in cyan, stress curve in green. 

3. Pre and Post stress curves, and stress difference curve.
Post stress scan data curve in white, pre stress curve in cyan, post stress 
curve in green, and stress difference curve in orange. 

4. Remove all stress curves.

Removes all stress and curve fit curves, and restores the vertical scale to 
Angstroms. 

Constraints and Limitations 

1. The stage should be hardware leveled, and in the same leveled position for
both the pre and post stress scans.

2. Both pre and post stress scans must have th.,; saiJlc nu:u.1ber of data points.
That is, don't abort either scan before completion.

3. The algorithm will work best on a flat wafers. Surface features will throw
off the curve fitting algorithm, and produce invalid maximum stress values.
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APPENDIX C - AUTOLOADER INSTALLATION AND OPERATION 

APPENDIX C 

DEKTAK V 200-Si AUTOLOADER 

INST ALLA Tl ON AND OPERATION INSTRUCTIONS 

The DEKTAK V 200-Si cassette to cassette AutoLoader provides automatic transfer and 
orientation of wafers up to 200mm (8"). Single cassette and dual cassette configurations 
are available. 

INSTALLATION 

Once the Loader is unpacked and connected to the Dektak V 200-Si, the air and vacuum 
Lines must be connected and the system leveled. 

Air Pressure and Vacuum 

If the AutoLoader is to be located in front of a wall, be sure to leave enough room (about 
two feet) between the wall and loader for easy access to the air pressure and vacuum 
connectors before moving the loader to its permanent location. 

Air Pressure 

The Dektak V 200-Si with Autoloader is built upon a vibration isolation table and 
requires no less than 100 psi. to operate properly. The air pressure connector is located on 
the back side of the loader. Connect the external air pressure using a 1/4" dia. hose by 
simply pushing it straight in and then pulling back to make sure the hose is secure. The air 
pressure may now be turned on. Allow at least 5 minutes for the isolation table to fully 
engage. 

Air Vacuum 

The loader robot and vacuum chuck require no less than 24 inches Hg. of vacuum. The air 
vacuum connector is located on the back side of the loader. Connect the external air 
vacuum using a l/4" dia. hose by simply pushing it straight in and then pulling back to 
make sure the hose is secure. The air vacuum may now be tu.med on. 

Leveling 

When the unit is moved to its permanent location it must be leveled to insure proper 
vibration isolation. Place the level on the robot mounting plate as close to the center of the 
machine a possible. Use a wrench to turn the blots located on the bottom side of each 
frame leg clockwise until the wheels lift off the floor. Check the level to see witch leg 
needs more or less adjustment. When the table appears level, check each corner of the 
table by pushing down gently. If the table is not floating freely on each comer, more 
adjustment may be necessary. 
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OPERATION OVERVIEW 

Loader Program files permit a number of cassette configurations to be programmed and 
stored on the hard disk. The user can create a program to use a single cassette to transfer 
up to 25 samples, a double cassette to transfer up to 50 samples, or cassette to cassette to 
get substrates from the first cassette and put back in the second cassette. 

The Dektak V 200-Si Scan head can be used with or without the AutoLoader. When the 
machine is first powered up, the Programmable Sample Stage moves to the robot load 
position. The user can ignore the loader and use the Scan head by itself by picking 
"Unload" from the menu. This will move the Programmable Sample Stage to the front for 
manual loading. 

NOTE 

The stage should be as level as possible before using the 
AutoLoader. If a mistake is made in the leveling process, every 
attempt should be made to level the stage before using the 
AutoLoader. Run a Loader Test program before running an 
automation program with the AutoLoader. Do not attempt to run 
a loader program until the scan stage is properly leveled. 

CREATING A LOADER PROGRAM 

Before running the AutoLoader, a loader program must be created to reflect the current 
conditions. An Auto Load program can be set up in three different configurations: 

Single Cassette 

The standard Auto Loader is set up with a single cassette. Substrates are taken from the 
cassette and placed on the Prealigner. After the substrate is aligned, it is placed on the 
profiler scan stage. when the automation routine is finished, the substrate is placed back in 
the cassette. 

Double CP.ssette 

The double cassette con.figuration is identical to the single cassette configuration, but 
allows you to process up to 50 substrates at a time. the loader routine starts on cassette #1 
and finishes on cassette #2. 

Cassette to Cassette 

The Cassette to Cassette routine takes the substrates from cassette 1, lower most position, 
prealigns the substrate and puts the substrate on the profiler scan stage. When the 
automation program is done, the robot removes the substrate from the scan stage and puts 
the substrate in cassette 2 in the highest most position. This routine is ideal for clean 
operations. 
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SETTING UP A SINGLE CASSETTE LOAD PROGRAM 

Using the track ball, click on "Window" in the menu bar and select "Program Loader". 
The Loader Program dialogue box will be displayed (see Figure E-1). This window 
provides several selections for setting up the system. The Loader Program window is 
described below. 

Cassette 1 

This selection controls the activity of cassette 1. Clicking on the slot numbers will activate 
or deactivate those slots. 

Cassette 2 

This selection controls the activity of cassette 2. Clicking on the slot numbers will activate 
or deactivate those slots. 

Cassette Config 

Select: SINGLE CASSETTE, DOUBLE CASSETTE or CASSETTE TO CASSETTE 
for desired loader routine. 

Substrate Size 

The sample size is set at the factory and can not be changed by the user at this time. Call 
Veeco/Sloan Technology customer service for assistance. 

Substrate Shape 

This selection does not apply to flat panels and therefore can not be accessed. 

Print Final Process Status 

When this item is selected, the printer will print a report of ±e loader 1,,at...1.:; at the end of a 
loader routine, or after the program has been aborted. 

Display Process Status 

Display Process Status provides a graphic representation of the loader status during a 
loader program: NO - Status will not be shown at any time. ALWAYS - shows the status 
during loader operation and toms off during the scanning process. AFTER EACH

SUBSTRATE PROCESSED - shows the status only after a substrate has been processed 
and for a specific amount of time. AFTER FINAL SUBSTRATE PROCESSED

shows the status only after the last substrate is processed and for a specific amount of 
time. DISPLAY DURATION - allows the user to specify the amount of time to display 
the status when "AFfER EACH SUBSTRATE PROCESSED" or "AFTER FINAL 
SUBSTRATE PROCESSED" are activated. 
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TUTORIAL 

The default setup shows cassette 1 fully loaded with 25 samples and cassette 2 with none. 
"Cassette Configuration" is set at 1 cassette, and "Display Process Status" is set to always. 
For learning purpose we will create a program to process five substrates. Go to the 
"CASSETTE 1" column and click on the "CHECK NONE" bar. This will make it easier to 
check on only five positions instead of checking off 20 positions. Now click on positions 1 
through 5. All the other parameters are preset to the configuration we need. Now you can 
save this program. 

Saving a Program 

To save a new or modified loader program, click-on the "SA VE PROGRAM" button. A 
new window will appear with a list of existing programs. You can choose one of these or 
save as a new program by typing in a new name. When finished, click on "OK" The new 
program is now saved to the bard disk. The "LOADER PROGRAMS" window will 
reappear. When you are finished, click on "DONE". The loader is now ready to run a 
loader program with your current scan automation program. 
,- ----- ---- --- ------------------- ---------------1 
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Figure C-1- Loader Program Dialogue Box 
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LOADERPROCESS STATUS 

To view a graphic representation of the current loader program, click on "Window" in the 
menu bar and Select "LOADER PROC. STATUS". A window will appear showing the 
current loader setup. This window can be made smaller and moved around to make a 
resized "DISPLAY PROC. STATUS" window by using standard Windows techniques. 

Setting Up a Double Cassette Load Program 

Setting up a double cassette load program is identical to setting up a single cassette 
program with the exception of clicking on "DOUBLE CASSETfE" in the "CASSETTE 
CONFIG" menu and adding substrates to the Cassette 2 column. 

Setting Up a Cassette To Cassette Load Program 

Setting up a cassette to cassette program is similar to setting up a double cassette 
program. For example, to setup a five substrates cassette to cassette program, you must 
click on the five slots to be processed in the cassette 1 column and then click on any five 
slots in the cassette 2 column. It is not necessary to click on the same five slots for 
cassette 2, but you must have at least 5 slots selected. 
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Figure C-2. Loader Process Status Window 
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APPENDIX C- AUTOLOADER INSTALLATION AND OPERATION 

RUNNING A LOADER PROGRAM 

Run Loader Program Test 

The user can run the current loader program without running a scan routine by clicking on 
"RUN" in the menu bar and picking "RUN LOADER PROGRAM TEST". This allows the 
program to be check without waiting for a scan. 

Run Loader Program 

To start a loader program with the current scan automation program, click on "RUN" in 
the menu bar and pick "RUN LOADER PROGRAM". The loader program will 
immediately start. 

Aborting a Loader Program 

A loader program can be aborted at any time by hitting the "ABORT'' key on the profiler 
key panel, or by bitting the "A" key on the external keyboard. All process will stop and the 
robot will go to it's home position. The user can use this time for several things; 

1. Modify the scan automation program, check the magazine tray, etc.,
then resume with the program. To resume a program, click on "RUN"
in the menu bar and pick "CONTINUE". The program will continue
from the same point it was aborted at.

2. Completely abort the scan and loader programs. After clicking on the
"LOADER PROGRAM ABORTED" message, click on "RUN" in the
menu bar and pick "RECOVER LOADER". This tells the machine to
find all substrates still left in the loader process and to put them back in
the cassette.

Running the Last Loader Program 

To run_ !.he last loader program, click on "PROGRAMS" in the menu ba!" and pick 
"LOADER PROGRAM". The hist program will be displayed. C!ick on "DONE" to reset 
the last program and start the program as before. 
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RECOVER LOADER 

After picking "RECOVER LOADER", the scan stage will move to the robot load position 
and the "LOADER OPERATION" window will appear. 

1bis window will show the current status of the loader program. Check to make sure the 
information in the window reflects the true current status. If all information is correct, 
click on "GO" and the robot will put the substrates back in the cassette, starting with the 
last substrate to enter the load process. Keep clicking on "GO" until the last substrate is 
back in the cassette. When all substrates are back in the cassette, click on "DONE" to exit 
"RECOVER LOADER". 

Incorrect Status 

The "RECOVER LOADER" program will no allow you to move a substrate to a location 
it believes is already occupied by another substrate, and it also will not pick up a substrate 
if it believes there is no substrate present. The user can override the program by using 
"GO OVERRIDE". For example, if the substrate is on the Pre-aligner but the loader status 
shows the substrate on the loader arm l ,  the user must click on "GO OVERRIDE" to 
force the robot to carry out the command. Always make a visual check of the situation 
before using "GO OVERRIDE". Attempting to move a substrate to a location that is 
already occupied will result in damage to the substrate and robot. 

WARNING 
Never turn off the machine and/or vacuum when the robot still 
has a substrate on the arms. This may result in damage to the 
substrate. Use II ABORT" sparingly to avoid creating difficult or 
confusing situations. 

Recover Loader Used as a Utility 

Recover loader can be used as a utility to move substrates manually. This is helpful when 
checking to see if the profiler scan stage is level enough to work well with the loader. 

For example, if the user wants to move the third substrate from cassette 1 to the profiler 
scan stage, click on "RUN" in the menu b,..r nnd 1,clcct "RECO'v'ER LOADER". When the 
Loader Operation window appears, click on "CASSETTE l "  and type in slot "3" in the 
"GET SUBSTRATE FROM" box. Next, click on "PROFILER" in the "PUT 
SUBSTRATE TO" box and click on "GO" to start the process. 

When the substrate has been put on the profiler stage, click on "DONE". The profiler can 
be used to move the stage, start a scan, etc. When finished, click on "RECOVER 
LOADER" in the "RUN" menu again and click on "GO" to return the substrate to it's 
original location. 
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APPENDIX D · 3-D RENDERING OPTION 

APPENDIX D 

3-D RENDERING OPTION

DEK-MAP II, the Dektak Rendering Option is an add-on software package that 
allows Dektak surface profiler customers to view and analyze data in 3 
dimensions (X, Y, and Z), instead of only 2 dimensions (X and Z) that the current 
products provide. Dektak: surface profilers collect 3D data through the use of 
mapped scans. The mapped scan data is then converted into data files that are 
usable to both the standard Dektak analysis routines, and the 3D rendering 
package. 

Overview 

DekMap II, the Dektak Rendering Option will run as a stand-alone analysis tool 
on any computer that meets the system configuration specifications. As a stand 
alone application the program is called up by the user through one of the standard 
Microsoft Windows application starting mechanisms (double-clicking an icon, 
using a shortcut, etc.). 

Recommended System Configuration to Run DekMap II Software 

Hardware 

486DX-66MHz to Pentium based IBM compatible PC with: 

8 Megabytes cf P�A__fyl (minimum) 

100 Megabytes hard drive capacity 

Microsoft compatible mouse or trackball pointing device 

VGA Color subsystem capable of 800x600 pixels and 256 colors 

VGA Color Monitor capable of 800x600 pixels 

Software 

Microsoft Windows 3 .1 or Windows for Workgroups 3 .11 under DOS 6 .2 or 
greater or Microsoft Windows 95 

The package will be network compatible based on the network compatibility of 
the underlying operating system. This typically includes remote file system 
storage and re�eval, along with remote printing. 
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SETTING UP A 30 MAPPING PROGRAM 

In order to set-up a 3D mapping automation program, the area on the sample 

surface to be mapped must first be defined. This is accomplished by physically 

moving the sample stage to define the corners of the area to be mapped. The 

procedure for entering the mapping area from the sample positioning screen is 
described below. 

1. From the sample positioning screen, position the sample so that the software
reticule is located at one of the four corners of the area to be mapped.

2. Click-on "Edit" from the menu bar and click-on "Enter Map Area".

3. Using the software reticule as a reference, roll the trackball along the scan
direction to determine the length of the scans used in the map, and click-on
the left button of the trackball. Next, roll the trackball perpendicular to the

scan direction and click-on the desired location to define the Y extent of the
map. The Enter Scan Map Region dialog box will be displayed (Figure D-1).

4. To accept the scan length and Y extent, click-on "OK" from the Enter Scan
Map Region dialog box. The Map Program dialog box shown in Figure D-2
will display detailed map parameters.
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Figure D-1. Enter Scan Map Region Dialogue Box 
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ENTERING MAPPING PARAMETERS INTO AN AUTO PROGRAM 

The Map Program dialog box shown in Figure D-2 contains the parameters for a 
3-D map set-up in the previous step. Prior to running a 3D mapping program it is

recommended that a mapping data filename be selected. Click-on the Mapping
Data Filename "select ... " button from the map program dialog box to enter the

desired filename. To enter the filename and accept the map program parameters,
click-on "OK".

The mapping parameters can also be changed via the dialog box to allow 
individual parameters to be altered as desired. In most instances the mapping 

parameters should be entered through the Sample Positioning Screen. Cljck-on 
the "Map Entry" button to go back to the Sample Positioning Screen. 

The Map Program dialog box can be accessed at any time by clicking-on 
"Mapping Parameters" from the Automation Program screen field. 
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Figure D-2. Map Program Dialog Box 
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RUNNING A MAP PROGRAM 

To execute a mapping program, simply run an automation program containing the 
desired mapping parameters. 

1. To run the current automation mapping program, select the Run Menu and

selecting the "Auto Program" menu item.

2. The current automation mapping program will be run. The Data Plot screen

will be displayed and plot each scan in real time.

3. Once all the scans in the automation mapping program are complete, the 3D

Projection Screen will be displayed with the three dimensional rendered
image generated from the multi-scan mapping program.

The user can also select to have the image displayed as either a wire frame or 

scan line image, with Z color rendering. In this window the user is able to either 
scroll the Phi and Theta angles with a slide bar, or by directly entering in values 

for these angles. The image is instantly updated to reflect the users' selections. 

At anytime, from the small screen, the user can enlarge the image with the 
standard MS-Windows Maximize button or command. When maximized the Z 

color rendered image fills the entire display. All previously selected user options, 
viewing angles, axis display options, are used when displaying the maximized 
image. The user is still provided with the Phi and Theta sliders on this screen. 
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APPENDlX D - 3-D RENDERING OPTION 

DEKT AK RENDERING OPTION SOFTWARE 

The DekMap II icon is displayed in the lower left of the Data Plot screen once a 
mapping automation program has been run and the rendered image is displayed. 
Double clicking on the icon opens the Dektak Rendering Option software which 
permits additional data analysis. 

Title Screen 

Once started, the package will display a title screen that incorporates both a menu 
bar and a toolbar for command selection. The title screen will display the version 
number of the Dektak. Rendering Option software that is currently running. The 
user then uses the title screen as a home base for performing data analysis, 
transformations, and image presentation. 

File Open 

The File, Open command opens a scanned image file, and transfers the data into a 
working data buffer (current data set) for use by the package. All data analysis, 

transformations, and image presentations are then performed from the current 
data set. 
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Figure D-4. Dektak Rendering Option Main Title Window 
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File Browse 

The File, Browse command allows the user to visually browse through directories 

of images. When this command is invoked the user is prompted with a standard 
file dialog box (see Figure D-5 ). The file name that the user selects becomes the 

starting point for that directory. Eighteen (18) image files starting with the file 

name selected are then displayed in a top down Z color rendering on the screen 
simultaneously in adjacent locations within the browse window. Below each 

image is listed the file name of the image and the text from the comment field 

when the image was saved (see section Summary Information). The user can then 

click the mouse on any image that is displayed, and that image will loaded into 
the current data set. 

The browse window contains two menu commands, Next and Previous. The 

commands display either the next or previous eighteen (18) images respectively. 
If there are fewer than eighteen images left then if the command is 'Previous' the 
first image is the first file listed in the directory, and then the next seventeen ( 17) 
image files from there. If the command is 'Next' all unused images will be shown 
as blank. 
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Figure D-5. Image Browse Window 
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APPENDIX D · 3-D RENDERING OPTION 

File Save 

The File, Save As command allows the user to save an image. This command is 
typically used when the user has transformed the data set and wishes to save the 
results of the transfonnation independent of the raw data set. 

Summary Information 

The File, Summary Info command allows the user to either add or edit the data set 
summary information. The summary infonnati.on consists of a three user editable 
fields. These are a 'Comment', 'Keywords', and 'Description' :fields. The 
comment field is a forty (40) character text field that is displayed in the browse 
window along with the image. The keywords field is a forty ( 40) character text 
field that is a hook for a yet to be developed feature whereby the user will be able 
to limit the browse or a find screen to only image files that contain certain 
keywords. The description field is a free form, multi-line text field of unlimited 
length. This field allows the user to enter a lengthy description of the contents of 
this image file. The summary information window also displays the file name of 
the image, the date that it was scanned, and the scan line resolution of the current 
data set in display only fields. 

File Export 

The File, Export to TIFF command transfers the current data set into a TIFF version 
6.0 file. The user is prompted with a standard file dialog box, to enter the name 
and location of the TIFF file to be created. Once the user enters this information 
and presses the OK button, the current data set is translated into a top down 
rendered image using a 128 color gray scale, and stored into the file the user 
specified. 

Printing 

Anywhere within the package the user is capable of printing the current window 
on an attached printer. There are three print options available; the entire display 
contents, the current window, or the client area of the current window. The entire 
display means exactly that, every pixel shown on the monitor is sent to the 
printer. The current window is defined as the current active MS-Windows 
window, this includes the window border, sizing handles, title bar, menu bar, and 
window client area (contents). The client area is the portion of a window that 
excludes the title bar, menu bar, and window border, if any. 

To print the current window press Ctrl+P, to print the entire screen press Ctrl+S, 

to print the current client area press Ctrl+Shift+P keys together. The requested 
portion of the screen is then sent to the current default printer as defined by MS­
Windows and the user. The page orientation of the output is automatically 
changed so the_ largest possible image is printed on a page. 
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Two Dimensional (Top Down) View 

Throughout the package, when the data set is presented to the user it is always 
presented i.n a Z height color rendering with a viewing angle of straight down, 
looking from directly overhead of the image plane. This image rendering is called 
a top down view. A number of the top down displays include the X and Y scales 
shown alongside the image. The top down image is shown whenever the user 
transforms that data set so there is a visual indication of bow the transform 
effected the image, such as changing the color palette. 

Intensity and Contrast Control 

The user has the capability of adjusting the intensity and contrast of an image. 
This is accomplished by altering the range, and color increments within a palette. 
Slider controls are provided to the user to adjust the intensity or contrast of the 
image (see Figure D-6). Adjusting image intensity and contrast is equivalent to 
adjust the color palette. Increasing the intensity has the effect of pushing the color 
band up towards the top (or higher Z heights); decreasing lowers the band. 
Increasing the contrast has the effect of narrowing the color band with the palette; 
decreasing widens the band. 
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APPENDIX D - 3-D RENDERING OPTION 

User Definable Z Color Palettes 

Available from both the 2D and 3D viewing windows is a command that allows 
the user to alter the Z height color definitions or Z color palette. 

The Z color palette design window is displayed whenever the user executes the 
Palette command from one of the view windows. The screen is organized into 
two areas, and design and preview. The design area contains several elements. 
The first is a plot of the RGB colors as a function of intensity against the Z 

height. The next element is a palette of the current Z height colors, displayed 
along with a scale. The last set of elements are RGB color selection buttons that 

allow the user to change the current RGB pen, and a "Smooth" command button. 
These buttons work in conjunction with the RGB plot. When the user has selected 

a color pen they are able to click or drag the mouse through the plot object. The 
currently selected color then traces the users movement, and is re-plotted, and 
displayed in the z color palette. The smooth command "smoothes" the RGB plot 
with a data smoothing algorithm. 

The preview area is provided so the user can get an instant feel for how the 
palette will look with their image, without having to return to a view window. 
The preview area consists of a top down image, along with a command button 
that allows the user to preview or view the current palette. 
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Figure D-7. Z Height Color Palette Design Window 
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Predefined Color Palettes 

The user can select a Z color palette from a number of predefined palettes in the 
system. The user is presented with a predefined palette selection window when 

the Select menu command is executed. A selection window then displays a 
selection of six (6) different primary colors, each with the option of full range or 
saturated color, and two (2) rainbow color palettes. The primary colors are 

defined as red, green, blue, yellow, cyan, and magenta. The full range and 

saturation options for each of these colors refers to whether the color palette 
becomes fully saturated with the primary color at the end or in the middle on the 
way to white (all color saturation). If the color palettes finishes with the primary 
color being fully saturated this is called "saturated". If the color palette finishes 
with white, then this is called "full range". 

The two rainbow palettes are labeled Spectrum for full color spectrum, and 
luminance for distinct bands of black, blue, red, magenta, green, cyan, yellow, 
and white. 

Closing this window automatically selects the currently selected predefined color 
palette . 
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Figure 0-8 - Predefined Z Height Color Palette Selection Window 
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Storage and Retrieval of User Defined Palettes 

The Z color design window also allows the users to record and retrieve palettes 

through the File menu command. The user selects either the File, Save Palette As, 

or File, Open Palette menu commands to save or open a palette file, respectively. 
The user is then presented with a standard file dialog box where the palette file 

name is specified. The palette file is then either loaded and displayed on the Z 
color design window, or saved into the file specified. 

Default Palette 

The package utilizes a default palette. This palette is used whenever a new image 

is loaded into the package. It is also used by the Browse, and Fast Fourier 
Transform windows. In these windows multiple top view images are presented. 

With the color limitation of 236 colors (due to Microsoft Windows, and the 

hardware specifications), only a single 128 color palette can be utilized, and this 
is the default palette. 

The default palette is typically the "Fire" palette. This palette starts at black and 

extends through to white with intensity of red increasing first, then green, and 
finally blue. The total effect is a palette that starts at black, goes to red, orange, 
yellow, and finishes at white. The fire palette is also known as the standard 
palette and can be instantly recalled by executing the Standard menu command. 

The user bas the ability to change the default palette through the File, Change 

Default menu command. This command takes the current palette and saves it as 

the default. The user can then load the current default palette with the File, Load 

Default menu command. 
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2 Dimensional Light Shaded Imaging 

The user is able to light shade the image. Light shaded images are shown in the 
top down format with adjustable light source coordinates, and contrast. 

To light shade an image the user brings up a maximized 30 view window. Menu 
commands to either Slope Shade

1 

or light shade the image. When the Light

Shading menu command is  invoked it presents the user with a window that shows 
a top down view of sphere (see Figure D-9). The user the drags the mouse pointer 
to a position on the sphere (a fudicial mark follows the mouse pointer). The 

position on the sphere then becomes the position of the light source. The closer to 
the outside edge of the sphere the light source is the lower to the horizon it is. 

The user can then click on the View Lighted Image area of the screen and be 

presented with a top down view of their image with light shading. A scroll bar 
also appears that allows the user to adjust the contrast of the image. 

Figure D-9. - Light source positioning window 

1 
Slope shading Is a special case of light shading. In a slope shaded Image the surface Is shaded according 

to it's. slope from the horizon. A steep area appears dark, while a flat area appears light. This Is the same as 
have the light source posiHoo directly above the center pdnt of the image plane. 
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ANALYTICAL FUNCTIONS 

A number of data analysis functions are provided through two sets of interfaces. 
One interface provides analysis of area and 3D roughness. The other interface 
provides analysis of distances, heights, angles, and 2D roughness. 

Area Analysis 

The area analysis or histogram window provides the user with the ability to 
perform roughness analysis on the data set. The roughness related analysis 
features include reporting of the Average Height, RMS Deviation, R0 , Maximum 

Deviation, RP, R,, R,,, Ri, Skewness, and Kurtosis of the entire scanned area.

A number of plotting features are also available through this window. These 
include Z height histogram, Z height histogram integral, roughness frequency, 
bearing ratio, autocorrelation and contour line (14) plots. The user is also able to 
retrieve and record both roughness frequency and autocorrelation plots. These 
two types of plots can then be simultaneously compared against other plots of the 
same type. 

The histogram window also allows the user to manipulate the data via selected tilt 
corrections, data smoothing and Z height truncations. 
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Z Height Histogram Plot 

The Height Histogram command displays a histogram plot of the observed Z 

heights, shown with the number of observations as the Y axis and the Z height as 

the X axis (see Figure D-10). When the mouse pointer is positioned within the 
plot, the current location of the pointer, expressed in the X and Y coordinate 

system values, is displayed on the screen. 

Z Height Histogram Integral Plot 

The Histogram Integral command displays a plot of the Z height histogram 

integral, shown with the integral result range of 0 to 1 as the Y axis and the Z 

height as the X axis. When the mouse pointer is positioned within the plot, the 

current location of the pointer, expressed in the X and Y coordinate system 
values, is displayed on the screen. 

Z Height Gaussian Fit Plot 

The Z height gaussian fit command is only available immediately after the Z 
height histogram command has been executed. Executing this command will 
superimpose a gaussian function plot over the histogram plot. The Y axis 

continues to be defined as the number of observations, but will be displayed with 
the 1, 2, and 3 sigma di visions. The X axis will continue to be defined as the Z 
height. When the mouse pointer is positioned within the plot, the current location 

of the pointer, expressed in the X and sigma coordinate system values, is 
displayed on the screen. 

Bearing Ratio Plot 

The Bearing Ratio command displays a plot of the bearing ratio, shown with the 
ratio ( expressed as a percentage from 0% to 100%) as the Y axis, and the Z height 
as the X axis. When the mouse pointer is positioned within the plot, the current 
location of th� pGintci, expr1,;SS�d ;r,. the X and Y· coordinate system values, is 

displayed on the screen. 

Autocorrelation Plot 

The Autocorrelation command displays a plot of the autocorrelation function for 
the data set. Autocorrelation is the reverse Fourier transform of the roughness 
frequency. The Y axis is defined as the amplitude, and the X axis is the 

displacement. When the mouse pointer is positioned within the plot, the current 
location of the pointer, expressed in the X and Y coordinate system values, is 

displayed on the screen. When the autocorrelation plot is on the screen, the user 

can choose to display another previously saved autocorrelation plot This is done 
by selecting the Load command from the menu. The autocorrelation plot can also 
be saved so that it can be re-displayed at a later time with the Save menu 
command. 
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Roughness Frequency Plot 

The Roughness Frequency command displays a plot of the spatial frequencies vs. 
the log of the power amplitude. This is calculated by talcing the power spectral 

density from the Fourier transform of each scan line. The Y axis is defined as the 
log of the power amplitude, and the X axis is the spatial frequency shown in µm·

1

(or the appropriate inverse distance units). 

When a roughness frequency plot is being displayed the user has the ability to 
load another roughness frequency plot and overlay on top of the current plot. This 
is done with the Load command from the menu. The user is presented with a 
standard file dialog box and the selected file is then shown on the current plot 
with a legend, and using a different line color. The user can select up tci five other 
roughness plots to be shown against the current plot at any one time. 

The current data sets' roughness frequency plot can be saved so that it can be re­
displayed at a later time with the Save menu command. This command presents 
the user with a standard file dialog box, and allows the user to enter the name of 
the file to save the current plot into. 
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Average Z Height 
When the histogram window is displayed the observed Ra will be displayed. The 

average Z height is the Z coordinate of the center plane, that extends outward in 
X and Y to infinity. 

Ra 

When the histogram window is displayed the observed R
a 

will be displayed. The 

R" , or Mean Deviation, is calculated as the average deviation from the center 
plane 

RMS Deviation 

When the histogram window is displayed the observed RMS deviation will be 
displayed. The RMS deviation or root-mean-square roughness is calculated as the 
RMS deviation from the center plane. 

Skewness 

When the histogram window is displayed the observed skewness will be 
displayed. "Skewness is a measure of symmetry of the surface about a mean 
plane. "1 In the 2D sense skewness is defined as: 

l 1 N 

Skewness = --

3 
-L l-;3 

Rq N 1 

where: 
Rq = RMS deviation

N = number of data points 

Y; = Z height of a data point

Kurtosis 

When the histogram window is displayed the observed kurtosis will be displayed. 
''Kurtosis is a measure of the amplitude density function sharpness. It 
quanlitali vely describes the randomness of a profile's shape; relati vp to that c.,[ ::1. 

perfectly random surface which has a kurtosis of 3."3 

1 1 N 

Kurtosis = -

3 
-L Y.4 

R
q 

N I I 

where: 
R

q 
= RMS deviation 

N = nwnber of data points 

Y; = Z height of a data point 

2 ANSVASME 846.1-1985 Surface Texture /Surface Rooohness, Wavfness and Lay). oara C32.3
3 

ANSVASME 646.1-J 985 Surface Texture /Surface Roughness, Waviness and Lay), para. C32.4 
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Maximum Deviation 

When the histogram window is displayed the observed maximum deviation will 
be displayed. The Max Dev or Maximum Deviation, is the furthest data point 
above or below the mean image plane. 

RP 

When the histogram window is displayed the observed R
P 

value will be 

calculated and displayed on the screen. The R
P 

or Roughness Peak, is the 

maximum height or highest peak of the profile roughness above the mean plane. 

R, 
When the histogram window is displayed the observed R, value will be

calculated and displayed on the screen. The R, or Ten Point Height, is the 

average distance between the five maximum peaks and the five maximum valley 
measurements. 

R. 

When the histogram window is displayed the observed R, value will be 

calculated and displayed on the screen. The R,, or Maximum Valley, is the lowest 

point below the mean image plane. 

R: 

When the histogram window is displayed the observed Rt. value will be

calculated and displayed on the screen. The R, or Average Height Difference, is 

the average difference in height between the five highest peaks and five lowest 
valleys relative to the mean plane. 
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IMAGE ANALYSIS 

The data point analysis or "image analysis" window provides the users with the 
ability to cross section the data, and then select two points and review the 

locations, distances, angles, and vector distances for these two points. 

The data point analysis window also serves as a gateway to standard Dektak. 2D 

analysis functions once the user has selected a cross section of the 3D data 
resulting in a 2D data set. 

E!IIMAGE ANALYSIS· C \01::KTAK\UATA\OENM IMG El 

Figure 0-12. Image Analysis Window 
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Cross-Sectioning of Data 

The image analysis window allows the user to cross section the 3D data set in 
three different ways "horizontal" "vertical" and "dia0onal" These terms make , , , 0 . 

sense if you view the data set as a top down image, but their real definitions are: 

Horizontal - a cross sectioning of the data along the Y axis (y is kept constant) 

for X equal to Oto the scan length. 

Vertical - a cross sectioning of the data along the X axis (x is kept constant) for 

Y equal to 0 to the scan width. 

Diagonal - a cross sectioning of the data between two user defined points within 

the scan. This means the cross section is of variable XY slope, and variable 
length. 

In all cross sectioning methods the X, Y, or XY coordinates are translated to the 

X axis (or length), and the Z heights are translated to the Y axis, resulting in a 2D 
representation of the data. This resultant data is then plotted in a separate plot 

object (herein referred to as the cross section plot) on the window with the correct 
scales placed along the axis. The aspect ratio of plot defaults to the length by the 
maximum observed Z height. A scroll bar positioned to the right of the plot 

allows the user to adjust the aspect ratio by a variable, yet unknown amount. 
When the data point analysis window is displayed it defaults to taking a 
horizontal cross section, at the Y mid-point or scan width / 2. 

Data Point Selection 

In the cross section plot there are two vertical lines, one red, the other blue. Their 
default positions at 1/3 the X range from the start, and 1/3 the X range from the 
end. These two lines denote the two measurement points that are used for all 
subsequent calculations. The G.:.:tual data poinu; are located wiJere these verticai 

indicators intersect the plotted line. 

To move either vertical indicator the user drags the mouse near one of the lines 
and moves it either to the left or right. All up, down motion is ignored. The user 
does not have to position precisely on top of one of the indicator lines to select it, 
just near it. The red (left hand) indicator is prevented from moving to the right 

side of the blue (right hand) indicator, and vice versa. Due to the preceding rule 
clicking with the mouse to the left of the red indicator always selects the red 

indicator and vice versa. In the situation where both indicators are equidistant 
from where the user clicks the mouse, the blue indicator will be selected. Once 
any indicator is moved the coordinates, distances, angles, and vector distances 
displays will be updated based on the selected points. 
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Selected Point Coordinates 

At all times the current X, Y, and Z coordinates of the two selected points are 
displayed with appropriate titles. 

Delta X, Y, and Z 

At all times the distances between the two selected points are displayed, 
expressed as the delta for each X, Y, and Z axis. 

20 and 30 Vector Distance 

At all times the two dimensional and three dimensional vector distances between 
the two selected points is displayed. The two dimensional vector distance is 
calculated as the XY vector distance points. The three dimensional vector 
distance is calculated as the XYZ vector distance between points. 

Theta Angle 

At all times, the Theta angle defined by the two selected points are displayed. 
These are labeled Theta. Theta is defined as the angle from the XY plane for the 
3D vector between the two points. This can also be considered the angle defined 
by the two points as shown on the cross section plot, since the X axis is always 
parallel to either X or Y plane. Theta is expressed in degrees. If the two cursors 
intercept the cross section plot at the same vertical height, then Theta would be 
defined as 0°. 

Phi Angle 

Phi is defined as the 2D vector angle (X and Y) of the two points in 3D space. 
This can also be considered the angle defined by the cross section line as shown 
on the top view image, Horizontal i<; 9(1° , and vertical is 0°. 
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Side by Side Image Comparison 

The user can compare the top down view images of two data secs side by side on 

the display. A cursor is then shown in both images at the same relative 
coordinates to assist the user in determining feature differentiation. The user is 

also has the ability to subtract, add or divide one image from/by the other. To use 

this feature the use selects the File, Compare menu command. This command 

displays a window can show two images side by side, horizontally on the screen. 

The user is then selects the data set to be displayed in the left hand image with the 
Select Left menu command. The user then selects the data set to be displayed in 
the right hand image with the Select Right menu command. Once both images are 

displayed the user can then choose to add, subtract, or divide the data sets and 
display the resultant image with the Sum Images, Subtract Images, or Divide 

Images menu commands. These commands use the following algorithms for their 
operation: 

Sum: left(x,y) = left(x,y) + right(x,y) 
Subtract: left(x, y) = left(x, y) - right(x,y) 

Divide: left(x,y) =
left(x,y) 

right(x,y) 

Contour Plotting 

The user is able to have the system overlay a contour plot on top of a top view 
image at two locations within the package. In the 3D view window, when the 
screen is maximized, the user has the option of dividing the Z height range into 4, 
6, 10, or 16 equal height increments, and contour lines are then super imposed 
over a top view image using the color green. In the histogram window the user 
can select the Contour menu command to divide the Z height range into 14 equal 
height increments, and contour lines are then super imposed over a top view 
image using the color green. 

Data Transformations 

A number of data transformations are offered through the functions such as tilt 
correction, filtering, smoothing, convolution, scaling, image touch up and 
magnification. Once manipulated the data can then be transformed and saved as a 
new and separate image file. 

Edge Fit 

The user is able to remove planar tilt from an image using an algorithm known as 

'Edge Fit'. Edge fit tilt removal calculates the X and Y tilt by finding the average 
height on all four sides of the image. From these averages the X and Y slopes are 
calculated and then subtracted from the data set. 
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Three Point 

The user is able to remove planar tilt from an image using an algorithm known as 

'Three Point'. Three point tilt removal allows the user to select three points 

with.in a data set. A plane is then defined that contains these three points and is 
subtracted from the data set. 

Parabolic 

The user is able to remove parabolic dishing from an image using an algorithm 
called 'Parabolic'. With parabolic tilt removal a third order polynomial function 
for a parabola is calculated based on the data set. This polynomial is then 
subtracted from the data set. 

Parabolic in V Only 

The user is able to remove parabolic dishing in each individual scan line, on a line 
by line basis with an algorithm called 'Parabolic Line by Line'. With this tilt 
removal a third order polynomial function for a parabola is computed for each 
line. The polynomial for each line is then subtracted from that line. The overall 
effect is to remove a curvature that resembles a slice taken out of a can, if you cut 
the can from top to bottom. 

Line by Line Averaging in X Only 

The user is able to remove the DC offset in the X direction from each scan line, 
on a line by line basis with an algorithm called 'Line by Line H'. This tilt 
removal algorithm effectively flattens the image along the Y axis by removing the 
DC component from each scan line. This is accomplished by finding the average 
height of each scan line and then subtracting that height from each point in that 
line. This type of tilt removal is only recommended for surfaces that are known to 
be flat. 

Line by Line Averaging in V Only 

The user is able to remove the DC offset in the Y direction from each line, on a 
line by line basis with an algorithm called 'Line by Line V'. This tilt removal 

algorithm effectively flattens the image along the X axis by removing the DC 
component from each line in Y. This is accomplished by finding the average 
height of each line and then subtracting that height from each point in that line. 
This type of tilt removal is only recommended for surfaces that are known to be 
flat. 
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Line by Line Averaging in X Only with Data Rejection 

The user is able to remove a portion of the DC offset in the X direction from each 
scan line, on a line by line basis with an algorithm called Histogram H. The user 
additionally selects one of three options from Hills, Hills and Valleys, and 
Valleys. This option determines how the average height of a scan line is 
computed. For Valleys, the average height is calculated by taking the average 
height of lowest 33% of the data set. For Hills and Valleys, the average height is 

calculated by taking the average height of the lowest 50% of the data set. For 
Hills it is 66% of the data set. Once the average height is calculated the algorithm 
works the same as Line by Line H. This type of tilt removal is only recommended 
for surfaces that are known to be flat. 

Line by Line Averaging in Y Only with Data Rejection 

The user is able to remove a portion of the DC offset in the Y direction from each 
Line, on a line by line basis with an algorithm called Histogram V. This works in 
the same manner as Histogram V, except in the Y direction instead of X. This 
type of tilt removal is only recommended for surfaces that are known to be flat 

Streak Removal 

The user can remove horizontal or vertical streaks from the image with a 
Retouch, Streak Removal menu command. Streak removal allows the user to 
select a rectangular area from a top view image. Once selected the data points 
above and below the X edges (top and bottom) are interpolated through the Y 
range of scan lines, eliminating the actual data bound by the rectangle, and 
replacing it with the interpolated data. The top view image is then updated with 
the transformed data. 

Spot Removal 

The user can remove horizontal or vertical streaks and unwanted particles with 
the Retouch, Spot Removal menu command. Spot removal allows the user to 
select a rectangular area from a top view image. Once the area has been selected 
the data points with the rectangle are interpolated in both the X and Y directions 
between all edges of the rectangle, eliminating the actual data bound by the 
rectangle, and replacing it with the interpolated data. The top view image is then 
updated with the transformed data set. 
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Smoothing 

The user can smooth the data with the Retouch, Smoothing menu command. 

Smoothing is the same as applying a low pass filter to the data. This command 

allows the user to select either 3, 5, or 9 point averaging for the smoothing 
transform. The higher the poLnt number the higher the frequency of the filter is. 
The entire data set is then transformed and displayed in a top view image. 

Convolution 

The user can convolve the data set with either predefined or user defined 

transforms, and display the resuJ ts with a series of commands. Data convolution 
can be explained as the process of converting a data set to the frequency domain, 
applying a filter, and then re-transforming the data back into the X, Y domain. 

To convolve the data the user first selects the Retouch, Select Filter menu 
command to bring up a dialog box that allows them to select from matrix sizes of 
3x3, 5x5, 7x7, 9x9, llxl l, or 13xl3; select from a predefined transform from 

either a rectangular low pass filter, a gaussian low pass filter, an edge 
enhancement transform, an edge detection transform, a band pass filter, or a 
allows the user to create their own matrix or transform values. The size of the 
matrix determines the frequencies that will be involved in the convolution; the 
larger the matrix, the lower the frequency. 

To convolve the data using the selected transform matrix, the user then selects the 
Apply Filter command. This command then applies the transform to the data set, 
replacing the original data set with the transformed data. Next the transformed 
image is displayed as a top down image. 

Data Zoom 

The user is able to select a square portlun of the data set that i-: m?.gniffod and 
becomes the new data set, with the Zoom command. The user selects a square 

area of the data set from a top view image. Once selected the portion of the data 
set is reproduced at the original resolution original data set. For example, if the 
original data set is defined as 100 elements by 100 elements, and the user selects a 
20 by 20 region, the 20 by 20 data is re-scaled to 100 by 100 elements. The 
missing data points are interpolated so the Lmage does not appear pixelated. The 
requirement that a square are be selected is enforced by the package as the user 
clicks and drags the mouse during the zoom command. 

While the user is dragging the mouse to select the area to magnify, the current 
size of the selected area is displayed on the screen. 
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Z Height Truncation 

On the Z height histogram plot the user is able to select a command that truncates 

the Z height information down to a specified range. Z height data above or below 

this range is truncated to the new minimum or maximum heights respectively. To 

use truncation the user first selects the menu command Truncation, Cursors. This 

displays two vertical cursor lines within the histogram plot. The cursor on the 
right serves as the cut off point for the maximum height, and the left cursor as the 

minimum. The user then selects the menu command Truncation, Action to 
transform the data set. 
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2 Dimensional Fast Fourier Transform 

The user is able to analyze and filter frequencies from an image, through the 

fourier transform analysis feature. This feature is provided by a separate window 
that can transform the data set from its spatial XY domain into a frequency 
domain. The real and imaginary components are then plotted along with the 
power spectral density ( or sum of the squares of the real and imaginary 
components). The user is then allowed to erase components from the frequency 

content of the data, and then re-transform the data back into the XY domain, 
resulting in a transformed image. 

Image Edit Transform 

1 

Figure D-13. Fast Fourier Analysis Window 
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Excluding Frequency Data 

To transform the XY domain data into its frequency domain the user imports the 
into the FFT analysis window with the "Import Data" command button. From 
there the data can be transformed into the frequency domain with the 
"Transform" command button. The real and imaginary components of the FFT 
are plotted on XY charts with the color (or intensity) of each data point 
determined by its scale. A power spectral density (PSD) plot is shown with the 
color of each data point determined by the amplitude of the frequency 
component. 

The user is now able to select either an ellipsoidal or rectangular area on the PSD 
graph. The center of either type of object is the exact center of the graph or OHz.

To select either type of shape the user presses either the "Ellipse Zone" or "Rect 
Zone" command buttons, and then clicks and drags the mouse with the PSD 
graph to draw the shape. The user now has the option of either excluding the 
frequency data within or outside of the area selected. To exclude frequencies 
outside of the selected area, the user selects the Exclude Outer command button. 
To exclude frequencies inside of the selected area, the user selects the Exclude 
Inner command button. Both command buttons then erase, or zero, the 
frequencies to be excluded from the data set. The cutoff is a sharp distinct cutoff 
filter. If the user instead wants a gradual filtering a Gaussian Cut command button 
can be used to implement a gaussian roll-off of the amplitudes starting at the 
frequency (or frequencies) defined by the edge of the selected area, before using 
either the exclude inner or outer commands. 

The user can exclude a specific frequency and orientation (with respect to X or Y) 
with an eraser. Two sizes of erasers are available; small, and large. To erase a 
frequency component the user selects the appropriately sized eraser from the 
Erase menu command, and then clicks and drags the eraser over the PSD graph. 
-whenever the mouse button is depressed all information under the eraser will be 
erased. 

To convert the frequency domain data back into the XY domain, and resulting in 
a recovered image, then user selects the Retransform command button. The real 
and imaginary component data, along with the frequency information removed by 
the user, is re-transformed into an image which is shown along side the original 
image. The user then has the option of exporting the re-transformed image into 
the current working data set for the rest of the program with the Export Image 
command button. 
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Amplitude Scaling 

To assist the user in determining the frequency components of an image, menu 

commands to scale the amplitudes up or down are available. When the amplitude 

is scaled down, the mode dominant :frequencies will remain brighter on the PSD 
graph, while the less dominant will dim from existence. The effect can be 

reversed by either scaling up or using the Scaling, Restore menu command to 

restore the original scale. The scale must be restored if a comparable image to the 
original is desired, otherwise the Z heights of the re-transformed image will be 
scaled according to the difference between the selected scale factor and the 
original. 

Tutorial or Experimental Mode 

The FFT analysis window also allows the user the experiment with using FFT 
transforms and filtering frequencies. The user is able to generate a number of 
sample image patterns and noise patterns of both random and fixed frequency. 
The user can then perform the transforms and data fi1 tering as normal with these 
generated images. This then give the user a better feel for the meaning of the PSD 
graph, and what factors should be consider when filtering information for 
achieving specific results. 

On-line Help 

The package offers on-line help to the user through the standard MS-Windows 
help system. The package includes the recommended MS-Windows help menu 
that allows the user to select the help file contents, search the help file index:, and 
help on how to use the help system. 

The on-line help describes how each command is used, and outlines the general 
procedures and principals involved in using the package. 
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APPENDIX E 

STEP DETECTION SOFTWARE OPTION 

The DEKT AK V 200-Si Step Detection Option enables the automatic 
computation of analytic functions on scanned features. This is accomplished in a 
two step process. First, the Step Detection algorithm will locate the leading and 
trailing edge of each scanned feature. Dektaks' Reference and Measurement 
Cursors can then be automatically positioned at a relative distance from each 
detected edge, where chosen analytic functions (ie. Average Step Height, Slope, 
Peak,Valley, Peak to Valley, etc.) will be computed. Tue Step Finder can be 
thought of as a filter that accentuates the edges of a scanned feature where a high 
variation (high frequency) between data points exist. 

NOTE 

Step Detection is an optional feature that must be installed in 

the DEKTAK V 200-Si prior to use. 

How does it work? 

A least squares fit algorithm has been employed to accomplish the location of 
feature edges. The following variables will be used by the least squares fit 
algorithm to determine the fitting criteria of a line to scanned data points. 

Detection Method 

Flrst Ster,, Will pvs1b.on the Rand M cursors for selected Analytical 
Functions relative to the beginning of the first step that 
matches the Step Description parameters. If a matching 
step is found, the ASH of the left edge and the right edge 
will be the first two entries in the Analytic Results window. 

Every Step Will position the R and M cursors for selected Analytical 
Functions relative to every step that matches the Step 
Description parameters. 

Feature edges are determined by the relative change in slope of each line segment 
and the proximity (minimum width) from other line segments. 

The operation procedure for Step Detection is described in the following pages. 
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EVERY STEP PARAMETERS WINDOW DESCRIPTION 

The Step Parameters Window displays all the necessary parameters for 

performing the Step Detection function. When the window is first displayed it 
will contain the default values for the "Every Step" detection method (see Figure 
E-1 ). The step parameter values may need to be changed depending on the steps 

being measured. A description of the parameters contained in the ·'Every Step" 
Parameters windows is provided below. 

Min. Step Height (A): Indicates the minimum height (in angstroms) of features 

to be measured. Decimal values can be entered to indicate any portion of 
angstroms. 

Max. Step Height (A): Indicates the max.imum height (in angstroms) of the 

features to be measured. The default value indicates the 

Smoothing Factor: The minimum edge height used to search for potential steps, 
in angstroms. 

+ Step: When selected, Step Detection will search for the first positive step
matching Step Description parameters.

- Step: When selected, Step Detection will search for the first negative seep
matching Step Description parameters.
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Figure E•1. Every Step Parameters Window 
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EVERY STEP PARAMETERS WINDOW DESCRIPTION (Cont.) 

Detection Range 

Start Position: The position, in microns, to start searching for a step. 

End Position: The position, in microns, to end searching for a step. 

Enable Step Detection: When checked, will perfonn Step Detection as specified 

on a completed scan. This check box is only available in program mode. 

Analytical Functions 

ASH Compute Average Step Height function. 

Slope Compute Slope function. 

AvgBt Compute Average Height function. 

Peak Compute Maximum Peak function. 

Valley Compute Maximum Valley function. 

P _ V Compute Maximum Peak to Valley function. 

Compute Average Compute the average of all results of an Analytical 
Function. 

Automatic Leveling - When selected will cause leveling to occur automatically 

with the R cursor placed at a relative distance before the first detected step and 
the M cursor placed at a relative distance from last detected step. Relative 

distance wil I be determined from the first selected analytical functions' Distance 

to Step value or 30µm if no analytic functions are chosen. 
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FIRST STEP PARAMETERS WINDOW DESCRIPTION 

A description of the parameters contained in the "First Step" Parameters windows 
is provided below (see Figure E-2). 

Step Description 

Height (A): The desired height of the step to detect, in Angstroms. 

Distance to Step 

R: The relative position of the R Cursor to the left of potential 
step being detected. 

M: The relative position of the M Cursor to the right of 
potential step being detected. 

Band Width 

R: Width of R Cursor positioned to the left of potential step 
being detected. 

M: Width of M Cursor positioned to the right of potential step 
being detected. 
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FIRST STEP PARAMETERS WINDOW DESCRIPTION (Cont.) 

Width(A): The desired width of the step to detect, in Angstroms. 

Noise Level: The minimum edge height used to search for potential 
steps, in Angstroms. 

Tolerance: Error factor used for calculating the height and width of 
the matching step. 

+ Step: When selected, Step Detection will search for the first 
positive step matching Step Description parameters. 

- Step When selected, Step Detection will search for the first 
negative step matching Step Description parameters. 

Detection Range 
Start Position The position, in microns, to start searching for a step. 

End Position The position, in microns, to end searching for a step. 

Enable Step Detection 

When checked, will perform Step Detection as specified on a completed 
scan. This check box is only available in program mode. 

Save Changes To Scan Routine 

When checked, all entered Step Detection parameters will be saved to the 
current scan routine. This check box is only available in compute mode, 
when step detect has been initiated from the Data Plot screen. 

Analytical Fun�tions 

ASH Compute Average Step Height function. 

Slope Compute Slope function. 

A vgHt Compute Average Height function. 

Peak Compute Maximum Peak function. 

Valley Compute Maximum Valley function. 

P _ V Compute Maximum Peak to Valley function. 

Compute Average Compute the average of all results of an Analytical 
Function. 
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FIRST STEP PARAMETERS WINDOW DESCRIPTION (Cont.) 

Cursors 

Function: 

Distance To Step (R) 

Selects an Analytical Function and displays the 
corresponding cursor values in the grid below it. 

The relative distance from the beginning of the detected step at which to place the 
R Cursor prior to performing the corresponding Analytical Function. Negative 
values fall to the left of the beginning of the step, positive values to the right. Up 
to 10 distances may be entered for each Analytical Function. 

Distance To Step (M) 

The relative distance from the beginning of the 

Band Width (R) 

M Cursor Band Width used when performing corresponding Analytical Function. 
Up to 10 widths may be entered for each Analytical Function. 

Band Width (M) 

M Cursor Band Width used when performing corresponding Analytical Function. 
Up to 10 widths may be entered for each Analytical Function. 

Automatic Leveling 

Options Display the Automatic Leveling Dialog Box. 
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STEP DETECTION SET-UP 

Step Detection is typically used for finding and measuring steps when performing 

multi-scan operations. It enables like features at multiple locations on multiple 
samples to be scanned with the step height measured automatically. Prior to using 
Step Detection in a multi-scan operation, it is recomended that a sample scan be 
created of the feature to be measured to aid in setting up the Step Detection 
parameters. Using the scan shown in Figure E-3 as an example of a sample scan, 
the following pages will demonstrate how to set-up and perform Step Detection 
on a scan data file. 

Figure G-3 shows a scan across a feature with steps located at approximately 
300um and 1400um. The procedure to invoke Step Detection on an existing scan 
data file is provided below. 

1. With a scanned profile of multiple steps displayed on the data plot screen,
click-on the Analysis Menu from the menu bar (see Figure E-3).

2. Select "Step Detection ... " from the analysis menu and the Step Parameters
window will be displayed (see Figure E-2).

A!laly1Jcal Functions ..• 

!;::::_::_::_::_-:,=--==-� J;.utoff Fllters ..• 
Se11 .Smoothing ..• 
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'RES: 0.513 UIII/Sa,ople 

FORCE: 15.0 11!J 
...._. __ .., N F.AICE: ,;;;;J{Q 
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!TOWER SPEED: Hi9h . 

Analytic Results 
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1

X:325000. Y:325000. T:O 

Figure E-3. Typical Scan of a Step 
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PERFORMING STEP DETECTION ON A SINGLE SCAN 

With the Step Parameters Window displayed, select the Step Detection method 
(First Step or Every Step) from the Step Parameter Window. Select the desired 
parameters for the scan to measure the scanned step or steps. Click on "Enable 
Step Detection" and click on "OK". 

The resulting scan after Step Detection has been enabled will perform redisplay 
the plotted profile and detect and measure the steps which apply to selected Step 
Detection parameters. 

The selected analytical funtions such as the ASH measurement will be performed 
on the detected steps. The steps will be detected causing the ASH measurement 
to be computed with R and M cursors positioned on either side of the step and 
displayed to the left of the plotted profile. 

You can now automatically locate the cursors to their corresponding position by 
highlighting the desired Analytic Result. 

The result of selecting both cursors (both R and M cursor buttons indented) will 
allow simultaneous movement of cursors and simultaneous modification of cursor 
band widths. To select both cursors hold the control key ( <Ctrl>) down while 

clicking with the left mouse button on the R or M cursor button that is not 
indented. Clicking on either the right arrow or left arrow will then cause both 
cursors to move simultaneously. Clicking on the up arrow or down arrow will 
cause both cursor bands to simultaneously expand or contract. 

PROGRAMMING STEP DETECTION INTO A SCAN ROUTINE 

. rcw that an :?.ccer,tab!e step detection criteria for locating feature edges on a 
single scan data file has been determined, the same criteria can be used for 

performing step detection on similar features during subsequent scans. 

To enable Step Detection during a scan, select the Window->Scan Routines 

menu item to display the Scan Routines Window. 

From the Scan Routines Window, invoke the Step Detection dialog box by 
clicking the left mouse button on the Data Processing->Step Detection ... item. 

This displays the Data Processing->Step Detection ... dialog box with default 
values displayed. 

Step Detection Enabled - must be selected (X in box) to enable Step Detection 
while scanning. 
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PROGRAMMING STEP DETECTION ON MULTIPLE SCANS 

The Automation Program Summary (APS) can be used with step detection to 
automatically compute standard deviation and mean values of chosen analytic 
functions at each detected step for a series of scans. 

To program a series of scans with Step Detection select Automation Programs 

from the Window menu. 

First, invoke the APS dialog box in order to enable the computation of 
Automation Program Summary information. To do this, click with the left mouse 

button on the DA TA DESTINATION OPTIONS->APS screen item. 

Then, click with the left mouse button on Compute And Display to cause the 
check box to display an X. 

Then, create a copy of the previously developed scan routine by selecting Copy 

To ... from the Edit menu item. 

Enter scan routine location where copy will be created. 

Double-click the left mouse button on the newly created scan routine to allow 
modification of the new scan routine location. 

Click, with the left mouse button, on the SCAN PARAMETERS->Location 
item. 

Change the Location X: and Y: values appropriately and then click on the OK 
button. 

Re1urn �.., the Autom::ition Program Window by selecting the Windcnv­

>Automation Program menu item so that we can run the automation programs. 

Select the Run->Auto Program From ... menu item after highlighting the first 
Auto Program to be executed. 

The resulting Automation Program Summary with Mean, Standard Deviation, 
Minimum, Maximum and Range values for ASH measurements at each detected 
step. 
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APPENDIX F 

PATTERN RECOGNITION OPTION 

The DEKT AK V 200-Si Pattern Recognition Option allows a multi-scan 
automation program to be run on multiple samples by automatically deskewing 
substrates prior to measurement. The procedure for Auto Alignment is described 
in the following pages. 

NOTE 

Pattern Recognition is an optional feature that must be 
installed in the DEKT AK V 200-Si rior to use. 

Auto-Align Program Entry Sequence 

1. Load the Reference substrate. Using the DEKTAK V 200-Si cassette
loader with the prealigner is recommended. Th.is assures continuity with
subsequent program execution operation.

2. "Square-Up" the substrate. Rotate stage to orthogonally align features
using the "Make Horizontal" function in the DEKTAK V 200-Si sample
positioning screen.

3. Set Alignment targets. Locate, train and test alignment targets. Illumination
source is user selectable.

4. Name and save the program and its elements.

5. Assign to a DEKTAK Automation Program.

Reference Substrate Orthogonal Pre-Alignment 

1. Load reference substrate onto chuck. Using the DEKT AK V 200-Si auto
loader for the placement of the initial substrate onto the chuck is
recommended.

2. Position the stage in the "Load" position so the center of the stage is located
in the center of the Low magnification optical field of view.

3. Using the "Make Horizontal" function, locate two points in the image that are
to be aligned to the same orthogonal axis.

4. Angle is calculated, and the stage is rotated as required.

5. Use the default theta alignment to set the correct stage rotation.
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ALIGNMENT TARGET MODELS FLOW CHART 

Begin Program 
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Low Magnification 

Focus & Adjust Illumination 
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No 
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Figure F-1. First Alignment Location Flow Chart 
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ALIGNMENT TARGET MODELS FLOW-CHART 
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: Figure F-2. Second Alignment Location Flow Chart 
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OVERVIEW 

The DEKT AK Automatic Alignment option enables operator-free substrate 
alignment for execution of automation programs. When combined with 
automated substrate handling, fully automated operation is possible. 

Substrate alignment is useful for replicating a programmed measurement 
sequence (Automation Program) on many substrates which may be placed on the 
DEKTAK stage in slightly varying orientations. 

The DEKT AK Automatic Alignment option provides the DEKT AK surface 
profilers the ability to use a hardware pattern recognition system to align a test 
substrate to a predefined reference. It replaces the manual deskew operation 
traditionally used for substrate alignment. The advantages of the hardware 
system over the human operator is better consistency (read repeatability), and 
faster through-put. Different alignment techniques are available with the 
hardware pattern recognition system that optimize the performance for both 
alignment speed and repeatabi1ity. 

Automatic alignment can be performed on a global level, where common 
alignment offsets are applied to all scan sites in the automation program. or on a 
local level where prior to a scan an alignment operation can be performed to 
provide offsets to be applied to that particular scan. 

The DEKT AK Automatic Alignment option uses a vision processor manufactured 
by COGNEX to perform the image pattern recognition. An optics unit is attached 
to the DEKT AK sensor head which provides two fixed magnifications and both 
dark and bright field illumination for each magnification. 

Basically, a set of reference video images and other properties are learned 
(trained) for a given alignment program. The operator specifies alignment 
locations and is guided through the alignment model creation and test process. 
This setup is performed at the same time the automation program scan sites are 
programmed. The alignment program is then attached to the automation program 
so when the automation program is executed, the alignment program is executed 
at the proper time. Wren tie automation program instructs the alignment 
program to execute, the stage is sent to the first alignment site, and the 
programmed alignment methods are executed. The stage is optionally corrected, 
and if another alignment site is programmed, then the stage is traversed and the 
alignment process continues until completed. The balance of the automation 
program is then executed. If enabled, a local alignment program would be 
selected and executed just prior to scanning. 
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SUBSTRATE ALIGNMENT 

The DEKT AK Automatic Alignment option allows the user to specify both the 
alignment targets and their locations on the substrate. This flexibility is required 
to accommodate the various shapes and sizes of wafers, flat panels, and other 
substrates. In general, alignment targets that are separated as far as possible, and 
at roughly 45 degrees from one another work the best since the corrections for 
rotation are optimized. Substrate alignment can be accomplished using both 
global alignment and local alignment. In most cases, the global alignment is 
adequate, however for applications where small features are to be measured, the 
application of a local alignment to that feature may be desired. 
The global alignment operation is a composed of a two point coarse alignment 
(using a low magnification), which removes the rotational offset of the substrate 
and determines the X and Y offsets to be applied to all scan sites within the 
Automation Program. To further refine the alignment, the DEKT AK Automatic 
Alignment option provides the choice of either a single or two point fine 
alignment which uses a higher magnification. The coarse alignment optics 
provide a field of view (FOY) of roughly 10mm horizontal and 8mm vertical -­
pixel resolutions of about 18-19 microns. The fine alignment optics provide a 
FOY of roughly 750 microns horizontal and 625 microns vertical -- pixel 
resolutions of about 1.3 microns. 

The DEKTAK Automatic Alignment option uses image pattern recognition 
techniques to find alignment targets (models) on the user's substrates to 
determine the substrate's alignment relative to a stored reference. The stored 
reference is trained from a real part. The alignment program and the 
measurement programs are created at the same time to establish the reference. 
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PATTERN RECOGNITION CONCEPTS 

The alignment reference is composed of two or more pattern recognition models 
that are extracted from the reference substrate. Pattern recognition models are of 
two classes: grayscale (linear) and intensity gradients or edge (non-linear) 
models. The choice of which to use is determined by the application. 

Grayscale models or linear models, use a normalized cross-correlation technique 
that provides robust search operation for applications that may be subject to linear 
changes in the image. If we consider the model to be an object on a background 
with some contrast between them, then linear changes would encompass varying 
illumination and process changes that affect the contrast linearly. 

Image intensity gradients or edge based models are best utilized when either non­
linear contrast changes are expected, or less than 100% of the model is expected 
to be in the test image. Non-linear contrast changes can occur in manufacruring 
processes. Varying etches of material that change reflectivity as a function of 
thickness for example, cause non-linear changes to contrast -- sometimes this can 
include contrast reversals. 

In either case, all pattern recognition models require some contrast in the image 
of the alignment feature to its background. If there is too little contrast, than 
neither pattern recognition scheme will work. In general, it is recommended to 
use the grayscale models unless there is compelling need to use edge based 
models. Grayscale model searches are faster and more robust than edge based 
model searches. They are more tolerant of rotational shifts. 

Along with feature contrast, the alignment feature chosen must be unique within 
the entire image field of view. This includes the bordering area surrounding the 
image. If the alignment model is not unique, then the alignment system will fail 
due to the ambiguity. 

Ideal Alignment Setup 

Th� i<lc:i1 ulignmenc setup would have the alignment models placed on a diagccal 
(about 45 degrees) and spread as far apart as possible. The alignment features 
chosen to be the target model would have high contrast (use your eyes as a gauge, 
if it looks good to you, it will be great for the vision system), and be unique to 
both the immediate image and to the surrounding area as well. Furthermore, the 
selected feature will be present in good quality on all substrates to be tested. In 
some cases, a manufacturer may want to design their masks with pattern 
recognition in mind -- placing alignment features in locations that are not 
subjected to changes as layers are processed. 
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ALIGNMENT PROGRAM CREATION 

The creation of an Automatic Alignment program is performed through the 
DEKT AK Alignment Program Entry application. This application guides the 
user through the steps required to locate, train and test alignment models. It is 
recommended that you first create a measurement program (Automation 
Program), then whi1e the substrate is still on the stage, create an alignment 
program. 

This application is launched from within the main DEKT AK application by 
selecting the Create Alignment Program menu item under the Align menu. The 
Align menu is found in either the Automation Program Setup window, or the 
Sample Positioning window to display the Automatic Alignment Window. 

To create an alignment program, select the New Alignment Program menu item 
under the File menu in the Alignment Program Entry application (see Figure F-3) 
-- or key press F2 (function key F2). This begins the program creation. A dialog 
box will appear asking you to select the alignment program options (see Figure F-
4 ). These include coarse and/or fine alignment, and selection of grayscale 
(default) or edge based model creation. Then based upon your selections, the 
program guides you through the operations of model location, training, and 
testing. 
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Figure F-3. Creating A New Alignment Program 
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COARSE ALIGNMENT 

The steps to create a coarse alignment program are as follows: 

1. Select coarse alignment from the Alignment Program Options dialog box
(see Figure F-4).

• Coarse Alignment Operations 

1¥ Two Points. KY and Theta Correction. 

Fine Alignment Operations 

0 No Fine Alignment 
- - -

@ One Point.. X, and Y �orreq.ion 0.nJy. 

0 Two Point X. Y and Theta Correction 

r Use Edge Gradients

�NCEl 

Figure F-4. Alignment Program Options Dialog Box. 

2. When Coarse Alignment Operations is selected from the Alignment

Program Options dialog box the Coarse Alignment Entry #1 dialog box
will be displayed (see Figure F-5). Click on "Locate Alignment Feature"
and "Continue".

Coarse Alignment Entry #1 

r (9cate�Ali_g·n�ent}:eciture l

r Orreate Alignment M oael

Redo � I Gan�I JI 

Figure F-5. Coarse Alignment Entry #1 Dialog Box 
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LOCATING COARSE ALIGNMENT FEATURES 

Locate the alignment feature on the substrate. This is accomplished by using the 
positioning controls in the stage control window which automatically comes up 
after you make you program options. You can jog to position by using the arrow 
buttons. You can also position by double clicking on the stage template, or 
manually entering the location into the stage location boxes and press the Move 
Stage button. From within this window, you can also adjust the illumination to 
optimize the image contrast. Pressing DONE will complete this step. The 
"Coarse Alignment Entry #1" dialog box will be redisplayed. Click on "Create 
Alignment Model" and "Continue" (see Figure F-7). 

Note: It is recommended that the stage be positioned such that the desired 
feature is located directly under the crosshair on the display. This allows the 
system to tolerate the maximum variations in substrate placement. 
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Figure F-6. Stage Control Window 
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CREATING THE ALIGNMENT MODEL 

Create the alignment model by using the COGNEX Trackball to move a box on 
the screen until it completely covers the desired feature(s). To change the shape 
of the box, press the MIDDLE BUTION on the COGNEX Trackball -- it anchors 
the upper left corner and allows changes to the bottom and right boundaries. 
Press the LETT BUTTON to accept the location and shape of the box. 

Note: The dimensions of the box must be kept small (less than 2 x 2 
inches on the video display) or the vision system will error. 

Ii" Looa-re Alignment Feature

,great� .Alig�[D�n.t -�-od.�lc 

I-= ���Jl 
L 'Attt�%!�<>..w1 IC ���!J 

Figure F-7. Create Alignment Model Selection 

After you have accepted the box location and shape, the application automatically 
trains and tests the model for both contrast and uniqueness. The test results are 
displayed in the next dialog box to appear (see Figure F-8). If the score 
difference between the chosen model and the next closest is large enough, then 
you should choose to accept it and continue on. If not, in the message window, 
suggestions will be displayed to accommodate usage of the selected model. 

Note: It is recommended that unless it is absolutely necessary, if more 
than one occurrence nf the rnorlel i� found, you should choose to create a 
new model. Complete uniqueness 1s the best solution, and will provide 
the most robust operation. 

To create a traininj region, use the 
COGNEX trackba.rl. Middfe button 

• toggles between rectangle movement
f modes; Left button exits Cognex 

tmck.b.all mode. 

Figure F-8. Training Region Dialog Box 
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FINE ALIGNMENT 

The steps to create a fine alignment program are as follows: 

1. Select fine alignment from the program option dialog box. If coarse
alignment is also selected, follow the directions for coarse alignment first.
After acceptance of both coarse alignment models, the application
automatically starts guiding you throughout the steps to create fine alignment
models.

Note: The steps to create fine alignment models are exactly the same as with
coarse alignment, accept the addition of locating the alignment feature first
through the coarse optics.

2. Locate the alignment feature on the substrate using coarse optics. This is 
accomplished by using the positioning controls in the stage control window
which automatically comes up after you make you program options. You can
jog to position by using the arrow button, double click on the stage template,
or manually enter the location into the stage location boxes. From within this
window, you can adjust the illumination to optimize the image contrast.
Pressing DONE will complete this step.

Note: It is recommended that the stage be positioned such that the desired
feature is located directly under the crosshair on the display. This allows the
system to tolerate the maximum variations in substrate placement.

3. Locate the alignment feature on the substrate using fine optics. This is
accomplished by using the positioning controls in the stage control window
which automatically comes up after you make you program options. You can
jog to position by using the arrow button, double click on the stage template,
or manually eater the location into the stage location boxes. From within this
window, you can adjust the illumination to optimize the image contrast.
Pressing DONE will complete this step.

Ncte: 1t is re,;nrrLm�ndeo that the stage be positioned such that the de:::ired 
feature is located directly under the crossbair on the display. This allows the 
system to tolerate the maximum variations in substrate placement. 

4. Create the alignmenl model. This is done by using the COGNEX Trackball to
move a box on the screen until it completely covers the desired feature(s). To
change the shape of the box, press the MIDDLE BUTTON on the COGNEX
Trackball -- it anchors the upper left comer and allows changes to the bottom
and right boundaries. Press the LEFT BUTTON to accept the location and
shape of the box.

Note: The dimensions of the box must be kept small 0ess than 2 x 2 inches 
on the video display) or the vision system will error. 
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AUTOMATIC ALIGNMENT MODEL ACCEPTANCE 

After you have accepted the box location and shape, the application automatically 
trains and tests the model for both contrast and uniqueness. The test results are 
displayed in the next dialog box to appear. If the score difference between the 
chosen model and the next closest is large enough, then you should choose to 
accept it and continue on. If not, in the message window, suggestions will be 
displayed to accommodate usage of the selected model. 

Note: It is recommended that unless it is absolutely necessary, if more 
than one occurrence of the model is found, you should choose to create a 
new model. Complete uniqueness is the best solution, and will provide 
the most robust operation. 

AUTOMATIC ALIGNMENT PROGRAM ENTRY 

After the alignment program is completed, you will close DEKT AK Automatic 
Alignment Program Entry application (File/Exit) and return to the main 
DEKTAK application. The final step would then be to assign the alignment 
program to the automation program you created previously. Save the Automation 
Program and return the substrate to the carrier. Now you are ready to perform 
automated measurement programs with alignment. 
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